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About this Guide 
This document explains how to use the Enterprise Communications Manager (ECM™) to 
communicate data between stations for Retail Pro version 9.2 (R5). 

If you believe the information presented here is incomplete or inaccurate, we encourage you to 
contact us at emanuals@retailpro.com. 
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Introduction 
About Communications 
Retail Pro 9 communicates data using ECM (Enterprise Communication Manager). ECM takes 
advantage higher bandwidth networks to deliver data faster and more efficiently than traditional 
polling. ECM sends data via open transport using XML, which allows open data exchange 
between Retail Pro and other systems.  

Advantages of ECM 
Convenience 

Setting up stations to exchange data is as simple as specifying the database type (BTF or Oracle), 
Subsidiary number, Retail Pro location, and station name. 

ECM can be run at any time of the day without disrupting store operations. The more often data is 
sent to Retail Pro, the more current the information will be. 

Efficiency 

Near real-time data is available to all stations. There's no need to wait until the end of a polling 
cycle to see updated information. 

Transmission errors are automatically caught and corrected by the system, and data flow resumes 
automatically. 

ECM moves only records that have been changed. ECM replicates 100% of a user’s Retail Pro 
data, directly updating the Retail Pro 9 database with the records stored in Retail Pro 8. 

Reliability and Flexibility 

ECM provides reliability and flexibility in data exchange. As ECM reads data from one database, 
it transforms the data into the appropriate format and then writes to the other database. No 
intermediate files are generated during this process.  

For the Retail Pro 9 database, a native connection is established via Oracle Net. 

For Retail Pro 8 data, the data files are accessed via proprietary database access components 
developed specifically for this function. 

ECM sends changes in information from Retail Pro 9 to each station, simultaneously. 

The RP 9 database can reside on the same server as an RP 8 or RP9 installation, on another local 
server, or on a server at another geographical site. 

ECM checks each station's profile checklist and profile tools to determine what data is processed 
and when. 

Checklists and Profile Tools 
When configuring a station, you control how the station sends/receives data by configuring 
checklist options and profile tools. 

 The profile checklist controls how data is sent by the station 

 Profile tools control how data is received and processed by the station 
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Launching/Scheduling Communications 
You can launch communications manually, or schedule communications to take place 
automatically at the times you specify. When exchanging data manually, you can perform a full 
communications cycle, or just a portion of the cycle. 

Setting up Communications 
To communicate using ECM, each station needs to:  

1. Make sure the necessary ECM program files are installed.  

2. Configure ECM workstation preferences for your station, including identification information 
for your own station, the locations of your data files, rules for processing data, and other 
communications settings. 

3. Create a station record for each station with which you want to communicate.  

4. Create a group for employees who need access to ECM, and then assign necessary 
permissions to the group.  

Here are some things to keep in mind when setting up ECM: 

 At the Retail Pro 8 and Retail Pro 9 stations, the computer running EcmProc.exe must 
have its language settings for both the system AND user set to the same language. 

 In the station record for each station with which you will be communicating, configure 
the station’s 1) checklist and 2) profile tools.  

 You can execute multiple ECM processes simultaneously, but only one process at a time 
per computer. 

 ECM supports XML interface via XML schemas and XML data. 

 

ECM Menu Buttons 
The following is a description of the menu buttons found when you select Stations from the top 
menu of the ECM Home Screen. 

Menu Button Description 

 

Click to access the station wizard (for creating station records). If the 
Station Wizard button is disabled, check to make sure you have 
selected a subsidiary. 

 

Click to load an existing profile into the station's record. Loading a 
profile saves you the time of redefining profile settings for each station.  

 

Click to prepare profiles for communication. The profiles will be sent 
during the next communications. 

 

Click to perform a Quick Poll (based on your QuickPoll settings in 
Options > W/S Preferences. 
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Menu Button Description 

 

Click to restart ECMExchange.exe. ECMExchange.exe runs as a 
service, but if you had to stop it for any reason, you can restart by 
selecting this button. 

 

Click to exchange data. Data in your \Out\ folder is sent to the other 
station(s)'s In\Recvd\ folder. 

 

Click to access the profiles area, where you can add, edit, or delete 
profiles. 

 

Click to process in data that is currently in your \In\Recvd\ folder. 

 

Click to process out data that is currently in your \Out\ folder. 

 

Click to regenerate document history or to initialize a station. 

 

Click to access movelists. 

 

Click to create a new movelist template, or to edit an existing template. 

 

Click to edit an existing movelist. 
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Installing/Launching/Configuring ECM 
Installing ECM 
Use the following procedure to install ECM at Retail Pro stations. 

To install ECM: 

1. Insert the installation CD. If the installation program does not launch automatically, launch 
the CD from the Windows Start menu on your desktop. 

2. Select Enterprise Communication Manager as the program to install. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Result: The InstallShield opens.  

3. Click Next. 

4. Decide if the default installation folder (...\ECM) is acceptable. If it is, click Next. If not, click 
Browse to choose a different folder. Click Next when you are finished. 

5. Verify that the information is correct, then click Next to begin copying files.  

6. Select to reboot your computer now, then click Finish. 

Note: The build number of your ECM must match the build number of your Retail Pro® 9 Series 
installation. 
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Launching/Exiting ECM 
To launch ECM, a user must: 

 Log in using the employee’s assigned username and password 

 Belong to a group assigned the “Launch ECM” permission 

To launch ECM (login required): 

1. Double-click the ECM.exe icon on your desktop, or select ECM on your Windows Start menu. 
If the security dialog displays, enter your User Name and Password, select a Subsidiary, and 
then click Login (<Alt+L>). The ECM Home Screen displays. 

2. Select a button to access that program area. 

Button Description 

 

Access your list of stations, profiles, and to launch communications manually. 

 

View the Processing Log and/or Error Log. 

 

 Define Workstation Preferences 

 Define Network Settings 

 Define Modem Settings 

 Log On 

 

To exit ECM: 

1. Click the Enterprise Communications Manager button in the 
upper right corner until you reach the ECM Home Screen.  

 

 

 

2. Click Exit on the side menu, then click OK to confirm.  
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About Configuring ECM 
Configuring ECM involves the following: 

 Assigning security permissions to those employee groups that you want to have access to 
ECM 

 Configure ECM Workstation Preferences 

 Create a record for each station with which your station will communicate and configure 
checklist and profile tool settings for each of those stations 

About the Station Checklist and Profile Tools 

When configuring a station, you control how the station sends/receives data by configuring 
checklist options and profile tools. 

 The checklist controls how data is sent by the station 

 Profile tools control how data is received by the station 

ECM Security 
To assign security permissions for ECM, use Security Administrator (SecAdmin.exe) found in the 
\ECM\SecAdmin\ folder. 

First, you'll need to register the ECM.sec file (found in the \ECM root folder). Then, assign ECM 
permissions to your employee groups. If necessary, you can create new groups and add 
employees to or remove employees from groups. 

To register ECM.sec and assign group permissions: 

1. Click Options > SecAdmin from the ECM Home Screen.    

Result: The Log On dialog displays. 
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2. Enter your User Name (<Alt+N>) and Password (<Alt+P>), and then click Login (<Alt+L>). 
Security Administrator launches. 

 

 

 

 

 

 

 

 

 

 

 

3. Select File from the top menu, then click the Register Security Information (<F3>). The Open 
dialog displays. 

 

 

 

 

 

 

 

 

 

 

 

 

4. Navigate to and select the ECM.sec file (located in the \ECM root folder), and then click Open. 
The ECM security permissions are available for selection in Security Administrator. 

5. Click the Groups tab (<Alt+G>). 

6. In the Area field, select ECM from the drop-down list. 
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7. Select a Group and select/unselect individual permissions, as necessary. 

 

 

 

 

 

 

 

 

 

 

 

8. Select File from the top menu, then select Save Security Information (<F2>). Repeat for 
additional groups, as necessary. 

9. Select File > Exit (<Alt+F4>) when you are finished. 

Available Security Permissions 
You can control employee access to the following ECM features: 

General   

Launch ECM Access Workstation 
Preferences 

Edit Workstation Preferences 

Access Network Settings Access Modem Settings  

System   

Modify List View Menu Designer Layout Manager 

Communication   

Start/Terminate Exchange Send/Receive Add/Edit Profiles 

Initialize/Regenerate Add/Edit Stations Add/Edit Movelist 

Logs   

Access/Print 
Communications Log 

Access/Print Error Log  

 

Adding the Logon Button to Menu 

When using security in ECM, you can add Logon as a side menu button of the Options menu to 
allow users the option of switching users and credentials as needed. 
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ECM Workstation Preferences 
Define ECM workstation preferences at each station. ECM workstation preferences control 
settings such as the station's type, the path to the station's data files, and processing rules. 

To define ECM workstation preference settings: 

1. Click Options > W/S Preferences from the ECM Home Screen. 

2. Select General > Setup.  
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Define the following settings as needed. 

Setting Description 

Station Name Enter a name for the station. 

Installation Type & Path Select the type of database installed at your station: Retail Pro (BTF) or 
Oracle. 

If you select Retail Pro (BTF): 

Enter your Subsidiary No. and Subsidiary Name. 

Enter your Retail Pro Path: Define the path to your RPRO8.exe files by 
either manually entering the path, or choosing the browse button and 
selecting the appropriate path. 

If you select Oracle:  

Select the database you are using in the Database field. (Default = 
RPROODS) 

Define the path to your Retail Pro® 9 Series files by either manually 
entering the Installation Path, or clicking the folder icon to browse to select 
the appropriate path. No further action is necessary. The Database field is 
a read-only field that displays the name of your Oracle database 
(RPROODS). 

Purge Logs After Enter or select the number of days to retain log files before they are 
automatically purged.  Default = 15 

Socket Base Port 

 

Enter the socket base port address to be used for receiving incoming data 
calls.  All machines must use the same base port address. Default = 20000 

If you modify the default base port address of 20000, ECM recognizes the 
change. The ECMExchange.exe service is uninstalled, and then reinstalled 
as ECMExchangeXXXXX, where XXXXX is the new base port address. 

Reconnect Attempts Define the maximum number of times ECM will attempt to contact the 
station if unable to connect and validate.   
Default = 5 

Reconnect Delay Define the number of seconds the station will pause when unable to 
connect and validate before trying to reconnect.  Default = 30 

Polling Path Define the path to your station's communication directories (\ECM\Polling) 
by either manually entering the path, or by selecting the browse button and 
choosing the appropriate path.  

If the polling directory is changed, and data is found in the original location, 
it will not be moved to your new polling path. You will have to manually 
move files that may have been in the original polling directory. 
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3. Select General > Rules.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Define the following rules as needed. 

Quick Poll Using the sliding bar in the text window, select which stages of the communications cycle 
to include when using the Quick Poll feature, and the order in which you want them 
performed.  

Send/Receive (first exchange), Send/Receive (second exchange), Process In, 
Process Out 

 

Processing Process In Immediately After Send/Receive. When this option is selected, your station 
will process in immediately after completing a manually initiated exchange. 

Process Out Immediately After Process In. When this option is selected, your station 
begins processing out immediately after processing in is completed. 

Process Shared Customers as Global. (Only available if your database type is BTF) 
Select to automatically mark as global customers in the Oracle database customers who 
are marked shared (to be shared with all other stations). If it is not selected, shared 
customers are added to the Oracle database as local customers for the subsidiary to 
which the station is assigned.  

Allow ECM Exchange to copy files from a mapped drive. If you select this option, 
enter your Windows Username and Password. The username and password you enter 
must be one with administrative privileges to the computer/workstation and to any 
mapped drives in which ECM may be operating. 
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4. Select General > Network Security.  

 

 

 

 

 

 

 

Define the following settings as needed. 

Allow ECM 
Exchange to 
Copy Files from 
a Mapped Drive 

If selected, ECMExchange.exe is allowed to copy files from one location on a mapped 
network drive to another location on the network. 

This is typically used when you have multiple 8 Series Main stations on a single server. 

If you select this option, define the following information that will allow ECM to assume 
the role of that assigned user when attempting to perform operations outside of the Local 
Drives assigned for a given system: 

Username: Enter your network username. 

Password: Enter your network password. 

Domain: Select the network domain. 
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5. Select General > Appearance.  

 

 

 

 

 

 

 

 

Define the following settings as needed. 

Home Page 
URL 

Define the path to any Web site URL by either manually entering the path or by selecting 
the browse button and choosing the appropriate path. 

The URL you enter determines the page that displays in the window of the ECM Home 
Screen. 

Display Top Menu. Select how you want buttons on the top menu to appear: Text and Icons 
(default), Icons Only, or Text Only. 

Side Menu. Select how you want buttons on the side menu to appear: Text and Icons 
(default), Icons Only, or Text Only. 

Left-handed layout. Select the checkbox to display the side menu on the left side of the 
screen.  
Default: not selected 

View Browser Controls. Select the checkbox to display a browser control bar that 
allows you to navigate the HTML page displayed on the ECM Home Screen. Default: 
selected 
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6. Select Printing Preferences, then select a Log from the list. Choose a printer and define the 
following settings for printing the Log, or select Set special printer to set up a non-Windows 
printer that does not appear on the printer list. 

Active If selected, the printer will be active for the selected Log. 

Preview Select to automatically display a preview of what will be printed before actually 
printing it. 

Design From a drop-down list, choose the document design to be used when printing the log. 

Paper Size From a drop-down list, select which paper size to use with this printer. 

Copies Enter the number of copies to print each time the log is printed. 

Allow Change at 
Time of Printing 

Select the options (Printer, Design, Copies, Preview) you want to be able to change 
at the time of printing. 

 

7. Click OK to exit ECM Workstation Preferences. 

Multiple Mains on Single Server 
If you have multiple Retail Pro® Main stations installed on a single server (not recommended), 
and you want to communicate with Retail Pro® 9-Series using ECM, you will need to define a 
record for each Main station in ECM Workstation Preferences. 

Command line parameters allow you to process in/out for a specific subsidiary or for all 
subsidiaries. 

To define multiple Main stations in ECM: 

1. Click Options > W/S Preferences from the ECM Home Screen, and then select  General > 
Setup. 

2. Select Retail Pro (BTF) as the Installation Type, and then click Add (<Alt+A>). 

Result: A new row displays in the Subsidiary table, ready for editing. 

3. Enter the Main station's Subsidiary No., Subsidiary Name, and Retail Pro Path. You can 
optionally enter the Subsidiary Name. 

Note: When you enter the Retail Pro path, ECM automatically pulls the Subsidiary No from 
that installation's System Preference settings. 

4. Repeat as necessary for each additional Main station. 

5. Click OK to save and exit. 

When viewing your list of stations, you can view all stations, or filter the list to display a single 
subsidiary. 
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When viewing all stations: 

 You don't have access to the Station Wizard. 

 You can communicate profiles to a specific station. 

 When processing data in/out, data for all active stations will be processed. 

 You can initialize or regenerate for a specific station or for all station. 

Some other things to keep in mind when multiple Mains are on a single server: 

 ECM Workstation Preference rules are shared across all subsidiaries. 

 ECM Workstation preference appearance settings are shared across all subsidiaries. 

 If the Subsidiary No. is entered prior to the Retail Pro Path, and there is a discrepancy, a 
warning dialog is displayed. 

 ECM Printing preferences are shared across all subsidiaries. 

 

Network Security 
When communicating data across shared network resources, you need to define your network 
user credentials in ECM Workstation Preferences. Entering this information allows ECM to know 
the correct mapped network drives to use during disk communication. 

To enter network user credentials: 

1. Select Options > W/S Preferences from the ECM Home Screen. 

2. Select General > Network Security. 

3. Click the checkbox for Allow ECM Exchange to copy files from a mapped drive. 

4. Enter your network User Name and Password and select the network Domain you are using. 

5. Click OK on the side menu. 

Password Changes 
If you change your network password, be sure to enter the new password in ECM Workstation 
Preferences, too, or communication errors may result. 

Network Resource Assignment 
Ensure that the account assigned within ECM is also assigned to all Retail Pro 9 Series resources 
and folders. In a multi-main server environment, each \RetailPro9 folder for each Retail Pro 
installation must have this account assigned with full access privileges.  
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Stations 
About Stations 
A station is a database that exchanges information with another database. You also need to create 
a station record for each station with which you will communicate. 

You can create the following types of stations: 

 Remote (RPRO 8x) is an 8-Series Remote station. 8 Series Remote stations use a BTF 
database and lack some of the capabilities of a Main. Remote stations are typically used 
for specialized functions such as point of sale or backroom and communicate with 8-
Series Mains via polling. 

 Main (RPRO8x) is an 8-Series Main station. 8 Series Main stations use a BTF database 
and serve as smaller hubs. 

 Main (Oracle) is the corporate hub station and central data repository for the corporation. 

 Retail Pro 9 (Oracle) is a 9-Series (Oracle) Remote station. 

 Other is used when sending data somewhere other than to a Retail Pro database. For 
example, when sending data to a purchasing system, employee management system, or 
customer management system. 

 IPMS is an IPMS database. (Future release) 

Each station record specifies: 

 The type of station (Enterprise, Main, or Remote), and identification information for the 
station. 

 The communication method being used: Internet, Modem, or Disk. 

 The types of data to send/receive. You can do this by assigning a profile, or defining a 
new profile as you create a station's record. 

 Whether or not the station is Active. When communication is launched, your station 
communicates with all Active stations. 

Whether or not the station manages inventory. You can have the Retail Pro 9-Series station 
manage inventory, or allow the 8-Series Main to manage inventory. 

The Station Wizard leads you step-by-step through the process of creating stations. 

Checklists and Profile Tools 

When configuring a station, you control how the station sends/receives data by configuring 
checklist options and profile tools. 

 The checklist controls how data is sent by the station 

 Profile tools control how data is received by the station 
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 Creating a Station 
You can create a station manually, or by using the Station Wizard. The Station Wizard leads you 
step-by-step through the process of adding a station.  

Before creating a station, consider the following:  

 You must configure your own station's preferences before you can create a station record 
at another subsidiary. See ECM Workstation Preferences for details about configuring 
your station preferences.  

 To create a station record for Retail Pro 9 (Oracle) on the Retail Pro 8 (BTF) side, follow 
the instructions in Station Setup at Retail Pro 8. 

To create a new station using the Station Wizard: 

1. Click Stations on the top menu of the ECM Home Screen. 

2. Select a Subsidiary from the drop-down list, then click Station 
Wizard.  

Result: The Station Wizard launches. 

 

 

 

 

 

 

 

 

 

 

3. On the Select Options screen, select Create a new station, then click Next. 
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Result: A screen for entering details about the new station is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the type of station with which this station will communicate: 

Retail Pro (BTF-based): If communicating with a Retail Pro BTF database, select if it is a Main 
Station or Remote Station. 

Retail Pro (Oracle-based): If communicating with a 9 Series Oracle database, select if it is a Main 
Station, otherwise, click Remote Station. 

Other Types: Select IPMS if communicating with an IPMS station, otherwise, select Other. 

Subsidiary #: Enter the number of the Retail Pro® 9 Series subsidiary to which the station is 
assigned. 

Store/Station: Enter the Retail Pro Store/Station combination to assign to this station. 

Note: The Store/Station field is required for all station types; however, you may also enter a 
Global Store Code if you create a Oracle-based Main or remote. 

Global Store Code: (Optional) Enter the Global Store Code you are assigning to this station. 

Station Name: Enter a unique name for the station (used for identification purposes). 
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4. Click Next (<Alt+N>) to continue. 

Result: A screen for entering details about the communication method is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. On the Communication Details screen, make the following selections: 

Section Description 

Communication 
Device 

Select a communication method, then enter the location of that device. 

Login 
name/Password 

 The Login name that you enter must be unique (no other station can 
have the same login name).  

 ECM used the Login name and Password to verify the station's 
identity upon startup.  

Use 
compression... 

Select to send all data from Retail Pro® 9-Series in a compressed format, 
saving transmission time. 

 

6. Click Next (<Alt+N>). 

Result: The Station Completion screen displays. 

7. On the Station Completion Screen, select one of the following options: 

 Click Finish (<Alt+F>) to save the station details and return to the list of stations. 

 Click Next (<Alt+N>) to select or create a profile for the station. (See Creating a 
Profile for instructions.) 

 Click Repeat (<Alt+R>) to return to the beginning of the wizard, where you can add 
another station. 
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To create a new station (without using the Station Wizard): 

1. Click Stations on the top menu of the ECM Home Screen. 

2. Select a Subsidiary from the drop-down list. 

3. Click New on the top menu. 

4. Click Form (<Alt+V>). 

5. Enter information about the station in the station fields and assign or create a profile. 

6. Click Save. 

Sample Station Records for Retail Pro 8-Series (BTF) and 9-Series 
(Oracle) Stations 
Retail Pro 8 Station Record at Retail Pro 9 ECM Side 

 
 

Retail Pro 9 Station Record at Retail Pro 8 ECM Side 
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Copying a Station 
A fast way to create a new station is to copy an existing station that offers the closest match. You 
can copy a station using the Station Wizard or by selecting Copy from the top menu in the 
Stations area.  

To copy a station using the Station Wizard: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Click Station Wizard on the side menu. The Station Wizard launches. 

3. Select Copy an Existing Station from the opening screen of the wizard, and then select a 
station from the drop-down list. Click Next after you have selected a station. 

4. Navigate through the screens of the wizard, making any necessary changes to the copied 
information. Be sure to enter a unique Name for the station and assign a unique Store/Station 
identifier. 

5. Click Finish when you reach the Station Completion screen of the wizard.  

You can also copy a station directly from the list of stations. 

To copy a station: 

1. Select Stations from the top menu of the ECM Home Screen. The list of stations 
displays. 

2. Select a Subsidiary and a station, and then click Copy.    

3. Enter the stations unique identifying information. 

 Station Name  

 Store/Station 

 Login Name 

 Global Store Code 

4. Edit the other fields, if necessary. 

5. Click Save (<Alt+S>). 
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Editing a Station 

To edit a station: 

1. Click Stations on the top menu of the Home Screen. 

Result: The list of stations displays. 

2. Select the station that you want to edit. 

Suggestion: For easier editing, select Form View (<Alt+V>) from the top menu to display the 
station record in Form View. 

3. Make any necessary changes to the station's fields.  

4. Click Save. 

 

Deleting a Station 

To delete a station record: 

1. Click Stations on the top menu of the ECM Home Screen. 

Result: The list of stations displays. 

2. Select the Station that you want to delete. 

3. Click Delete (<Alt+D>) and then click Yes to confirm the deletion. 

Result: You are asked if you want to delete the corresponding polling directory for the 
station. Click Yes to delete (clean up) the directory, or click No if you think you might 
recreate the station and want to use the same directory. 

Note: It is dangerous to delete a station without also deleting its folder. If the folder contains 
unprocessed files or files that were not communicated, then these same files will be present 
and used the next time that station type is created using this same directory. 
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Station Setup at Retail Pro 8 (BTF) 
Define a station record for Retail Pro 9 (Oracle) at each RP8 (BTF) station that will communicate 
with RP9. Please note that there are some key differences between the subsidiary station records 
created at the Retail Pro 9 station, and the station record created at Retail Pro 8 stations. 

Important: At the Retail Pro 8 station, the computer running ECMProc.exe must have its language 
settings for both the system AND user set to the same language. 

Sample Station Records for Retail Pro 8 and 9 Stations 
Retail Pro 8 Station Record at Retail Pro 9 ECM Side 

 
 

Retail Pro 9 Station Record at Retail Pro 8 ECM Side 
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The table below provides details about the station record fields on the 9-Series side and on the 8-
Series side. 

Field 9-Series (Oracle) Side 8-Series (BTF) Side 

Active Selected Selected 

Name Enter name for the station with 
which you want to communicate. 

Enter your station's name. 

Sbs No Enter the subsidiary number of the 
station with which you want to 
communicate. 

Enter your station's subsidiary number 

Global Store 
Code 

Enter the Global Store Code of the 
station with which you want to 
communicate (must match the entry 
on the 8-Series side). 

Enter your station's Global Store Code 
(must match the entry on the 9-Series side). 

Store/Station Enter the store number and station 
identifier (0, A, B, etc.) of the station 
with which you want to 
communicate. 

Enter your station's store number and 
station identifier (0, A, B, etc.). 

Station Type Select Main (RPRO 8x) as the type 
of station with which you want to 
communicate. 

Select Main (Oracle) as the type of station 
with which you want to communicate. 

Preferred Device Select the type of device that you 
want to use for communication. 

Select the type of device that you want to 
use for communication — Internet or 
Modem. 

Deliver Files To (Disc communication only) Enter the 
path to the remote’s \In\Recvd 
directory, where Exchange delivers 
files to this station. 

(Disc communication only) Enter the path to 
the remote’s \In\Recvd directory, where 
Exchange delivers files to this station. 

Pick Up Files 
From 

(Disc communication only) Enter the 
path to the station’s \Out\ directory, 
where Exchange picks up files from 
this station. 

(Disc communication only) Enter the path to 
the station’s \Out\ directory, where 
Exchange picks up files from this station. 

Host Name/IP 
Address 

Enter the station's Host Name/IP 
Address. On the 9-Series (Oracle) 
side, this will be the Host Name/IP 
Address of the 8-Series (BTF) 
station with which you want to 
communicate. 

Enter the station's Host Name/IP Address 
(Internet communications).On the 8-Series 
(BTF) side, this will be the Host Name/IP 
Address of the 9-Series (Oracle) station with 
which you want to communicate. 

Login Name Enter a Login Name (must be the 
same as the Login Name entered 
on the 8-Series (BTF) side). 

Enter a Login Name (must be the same as 
the Login Name entered on the 9-Series 
(Oracle) side). 

Password Enter a password. This password 
must be the same as the password 
entered on the 8-Series side. 

Enter a password. This password must be 
the same as the password entered on the 9-
Series side. 

Phone Book 
Entry 

Enter your phone book entry 
(modem communications). 

Enter your phone book entry (modem 
communications). 
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Station Fields 
The following table lists the fields available for station records. 

Field Description 

Active If selected, the station is active and able to send/receive data. If not selected, the 
station is not able to send/receive data. 

Checklist The list of data types that can be selected for communication. 

Deliver Files to The full path to the folder where ECM will deliver files for the station. Typically, this 
is the Polling\[Station]\In\Recvd folder. 

Exclude 
Committed Qty 

If selected, committed quantities are excluded from communication. 

FTP Passive Selected by default when you select FTP as the Preferred Device. 

Glob Store Code (Optional) Enter the Global Store Code you are assigning to this station. 
(Maximum 10 characters) 

Host Name/IP 
Address 

The Host Name/IP Address of the server. 

Limit XML File 
Size 

If selected, ECM breaks up a single XML file into multiple files preventing a single 
data type file from becoming too large. 

Login Name The name of the login user allowed to perform communications. (Maximum 30 
characters) 

Name Enter a unique descriptive name for the station. (Maximum 25 characters) 

Password The password of the Login Name user. (Maximum 30 characters) 

Phone Book Entry (Modem communications) The phone book entry, when using Modem 
communication. 

Pick Up Files 
From 

The full path to the folder where ECM will pick up files for the station. Typically, 
this is the Polling\[Station]\Out folder. 

Port Number The port number to be used for communication. Default = 20000 

Preferred Device Select how communication will be performed:  

Disk: If you select Disk, enter a Pick Up Files From and Deliver Files To path. 

Modem: If selected, enter a Host Name/IP Address, Port Number, and Phone 
Book Entry. 

Internet: If selected, enter a Host Name/IP Address and Port Number. 

FTP: If selected, enter a Host Name/IP Address, Port Number, and Retrieve Files 
From/Deliver Files To paths. 

Sbs No The subsidiary to which the station belongs. Reference: See About Subsidiaries 

Skip Inacative 
Inventory 

If selected, inactive inventory items will be skipped when processing in the 
station’s inventory items. 
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Field Description 

Station Type The type of station that you will be communicating with: 

Remote (RPRO 8x): Select if this station record is for a Retail Pro 8 Remote. 

Main (RPRO 8x): Select if this station record is for a Retail Pro 8 Main. 

Main (RPRO 9x): Select if this station record is for a Retail Pro 9 Remote. 

Remote (RPRO 9x): Select if this station record is for a Retail Pro 9 Main. 

Other: Select "Other" if communicating with a type not listed. 

IPMS: Select IPMS if communicating with an IPMS station. 

Store/Station The store/station combination for the station. For example, 001A, 0002B, etc. 

Use Compression If selected, ECM will use compression when generating the XML files to minimize 
their size. 

Use XML Schema If selected, the resulting XML files display all information that can be displayed. 
Selecting this option is useful if you are creating custom XML information because 
you can see all available information from the schema; however, selecting this 
option will increase the size of the XML files. 

If not selected, the XML file only displays schema information that is relevant to 
the data that is being processed out. Not selecting this option makes the XML files 
smaller.  

Default= Not selected 
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Profiles 
About Profiles 
A profile consists of: 

 Types of data that will be sent from a station (profile checklist) 

 Additional settings for controlling the processing of data received from the station 
(profile tools) 

Rather than defining these settings from scratch for each station, you can create profiles and 
assign those profiles to individual stations as necessary. Assigning a profile lets you select all of a 
station's data exchange settings with a single selection and ensures consistency in 
communications. 

Profiles can be created at any station. Profiles created at one station can be communicated to and 
viewed at other stations, but not modified. 

A station's profile is always used during an automated communications cycle. If no profile is 
assigned to a station, then the default profile is used when processing data. A station's profile can 
be overridden by manually launching communications from a Remote station. 

Changing Profiles 
If you assign a profile to a station and then change that profile, the changes will not be updated 
for that station. To have the changes take effect, you must reassign the profile. 

Profiles File 
Each profile's configuration details are stored in the Profiles.xml file, which is located in the 
ECM\Profiles folder. 
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Profile Checklist 
The Profile Checklist is used to control the type of data that is sent from a station.  

For each data type, you can select when you want to send data to the station. The options vary 
depending upon the data type. See Checklist Recommendations below for recommended settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

While viewing a profile in Form View, select data exchange options using one of the following 
methods: 

Method 1: Select one of the header options to assign the option to all data types for the station. For 
example, if you select All in the header, then All is selected for each individual data type. You can 
then select a different option, if necessary, for individual data types. 

Method 2: Select the plus sign next to the Profile name to display the list of nodes. Select a node 
and then select an option for individual data types. 

When selecting data types, select from the following options: 

None: Select None if you never want to send the data. 

All: Select All to always send the data. 

Differences: Select Differences to send only new or changed records. 

Images: Select Images to send any images associated with the records. Warning: Selecting Images 
can significantly affect transmission times, so typically it is not selected. 
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Listed below is a description of each data type category. 

Merchandise 
Checklist Option Description Available Settings 

Vendor UDFs User-defined fields for vendor records, defined 
in Local Preferences > Merchandise > Vendors 
> User-defined. 

None, All 

Item UDFs User-defined fields for inventory items, defined 
in Local Preferences > Merchandise > User-
defined/Auxiliary. 

None, All 

DCS Department records, defined in the 
Departments area. 

None, All, and Images 

Vendor Vendor records, defined in the Vendors area. None, All, and Images 

Kit Components Kits and their component items, defined in the 
Package and Kit area. 

None, All 

Inventory Inventory information, defined in the Inventory 
area. 

None, All, Differences, and 
Images 

Markdowns Price Markdown information, defined in the 
Price Manager area. 

None, All, and Differences 

PI Counts Physical inventory count information, defined in 
the Physical Inventory area. 

None, All 

 

Documents 
Checklist Option Description Available Settings 

Receipts Receipt records from the Receipts area. None, All, Differences 

Adjustment Memos Adjustment Memo records from the 
Adjustments area. 

None, All, Differences 

Transfer Slips Out slip records from the Slips area. None, All, Differences 

Vendor Invoices Vendor invoice records from the Vendor 
Invoices area. 

None, All, Differences 

Vouchers Voucher records from the Vouchers area. None, All, Differences 

Transfer Orders Transfer Order records from the Transfer 
Order area. 

None, All, Differences 

Sales Orders Sales order records from the Sales Order 
area. 

None, All, Differences 

Purchase Orders Purchase order records from the Purchase 
Orders area. 

None, All, Differences 

Former Z-Outs Former Z-Out reports from the Former Z-Out 
area. 

None, All, Differences 

Pending APR Pending Archive/Purge information from the 
Archive/Purge area of Technician’s Toolkit. 

None, All, Differences 
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Customers 
Checklist Option Description Available Settings 

Customer UDF User-defined fields for customer records, 
defined in Local Preferences > Customers > 
UDF/Aux. 

None, All 

Customers Customer records, defined in the Customers 
area. 

None, All, Differences and Images 

Customer Address 
Types 

Customer Address Types defined in System 
Preferences > Local Preferences > 
Customers > General. 

None, All 

 

Employees 
Checklist Option Description Available Settings 

Commission Schedules Commission information defined in 
Employee Mgmt > Commissions. 

None, All 

Time Shifts Time Shift information defined in Employee 
Mgmt > Time Shifts. 

None, All 

Employees Employee records defined in Employee 
Mgmt > Employees. 

None, All 

Store Sales Target Sales Target information for stores defined 
in Employee Mgmt > Sales Targets. 

None, All, Differences 

Employee Sales Target Sales Target information for employees 
defined in Employee Mgmt > Sales Targets. 

None, All, Differences 

User Groups User groups defined in Employee Mgmt > 
Groups. 

None, All 

Tills Till information defined in System 
Preferences > Local Preference > Point of 
Sale > General > Options. 

None, All 

 

Pricing 
Checklist Option Description Available Settings 

Discount Reasons Discount reasons defined in Local 
Preferences > Point of Sale > General > 
Price/Discounts. 

None, All 

Discount Schedules Discount handling information defined in 
Local Preferences > Merchandise > Pricing 
> General. 

None, All 

Price Rounding Price Rounding information defined in Local 
Preferences > Merchandise > Pricing > 
Advanced. 

None, All 

Price Adjusting Price Adjusting information defined in Local 
Preferences > Merchandise > Pricing > 
Advanced. 

None, All 
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Preferences 

Checklist Option Description Available Settings 

Preferences This option covers preferences not covered by the more 
specific preference options described elsewhere in this 
table. 

None, All 

Price Levels The names of your price levels and their discount 
percentages relative to the base price level, defined in Local 
Preferences > Merchandise > Pricing > General. 

None, All 

Tax Codes The list of tax codes that can be assigned to items, defined 
in Local Preferences > Taxes > Tax Codes. 

None, All 

Tax Areas The list of tax areas, defined in Local Preferences > Taxes 
> Tax Areas. 

None, All 

POS Fee Types The types of fees to be available for entry on receipts and 
Sales Orders, defined in Local Preferences > Point of Sale 
> General > Fees/Shipment. 

None, All 

Purchase Fee Types The types of fees to be available for entry on purchase 
orders and vouchers, defined in Local Preferences > 
Purchasing > General. 

None, All 

Stores The list of your stores and information about those stores, 
defined in Local Preferences > Stores > General.  

None, All 

Receipt UDFs Custom labels for user-defined fields on Receipts, defined 
in Local Preferences > Point of Sale > Receipts > 
Comments. 

None, All 

Credit Cards The list of credit cards and ranges accepted by your 
business, defined in Local Preferences > Point of Sale > 
Tenders > Credit Card. 

None, All 

Titles The list of titles (e.g., Mr., Mrs., Miss) that you can enter in 
customer and vendor records, defined in Local Preferences 
> System > Titles. 

None, All 

Allocation Patterns Allocation Patterns (used to allocate merchandise among 
multiple stores by specifying the relative quantities to be 
ordered for each store), defined in Local Preferences > 
Merchandise > Scales (in the Definition area of the Scales 
screen). 

None, All 

Scales The grid scales to be available when creating new styles, 
defined in Local Preferences > Merchandise > Scales. 

None, All 

Regions The list of regions and/or districts and the stores assigned 
to those regions/districts, defined in Global Preferences > 
Regions > Options. 

None, All 
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Checklist Option Description Available Settings 

Receipt Comments The list of comments to be available for entry on receipts, 
defined in Local Preferences > Point of Sale > Receipts > 
Comments. 

None, All 

SO Comments The list of comments to be available for entry on sales 
orders, defined in Local Preferences > Point of Sale > Sales 
Orders > Comments. 

None, All 

Slip Comments The list of comments to be available for entry on slips, 
defined in Local Preferences > Transfers > Comments. 

None, All 

Voucher Comments The list of comments to be available for entry on vouchers, 
defined in Local Preferences > Purchasing > Comments. 

None, All 

Currency A list of the currencies that you use in your store operations, 
defined in Global Preferences > Currency. 

None, All 

Rates Exchange rates for your currencies, defined in Global 
Preferences > Currency. 

None, All 

POS Tenders The list of tenders (cash, check, credit card, etc.) that will be 
available at cash registers, defined in Local Preferences > 
Point of Sale > Tenders > Tender Requirements. 

None, All 

Purchase Terms Default payment terms, defined in Local Preferences > 
Point of Sale > Receipts > Tenders/Terms. 

None, All 

Ship Methods The list of transportation carriers defined in Local 
Preferences > Point of Sale > Sales Orders > Options. 

None, All 

Ship Instructions Shipping Instructions that are available for entry on 
Purchase Orders, defined in Local Preferences > 
Purchasing > Comments. 

None, All 

Adjustment Reasons The list of adjustment reasons to be available when making 
adjustment memos, defined in Local Preferences > 
Merchandise > Adjustments. 

None, All 

Postal Codes Preferences related to handling ZIP/Postal Codes, defined 
in Local Preferences > System > General.  

None, All 

Sublocations This setting communicates the following preference settings 
in Local Preferences > Merchandise > Sub Locations: 

 Enable Sub Locations 
 Default Sub Locations to Managed 
 Default New Items to Sub Locations 
 Restrict Negative Quantities in Sub Locations 

None, All 

Store/Station/WS Workstations can have default stores/stations assigned, 
enabling the workstation to make specific types of records 
and/or documents for those stores and stations. 

None, All 

Transfer Rules Transfer Rules, defined in Global Preferences > Company > 
Transfer Rules.  

None, All 
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Checklist Option Description Available Settings 

Default Stores Default stores to be used when creating individual 
document types. This setting is defined in Local 
Preferences > Documents > Default Stores. 

None, All 

Field Lengths Settings for defining the length of various fields. None, All 

Track Adjustment 
Logs 

Track Adjustment Logs setting. None, All 

Document 
Sequences 

Settings for the next sequential number to be assigned to 
individual document types, defined in Local Preferences > 
Documents > Sequences. 

None, All 

Seasons Season information, defined in Global Preferences > 
Calendars > Seasons. 

None, All 

Disbursement 
Reasons 

Disbursement Reasons, defined in Local Preferences > 
Receipts > Disbursement Options. 

None, All 

Countries Country information, as defined in Global Preferences > 
Locality. 

None, All 

Languages Language information, defined in Global Preferences > 
Locality. 

None, All 

Transfer Reasons Transfer reasons, defined in Local Preferences > Transfers 
> Comments/Reasons. 

None, All 

Item Groups Item group information defined in Local Preferences > 
Merchandise > General 

None, All 

Item Ranges Item range information defined in Local Preferences > 
Merchandise > General 

None, All 

Transfer Fee Types Transfer fee types defined in Local Preferences > Transfers 
> General. 

None, All 

Transfer Stores The estimated in-transit time between store pairs, defined in 
Local Preferences > Transfers > In Transit Rules. 

None, All 

Transfer Definitions Verification rule definitions, defined in Local Preferences > 
Transfers > In Transit Rules. 

None, All 

Receipt Item 
Reasons 

Reasons for items voids and item returns, defined in Local 
Preferences > Point of Sale > Receipts > Returns/Voids. 

None, All 

Store Classes Store Classes defined in Local Preferences > Stores > 
General. 

None, All 

Store Types Store Types defined in Local Preferences > Stores > 
General. 

None, All 

Job Titles Job titles defined in Global Preferences > General. None, All 
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Sub Locations 
Checklist Option Description Available Settings 

Sub Location 
Segments 

Sub location segments defined in System 
Preferences > Local Preferences > 
Merchandise > Sub Locations. 

None, All 

Sub Locations Sub location information defined in 
Merchandise > Sub Locations. 

None, All 

Default Sub Locations Default sub locations assigned to individual 
document types at each store, defined in 
System Preferences > Local Preferences > 
Merchandise > Sub Locations. 

None, All 

Sub Location Qtys The quantities in individual sub locations. None, All, Differences 

 

General Checklist Recommendations 
The recommendations below are general ones. Each retailer’s checklist settings will vary 
depending upon the features the retailer is using and the retailer’s specific needs. 

Area Retail Pro 9 Retail Pro 8 Series Main 

Merchandise 

Vendor UDFs None None 

DCS None None 

Vendors None None 

Kit Components None None 

Inventory Differences None 

Markdowns None None 

PI Counts All All 

Documents 

Receipts Differences Differences 

Adjustment Memos None None 

Transfer Slips All Differences 

Vendor Invoices None None 

Vouchers None Differences 

Transfer Orders All None 

Sales Orders Differences Differences 

Purchase Orders All Differences 

Pending APR All None 

Customers 

Customer UDFs All None 

Customers Differences Differences 
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Area Retail Pro 9 Retail Pro 8 Series Main 

Customer Address Types All None 

Employees 

Commission Schedules None None 

Employees  None None 

Time Shifts None None 

Store Sales Target None None 

Employee Sales Target None None 

User Groups None None 

Tills None None 

Pricing 

Discount Reasons None None 

Discount Schedules None None 

Price Rounding None None 

Price Adjusting None None 

Preferences 

Preferences None None 

Price Levels None None 

Tax Codes None None 

Tax Areas None None 

POS Fee Types None None 

Purchase Fee Types None None 

Stores None None 

Receipt UDFs None None 

Credit Cards None None 

Titles None None 

Allocation Patterns None None 

Scales None None 

Regions None None 

Receipt Comments None None 

SO Comments None None 

Slip Comments None None 

Voucher Comments None None 

Currencies None None 

Rates None None 
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Area Retail Pro 9 Retail Pro 8 Series Main 

POS Tenders None None 

Purchase Terms None None 

Ship Method None None 

Ship Instructions None None 

Adjustment Reasons None None 

Postal Codes None None 

Sublocations None None 

Store/Station/WS None None 

Transfer Rules None None 

Default Stores None None 

Field Lengths None None 

Track Adjustment Logs None None 

Document Sequences All All 

Seasons None None 

Disbursement Reasons None None 

Countries None None 

Languages None None 

Transfer Reasons None None 

Item Groups None None 

Item Ranges None None 

Transfer Fee Types None None 

Transfer Stores None None 

Transfer Definitions None None 

Receipt Item Reasons None None 

Store Classes None None 

Store Types None None 

Job Titles None None 

Sub Locations 

Sub Location Segments None None 

Sub Locations None None 

Default Sub Locations None None 

Sub Location Quantities None None 

Profile Tools 

Manage Inventory Qty and 
Cost for this Station. 

Enabled Disabled 
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Area Retail Pro 9 Retail Pro 8 Series Main 

Manage Inventory Price for 
this Station 

Enabled Disabled 

Auto-update Vouchers 
received from this station. 

Enabled Disabled 

Purge Marked Slips during 
Communication 

Enabled Disabled 

Purge Marked ASNs during 
Communication 

Disabled Disabled 

Manage Inventory 
Descriptions 

Enabled Disabled 

Manage Customer Balances Disabled Disabled 

Manage Employee Security Enabled Disabled 

Compare Inventory Modified 
Dates 

Disabled Disabled 

Manage Committed Qty Disabled Disabled 

Accept Inventory cost for 
items with zero qty 

Enabled Disabled 

Accept Inventory price for 
items with zero qty 

Enabled Disabled 

Accept Inventory cost for 
new items with zero qty 

Enabled Disabled 

Accept Inventory price for 
new items with zero qty 

Enabled Disabled 

 

Profile Tools 
Profile tools are special settings associated with a profile to give you greater control over a 
station's data. Profile tool settings determine whether the Retail Pro 9 (Oracle) or 8 (BTF) station 
manages inventory. 

 If you select profile tools for a single station's profile, then the profile rules apply only to 
that station.  

 If you select profile tools for a profile assigned to multiple stations, then the rules apply 
to all stations using that profile. 

To define profile tools for a single station: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Select the Station for which you want to define profile tools, and then click Form View 
(<Alt+V>). 

3. Under Checklists, select Profile Tools. 

4. Select the Enable field for individual tools, as necessary. 
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Refer to the following table for information. 

Option Description 

Manage inventory 
quantity and cost for 
this station 

Select this option to have your station manage inventory quantities and costs 
for the selected station. 

Only transactional documents received from the station will affect the 
station's inventory quantities and costs, not the station's inventory file. If 
someone manually changes an item's quantity at the station (no document 
created), when your station receives the inventory file, that change would be 
ignored. 

When sending data to the selected station, the inventory quantities and costs 
that you send will overwrite the inventory quantities and costs at the station. 

Manage Inventory 
price for this station 

Select this option to have your station manage inventory prices for the 
selected station. 

Transactional documents received from the station affect the station's 
inventory prices, but not the station's inventory file. If someone manually 
changes an item's price(s) at the station (no document created), that change 
is ignored when your station receives the inventory file. 

When sending data to the selected station, the inventory prices that you 
send overwrite the inventory prices at the station. 

Auto update vouchers 
received from this 
station 

Select this option to automatically update any vouchers that your station 
receives from the selected station. If this option is not selected, any vouchers 
that your station receives from the station will be added to the Pending 
Voucher file, where they can be reviewed and updated. 

Purge marked slips 
during communication 

Select this option to automatically delete any slips marked for deletion that 
your station receives from this station. If this option is not selected, then slips 
that are marked for deletion will be added to the slips file. 

Purge Marked ASNs 
during communication 

Select this option to automatically delete any ASNs marked for deletion that 
your station receives from this station. If this option is not selected, then 
ASNs that are marked for deletion will be added to the ASN file. 

Manage Inventory 
Descriptions 

Your station manages inventory descriptions for the selected station. ECM 
sends ALL inventory item descriptive elements. 

Note: Depending on the size of your inventory, selecting the Manage 
Inventory Descriptions option can result in a large file transfer during ECM 
communication.  

When sending data, the inventory descriptions that you send will overwrite 
the descriptions at the station. 

Manage Customer 
Balances 

The station manages customer balances (via the Charge Balance and 
Charge Limit fields in the customer record) for the selected station. 

Manage Employee 
Security 

If selected, your station manages employee security settings for the selected 
station. 

This means that the following information will not be imported: 

1) password policies from PasswordPolicies.xml 

2) employee logon credentials from Employee.xml 

3) employee group assignment from Employee.xml 

4) employee store assignment from Employee.xml 

5) list of user groups from UserGroup.xml 
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Option Description 

Compare Inventory 
Modified Dates 

When the Compare Inventory Modified Dates flag is selected for a 
station, descriptions for existing items will be updated if the Last Modified 
Date in the Inventory.xml file is NOT OLDER than the Last Modified Date in 
the database. This allows stores to edit item descriptions without them being 
accidentally overwritten by data from the station that is managing 
descriptions. (See Compare Inventory Modified Dates note below for 
detailed information.) 

Manage Committed 
Quantities 

If selected, ECM will ignore committed quantities when processing in 
inventory data and update corresponding fields only when actual order 
document arrives.  

If not selected, ECM will update committed fields when inventory records are 
processed and skip updating of committed fields when handling documents. 

Recommended configurations: 

1) Regular v9-to-v9 polling - "manage committed quantities" should be set to 
the same state as "manage inventory quantity/cost" option. 

2) v9-to-v9 polling when source station has "skip committed" option checked 
- "manage committed quantities" should be selected (checked) at the target 
station, because the source station will not include committed fields in the 
XML, and updating them through documents is the only way to propagate 
them. 

3) v8-to-v9 polling - "manage committed quantities" should be selected on 
the 9-series side, because EcmProc does not include committed fields in the 
XML when inventory is exported from the v8 BTF database. 

Note: This option is tied indirectly to "manage inventory qty/cost" in the ECM 
station profile - when you change the state of "manage inventory qty/cost" 
ECM will automatically change "manage committed quantity" to match it (to 
support the most common v9 to v9 configuration - see  #1above for details). 
If you need to change the default setting, you must do it manually. Always 
select the proper setting for the "manage inventory qty/cost" option first, 
THEN AND ONLY THEN change the setting for "manage committed 
quantities," if necessary. 

Note: This option only affects ECM on the 9-series side. On the BTF side, 
ECM ALWAYS updates committed quantities when it receives a new or 
updated order document. 

Note: This option is turned OFF by default for existing stations, so be sure to 
set it properly for existing stations when install the maintenance pack (MP). 
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Option Description 

Accept Inventory 
Price/Cost for items 
with zero qty 

Accept Inventory 
Price/Cost for new 
items with zero qty 

If selected (checked), inventory price/cost values imported into Retail Pro 9 
will be accepted under two conditions: 

1) price/cost is NOT managed on receiving side, OR 

2) price/cost IS managed on receiving side AND current on-hand quantities 
are zero. 

If not selected (unchecked), price/cost information for zero-quantity items will 
remain managed (i.e., be ignored). Previously, price and cost information 
was always accepted for zero-quantity items. 

These options are only analyzed when the corresponding "manage inventory 
qty/cost" or “manage inventory price” profile tool is checked.  

(Default = All options are selected) 

These flags provide added flexibility in two key situations: 

 When brand new items are imported into Retail Pro 9 inventory 

 When existing items are (re)imported into inventory 

Adjustment Memos 

Cost adjustment memos created for the imported items follow these 
guidelines: 

If "Accept Inventory Cost for items with zero qty" is CHECKED, the cost 
adjustment will not be applied to items when the adjustment quantity is zero. 
In that case, cost will be delivered by inventory polling. 

If “Accept Inventory Cost for items with zero qty” is UNCHECKED, the cost 
adjustment will be applied to ALL items, regardless of their quantity (because 
inventory cost will be rejected unconditionally). This is applicable to 
scenarios when the "manage inventory qty/cost" option is CHECKED. 

Note for 9.20 users: There is a preference called "Create price adjustments 
for items with zero O/H qty" in System Preferences > Local Preferences > 
Merchandise > Adjustments page. It is strongly recommended to have this 
option CHECKED on all stations when "accept inventory price" options are 
UNCHECKED on the inventory managing polling station. Selecting this 
option will mean simplify price polling because fewer price adjustment 
memos will have to be manually created. 

Does Not Affect Retail Pro 9 

Clearing these flags do not affect the behavior of Retail Pro 9; only ECM is 
affected. For example, Retail Pro 9 will NOT produce price/cost adjustments 
for zero-quantity items when they are edited in inventory. In that scenario, 
either adjustment memos will need to be created manually or the user 
should make all price/cost changes on the managing side. 

Inactive Items 

If an item has been imported into Retail Pro 9, but as inactive, then the item 
is considered an EXISTING item. This typically occurs if an item is listed on 
Invoice.xml or other document XML which was imported before the 
inventory.xml file was imported. 

 

5. Click Save. 
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Compare Inventory Modified Dates Flag 
The Compare Inventory Modified Dates flag gives you greater control over the management of 
inventory description information. Use the Compare Inventory Modified Dates flag with the 
Manage Inventory Descriptions flag to ensure that inventory descriptions are updated correctly. 

When the Compare Inventory Modified Dates flag is selected for a station, descriptions for 
existing items will be updated if the Last Modified Date in the Inventory.xml file is NOT OLDER 
than the Last Modified Date in the database. This allows stores to edit item descriptions without 
them being accidentally overwritten by data from the station that is managing descriptions.  

For example, considering the following scenario:  

Store A and Store B are both NOT managing inventory descriptions. 

1. Store A deactivates an item at 1pm.  

2. Store B edits the item at 2pm and creates a document against it. 

3. Store A sends the inactive item to Store B at 3 p.m.  

Result: If the Compare Inventory Modified Dates flag is selected for Store B, Store B will not 
accept the item and the changes will be preserved. If the Compare Inventory Modified Dates 
flag is NOT selected, Store B will accept the item, erasing the changes made earlier.  

Note: If the Manage Inventory Descriptions flag is selected, descriptions for existing items will 
be rejected, regardless of the item’s Last Modified Date 

New Item Descriptions 

New items and their descriptions are always added to the database, regardless of the settings for 
Manage Inventory Descriptions and Compare Inventory Modified Dates. 

Managing Item Descriptions Using the “Manage Inventory Descriptions” and “Compare 
Inventory Modified Dates” Flags 

The following table lists typical communication scenarios using the Managing Item Descriptions 
and Compare Inventory Modified Dates flags. 

 Station A Station B Notes 

Single Station 
Manages 
Inventory 

Manage Inventory 
Descriptions = Yes 

Compare Inventory 
Modified Dates = No 

Manage Inventory 
Descriptions = No 

Compare Inventory Modified 
Dates = No 

Manage Inventory 
Descriptions is selected, 
so descriptions for 
existing items will be 
rejected, regardless of 
the item’s Last Modified 
Date. 

Both Stations 
Manage Inventory 

Manage Inventory 
Descriptions = No (allow 
editing by both stations) 

Compare Inventory 
Modified Dates = Yes 

Manage Inventory 
Descriptions = No 

Compare Inventory Modified 
Dates = Yes 

Descriptions for existing 
items are updated if the 
Last Modified Date in the 
XML is not older than the 
Last Modified Date in the 
database. 

Station Used 
Only for Initial 
Import of Items 
from 3rd-Party 
Database 

Manage Inventory 
Descriptions = No 

Compare Inventory 
Modified Dates = No 

 New items and their 
descriptions are always 
added. 
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 Station A Station B Notes 

Station used for 
Initial Import and 
Update of 
Existing Items 
from 3rd-Party 
Database: 

Manage Inventory 
Descriptions = Yes 
(Alternatively, No, 
depending on whether 
you are importing 
price/cost, or just 
descriptions) 

Compare Inventory 
Modified Dates = Yes 

  

Note: By default the Compare Inventory Modified Dates flag is unchecked for all existing stations.  

How Compare Inventory Modified Dates Flag Affects New and Existing Items. 

The following table explains how the possible combinations of the Manage Inventory 
Descriptions and Compare Inventory Modified Dates flags impact new and existing items. 

Inventory Management Settings New Items Existing Items 

Manage Inventory Descriptions = Yes 

Compare Inventory Modified Dates = Yes 
or No 

New items and their 
descriptions are always 
added. 

If Manage Inventory Descriptions 
is selected, descriptions for 
existing items will be rejected, 
regardless of the item’s Last 
Modified Date. 

Manage Inventory Descriptions = No 

Compare Inventory Modified Dates = No 

New items and their 
descriptions are always 
added. 

Descriptions for existing items are 
always updated. 

Manage Inventory Descriptions = No 

Compare Inventory Modified Dates = Yes 

New items and their 
descriptions are always 
added. 

Descriptions for existing items are 
updated if the Last Modified Date 
in the XML is not older than the 
Last Modified Date in the 
database. 

 

Updating Price, Qty, Cost 

Price, quantity, and cost will be updated when importing inventory items if the corresponding 
management flag is NOT set. 

Price and cost will also be updated when the corresponding management flags are set if you are 
importing items and all quantities are zero in both Inventory.xml and the database. If quantities in 
the XML and database are not zero, ECM will reject them and will wait for price/cost 
adjustments to arrive. 

Custom Import Tools 

Any custom import tool which communicates directly with the XML processor in the database (as 
opposed to preparing XML files for EcmProc) will have the field unchecked as well, unless its 
code is modified.  
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Creating a Profile 
To create a station profile, use one of the methods below. (You can also create a profile by 
copying an existing profile.) 

To create a profile using the Station Wizard: 

1. Click Stations on the top menu of the ECM Home Screen.  The list 
of stations displays. 

2. Click Station Wizard. The Station Wizard launches.  

 

 

 

 

 

 

 

 

 

 

 

3. On the opening screen of the wizard, select Create a new profile. Enter a name for the profile, 
then click Next (<Alt+N>). The Profile Details screen displays. 
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4. Select data exchange options using one of the following methods: 

Method 1: Select one of the header options to assign the option to all the listed data types. For 
example, if you select All in the header, then All is selected for each individual data type in the 
group. You can then select a different option, if necessary, for individual data types in the 
group. 

Method 2: Select a data exchange option for individual data types.  

5. Click Next (<Alt+N>) to move through the screens and choose data exchange options as 
necessary. 

6. On the Profile Tools screen, select the Enable field to apply any necessary profile tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Click Finish (<Alt+F>) when you reach the end of the wizard. 

To manually create a new station profile: 

1. Click Stations on the top menu of the ECM Home Screen. The list of 
stations displays. 

2. Click Profiles. The Profiles screen displays.  
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Profiles Screen 

 

 

 

 

 

 

 

 

 

 

 
3. Click New. The New Profile dialog displays. 

4. Type a name for the profile, and then click 
OK. Your new profile is added to the existing 
profile tree. 

5. Select data exchange options using one of the 
following methods: 

6. Select the + to display the list of profile 
areas, then select Profile Tools. 

7. Select the Enable field to apply individual profile tools. 

Note: Restrictions on Profile Names 
When creating a new station profile, you may not use (/, ?, \ or *) characters in the profile name. 

Changing Profiles 
If you assign a profile to a station and then change that profile, the changes will not be updated 
for that station. To have the changes take effect, you must reassign the profile. 

Editing a Profile 

To edit a profile: 

1. Click Stations on the top menu of the ECM Home Screen. The list of 
stations displays. 

2. Click Profiles and then select a profile on the left. 

3. Navigate through the list of data types, select and clearing options as necessary. 

4. Click Save. 
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Copying a Profile 
An easy way to create a new profile is to copy an existing profile that offers the closest match. 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations 
displays. 

2. Click Profiles. The list of profiles displays. 

3. Select a profile from the list, and then click Copy.   

Result: The system creates a new profile named Copy of [profile name]. 

4. Enter a new name for the profile. 

5. Navigate through the Profile Checklist and Profile Tools, selecting/un-selecting options as 
necessary. 

6. Click Save. 

Deleting a Profile 
1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Click Profiles.  

3. Select the profile that you want to delete. 

4. Click Delete.  A confirmation dialog displays. Click Yes to confirm the deletion. 

Note: If you delete a profile that is currently assigned to stations, be sure to assign a 
new profile to those stations. 

Communicating Profiles 
If you change any of your defined profiles, you can communicate the updated profile file to other 
stations. When preparing files for communication, ECM copies the profiles file (profile.xml ) from 
its existing location to the \Polling \[Station]\Out directory. The file is then transferred during the 
next Exchange. 

When a profile.xml file is sent to another station, it overwrites the existing profiles that were 
previously defined at the target station. 

To communicate profiles: 

1. Click Stations on the top menu of the ECM Home Screen. The 
list of stations displays. 

2. Select the station to which you want to communicate the new 
profile(s), and then click Communicate Profiles.  A confirmation dialog informs you that 
profiles were successfully prepared for communication.  

3. Click OK. 
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Filtering Documents and Merchandise by Store 
Filtering Documents by Store  
In addition to selecting which documents to send to a selected station, you can choose to send 
only documents for specific stores during communication. For example, if a Retail Pro 8 Main 
station communicates with a Remote station, you might only want to process out and send 
receipts for that station's store.  

Likewise, if Retail Pro 9 communicates with an RP8 Main station, then you should process and 
send documents for all stores.  

To filter documents by store: 

1. Click Stations on the ECM Home Screen. The list of stations displays. 

2. Select the station you want, and then click Form View (<Alt+V>). 

3. In the Profile Checklist for the station, select Documents from the list.  

 

 

 

 

 

 

 

 

 

4. Click in the Stores field next to the item and click  to 
open the Store Selection dialog box. 

5. Select individual store(s) as necessary, or choose Select 
All to select all stores. Click OK to save your selections 
and close the dialog.  

6. Click Save on the top menu. 

If no stores are checked for a document type, then ECM 
sends only documents for the current store.  

If a store other than the current store is selected, the store 
number or the word Selection is displayed in the Store 
column. (The store to which the station is currently assigned 
is always selected.)  
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Determining a Document's Store 

The following fields are used to determine the document store when sending documents. 

Document Field Comments 

Receipts Invoice.Store_no  

Adjustment Memos Adjustment.Store_no  

Vouchers Voucher.Store_no  

Transfer Slips Slip.Out_Store_no 

Slip.In_Store_no 

Includes Slips relayed from one station to 
another. 

Purchase Orders PO.Store_no 

PO_Qty.Store_no 

A Marked For PO directly references the PO 
record for item quantity information. 

A Ship To PO will reference the PO Qty file for 
the item quantity related to any store for which 
quantity is to be issued. 

Transfer Orders TOrd_Qty.Store_no 

TOrd.store_no 

 

Sales Orders SO.Trgt_Store_no 

SO.Store_no 

 

 

Filtering Inventory by Store 
When selecting Merchandise communication settings, you can select which stores will be 
included in communication. This is useful for reducing overall communication times when there 
is not a need to communicate data for each store. 

1. Click Stations on the ECM Home Screen. The list of stations displays. 

2. Select the station you want, and then click Form View (<Alt+V>). 

3. In the Profile Checklist for the station, select Merchandise from the list.  

4. In the Inventory row, click in the Stores field next to the item and click  to open the Store 
Selection dialog box. 

5. Select individual store(s) as necessary, or choose Select All to select all stores. Click OK to 
save your selections and close the dialog. 

6. Click Save on the top menu. 
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Assigning Profiles to Stations 
By assigning a profile to a station, you can define all of the Profile Checklist and Profile Tool 
settings for the station with a single action. 

You typically assign (or define) a profile when creating a station. However, you can assign a new 
profile at any time.  

To assign a profile to a station: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Select the Station to which you want to assign or change a profile. 

3. Click Load Profile. The Load Profile dialog displays. 

 

 

 

 

 

 

4. Select a profile from the drop-down list, then click OK. The profile you select replaces any 
profile previously assigned to the station. 

Setting Inventory Management Options 
ECM provides great flexibility in managing the updating of specific types of inventory 
information. Before configuring ECM, think carefully about which station you want to control the 
following inventory values: Quantity/Cost, Price, Descriptions. 

After you have decided which station will control which type of inventory information, make sure 
that the appropriate checkboxes are selected in the Profile Tools area of the appropriate station. 
You should never have all stations set to Manage or all stations set to NOT manage inventory. At 
least one location within any chain of communication should be configured as the controlling 
station. 

Quantity and Cost 
Quantity and Cost are managed together in Retail Pro 9 and are usually managed by headquarters. 
This is because retailers typically “average” the cost of their inventory items. Quantities received 
at one cost are averaged with quantities received at another cost to arrive at the current “Cost” for 
the item. If a station were to manage its own quantities but not cost, there would be no way to 
know the cost at which quantities were received and this would cause accounting discrepancies. 
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Here are two examples of when a retailer might want to allow remote stations to manage quantity 
and cost: 

 A retailer is importing inventory information from a 3rd party system (via xml files) at the 
store, and not at corporate headquarters. 

 The store is a franchise in which the franchise operator has full control. 

In most other situations, you will want the headquarters station to manage quantity and cost. The 
quantities and costs at headquarters are updated by transaction documents sent from remotes. The 
resulting Inventory.xml file is then sent back to remotes, overwriting the quantities and costs at 
the remote. 

Price 
Price is typically managed by headquarters, but you can select the Manage Price option for 
remotes to allow them to set their own prices that reflect the local conditions.  

If a remote manages prices, any changes in price received in the Inventory.xml file are ignored.  

Descriptions 
You can select which station manages inventory descriptions. For example, for stores located in 
foreign countries, descriptions can be controlled locally. The descriptions are entered in the local 
language, making it easier for associates and managers to work with inventory, but prices, costs 
and quantities are still controlled centrally. 

Setting Inventory Management Options 
The Inventory Management options are available in the Profile Tools area for each station. 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to control inventory quantity, costs, prices, and descriptions for a station, you need to 
select the appropriate options in the station’s profile. 
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Option  Description 

Manage Inventory Qty 
and Cost for this station 

Select this option to have your station manage inventory quantities and costs for 
the selected station. 

Only transactional documents received from the station will affect the station's 
inventory quantities and costs, not the station's inventory file. If someone 
manually changes an item's quantity at the station (no document created), when 
your station receives the inventory file, that change would be ignored. 

When sending data to the selected station, the inventory quantities and costs that 
you send will overwrite the inventory quantities and costs at the station. 

Manage Inventory Price 
for this station 

Select this option to have your station manage inventory prices for the selected 
station. 

Transactional documents received from the station affect the station's inventory 
prices, but not the station's inventory file. If someone manually changes an item's 
price(s) at the station (no document created), that change is ignored when your 
station receives the inventory file.  

When sending data to the selected station, the inventory prices that you send 
overwrite the inventory prices at the station. 

Manage Inventory 
Descriptions 

Your station manages inventory descriptions for the selected station. ECM sends 
ALL inventory item descriptive elements. 

Note: Depending on the size of your inventory, selecting the Manage Inventory 
Descriptions option can result in a large file transfer during ECM communication.  

When sending data, the inventory descriptions that you send will overwrite the 
descriptions at the station. 

 

About Manage Flags 
If a station has the Manage Inventory Price and Cost for this station and Manage Inventory Quantity 
for this station options selected, the settings affect the station’s process-in process and indicate 
what a local station will do with data received from another station.  

If the Manage Inventory Price and Cost for this station and Manage Inventory Quantity for this 
station options are NOT selected, it means the data received from this station will be accepted as 
is, provided that the Modified_Date field in the Inventory.xml file is not older than corresponding 
field on the existing item in the database (A time comparison is done considering time zone 
information). 

If flag IS set, it means that the data will be REJECTED from this station and instead will be 
propagated from documents.  

Price, Quantity and Cost 
Price, quantity and cost will be updated based on documents received by ECM.  

There are two exceptions: 

1. If a brand new ACTIVE item is received, ECM will accept its price and cost if on-hand 
quantities are all zero in the Inventory.xml file.  
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2. If an EXISTING item is received, ECM will accept its price and cost if on-hand quantities are 
all zero in BOTH the database and the Inventory.xml file. Otherwise, they will be left intact 
(set to zero/null for new items). 
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Descriptions 
Descriptions are only be updated when a new ACTIVE item is received, otherwise they'll be 
rejected. Keep in mind that things like serial/lot numbers and required quantities for price levels 
are considered item descriptions and are managed as such.  

A descriptive field in this context is defined as a field which cannot be confirmed for an existing 
item by any received document except for the field entry in inventory. Price, cost, and on-
hand/in-transit quantities are NOT descriptive fields, according to this definition, so they are 
separated into their own groups. 

On the other hand, foreign currency cost (not base currency cost) is a descriptive field. This is 
because base currency cost is affected by vouchers and cost adjustments. 

The Tax Code field is also a descriptive field, since there is no document which can confirm its 
change. The required quantity for discount price levels is also a descriptive field. 

Base Item Information 
Base item information which is used to create missing items is NOT a confirmation of item data. 
It's rather a minimal set of data allowing us to create the item AT ALL in order to process the 
document. 
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Managing Inventory with Retail Pro 9 Series 
This section explains how to configure station records to manage inventory with Retail Pro 9 
Series, while communicating with an 8 Series Main station. Using this configuration, the Retail 
Pro 9 station controls inventory quantity, price, and cost.  

Transactional documents sent to the 9 Series station will update the 9 Series database; however, 
changes to the Inventory.xml file (which communicates inventory information) are ignored. 

During communication, any changes made to the Inventory.xml file at the 9 Series station will 
overwrite the inventory file at the 8 Series Main. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Retail Pro 9 Series 
manages inventory and 
pushes changes down 
to an 8 Series Main. 

Store 001 Store 002 Store 003 

Stores send transactional 
documents to the 8 Series Main. 

The transactional documents 
update inventory quantity, cost, 

and price. The Main, in turn, 
sends those documents to 9 
Series. Any other inventory 

changes sent by the 8 Series 
Main are ignored. 
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When Retail Pro 9-Series manages inventory: 

 You have central control over inventory quantities, costs, and prices and can prevent 
individual stations from making unwanted changes. 

 During communication. Retail Pro 9-Series overwrites any changes you make to 
inventory quantities and costs (or price) in 8-Series, other than changes recorded on 
transactional documents. 

 

At the Retail Pro 9 Series ECM 

Station Record for Main (RPRO 8x) Station 

In the Retail Pro 9 installation of ECM, create a station record for each 8 Series Main station that 
you will communicate with. Assign Main (RPRO 8x) as the Station Type, and select the Manage 
Inventory flags in the Profile Tool area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  Retail Pro® Enterprise Communication Manager (ECM™) 
 

© 2011 Retail Pro International, LLC All rights reserved. 
59 

Profile for Main (RPRO 8x) Station 

When assigning a profile to the station record for the Main (RPRO 8x) station, select Target – Main 
(Managed) as the profile. This profile is predefined to control inventory for this station. 
Transactional documents received from a station that is assigned this profile will be used to 
calculate inventory quantity, cost and price at the Retail Pro 9 station. 
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At the 8 Series Main ECM  

Station Record for Retail Pro 9 (Oracle) Station 

In the 8 Series Main station’s ECM, create a station record for the Retail Pro 9 station. Assign 
Retail Pro 9 (Oracle) as the Station Type, and DO NOT select the Manage Inventory flags. 
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Profile for Retail Pro 9 (Oracle) Station 

The Main will not be managing inventory when communicating with the Retail Pro 9 (Oracle) 
station; therefore, when assigning a profile to this station, select Target Type – Enterprise as the 
profile. This profile is predefined to allow the inventory data file passed to it via the Retail Pro  9 
station to update its on hand quantity, cost and price information.  
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Managing Inventory with Retail Pro 8 Series 
You can allow a Retail Pro 8 Series Main (BTF) station to manage its own inventory. If a Retail 
Pro 8 Main manages inventory, any changes to inventory quantities, costs and prices (and 
optionally descriptions) made at the Retail Pro 9 station are overwritten by the subsidiary Main 
station during communication. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Retail Pro 9 Series is used 
as a data repository for 

reporting purposes. During 
communication, any changes 

made to inventory 
information are ignored by 

the 8 Series Main. 

The Retail Pro 8 Series 
Main manages inventory, 
sending any changes to 
quantity, cost, price, and 
descriptions to stores. 

Store 001 Store 002 Store 003 

Stores send transactional 
documents updating quantity, 
price and cost to the 8 Series 

Main. The Main then sends these 
documents (along with other 

changes to inventory information) 
to the 9 Series station. 
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At the Retail Pro 9 Series ECM 

Station Record for Main (RPRO 8x) Station 

At the Retail Pro 9 Series ECM, define a station record for each 8 Series Main station with which 
your station will communicate. Select Main (RPRO 8x) as the Station Type. Do NOT select the 
Manage Inventory flags.  
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Profile for the Main (RPRO 8x) station: 

In this configuration, Retail Pro 9-Series is serving as a repository of data received from the Main 
station and thus not managing the inventory. 

At the 9 Series ECM, when assigning a profile to the station record 
of the 8 Series Main, select Target – Main. This profile is predefined 
to allow inventory information received from this station to update 
inventory for the Retail Pro 9 Series station.  

 

At the 8 Series Main ECM 

Station Record for the Retail Pro 9 (Oracle) station 

At the 8-Series Main Station, define a station record for the Retail Pro 9-Series station, which will 
be the target station for communication. Select Retail Pro 9 (Oracle) as the station type. 

Select the Manage Inventory Qty and Cost for this station flag in the Profile Tool area. Any 
changes to inventory quantities and costs made at Retail Pro 9 Series will be overwritten by the 8 
Series Main station during communication. 

You can also select the Manage Inventory Price for this station and Manage Inventory Descriptions 
for this station options. If selected, any price or description changes made at Retail Pro 9 Series 
will be overwritten by the 8 Series Main during communication. 

Profile for the Retail Pro 9 (Oracle) station 

The 8 Series Main will be managing inventory with respect to 
this Retail Pro 9 Series station; therefore, select Target – 
Enterprise (Managed) as the profile. This profile is predefined 
to allow only transactional documents passed to it via this 
Retail Pro 9 station to update its on hand quantity, cost and 
price information.  
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In addition, at the Retail Pro 8 Series Main, set the Retail Pro 
System Preference setting to Require a Memo to Change: 
Quantity, Price, and Cost (System Preferences > Adjustments). 
Make sure Quantity, Price, and Cost are all selected. 

 

 

 

Auditing and reporting are far more accurate when a history 
trail can be associated with inventory information; therefore, 
select the Source for Item SID generation option to UPC 
(System Preferences > Merchandise). Having a unique UPC 
ensures that all transactions involving the item are tracked 
correctly. 

 

Managing Inventory with a Retail Pro Remote 
It is not recommended that remote stations manage their own inventory; however, a remote 
station is allowed to act as a stand alone subsidiary that can communicate directly with a Retail 
Pro® 9-Series (Oracle) station. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When a Remote 8 Series station 
manages inventory, the Remote 
sends inventory changes to 9 Series 
both by changing the inventory.xml 
file, as well as by transactional 
documents that are sent to 9 Series.
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Station Record for Remote (RPRO 8x) Station 

At the Retail Pro 9 ECM, create a station record for the 8 Series Remote station. Select Remote 
(RPRO 8x) as the Station Type. Do NOT select the Manage Inventory flags.  

 

 

 

 

Profile for the Remote (RPRO 8x) station: 

The Retail Pro 9 Series station will act as a repository of data received from the 8 Series Remote 
station and thus will not manage the inventory. 

At the 9 Series ECM, select Target Type – Main as the profile. 
This profile is predefined to allow inventory information 
received from this 8 Series station to update inventory for the 
Retail Pro 9 Series installation. 

 

 

At the 8 Series Remote ECM 

Station Record for the Retail Pro 9 (Oracle) station 

At the 8-Series Remote Station, define a station record for the Retail Pro 9-Series station, which 
will be the target station for communication. Select Retail Pro 9 (Oracle) as the station type. 

Select the Manage Inventory Qty and Cost for this station flag in the profile tool area. Any changes 
to inventory quantities and costs made at Retail Pro 9 Series will be overwritten by the Remote 
station during communication. 

You can also select the Manage Inventory Price for this station and Manage Inventory Descriptions 
for this station options. If selected, any price or description changes made at Retail Pro 9 Series 
will be overwritten by the Remote during communication. 
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Profile for the Retail Pro 9 (Oracle) station 

The 8 Series Remote will be managing inventory with respect to this Retail Pro 9 Series target; 
therefore, select Target – Enterprise (Managed) as the profile. 

This profile is predefined to allow only transactional data file passed to it via this Retail Pro 9 
station to update its on hand quantity, cost and price information. 

 

 

 

 

 

 

In addition, at the Retail Pro 8 Series station, set the Retail Pro 
System Preference setting to Require a Memo to Change: Quantity, 
Price, and Cost (System Preferences > Adjustments). Make sure 
Quantity, Price, and Cost are all selected. 

 

 

Auditing and reporting are far more accurate when a history trail can be associated with inventory 
information; therefore, select the Source for Item SID generation option to UPC (System 
Preferences > Merchandise). Having a unique UPC ensures that all transactions involving the item 
are tracked correctly. 
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Launching/Scheduling Communications 
Launching Communications Manually 
Typically, you will schedule communications to take place automatically, but you can also 
launch communications manually. 

To exchange data manually (for all active stations): 

1. Click Stations on the top menu of the ECM Home Screen. 

Result: The list of stations displays. 

2. Select the station that you want to communicate with, and then click one of the following 
options: 

 

Transfer data. 

 

Perform an exchange. 

 

Process in data. 

 

Process out data. 

 

Process in data, and then process out. 

 

Perform a Quick Poll with the station. 

Reference: See Quick Poll section 

 

3. Follow any additional displayed instructions for your selection. 

Communication Launched at Stores 
Retail Pro 9s cannot start a data exchange with an 8-Series station. Individual stations initiate data 
exchange by sending requests and data to Retail Pro 9 for processing. Retail Pro 9 makes the data 
available and the store retrieves it. 

Canceling a Communication Session 
You may cancel data exchange at anytime. When you cancel a data exchange session, ECM 
continues processing until it is finished with the current request, then generates a response. All 
files are held until the next data exchange session. When the next data exchange session begins, 
the store retrieves the response files and sends any unsent requests to the Retail Pro server. 
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Scheduling Communications 
You can automate the communication process using Scheduler (or Windows Scheduler, etc.). 

When scheduling communications, you need to add a task for each operation that you want 
performed, and chain the tasks together. For example, to schedule a full end-of-day 
communications cycle: 

1. Schedule ECMProc.exe at the 8-Series station. ECMProc.exe will process out data and move it 
to the \Out folder (in the 9-Series station directory). 

2. Schedule Exchange.exe at the 8-Series station with the restriction that it does not take place 
unless process out is completed. Exchange will move the station's data from the \Out folder to 
the \In\Recvd folder at the 9-Series station. 

3. Schedule ECMProc.exe at the 9-Series station. ECMProc.exe processes in the data it finds in 
the \In\Recvd folder. 

4. Schedule ECMProc.exe again at the 9-Series station. ECMProc.exe will process out data. 

5. Schedule Exchange.exe at the 9-Series station. Data is transferred to the 8-Series station 
(placed in the \In\Recvd folder). 

6. Schedule ECMProc.exe at the 8-Series station. The data in the \In\Recvd folder is processed, 

When Exchange.exe is launched using Scheduler, it will ignore the ECM workstation 
preference to process in immediately after Exchange. 

Command Line Parameters 
ECM.exe 

Use the following command-line parameters when scheduling ecm.exe. 

Parameter Allowed Values Description and Rules Expected Format 

-user 

 

Defined Windows 
user name. 

Logon name 

Note: -user and -
password parameters in 
ECM.exe are used for 
launching it with 
procin/procout/exchange 
parameters (when no UI 
interaction is expected, 
e.g. from Scheduler). 

-user:sysadmin 

 

 

 

-password The defined 
password for the 
specified Windows 
user name. 

Logon password -password:sysadmin 

 

 

 

-procout  Process out for all 
defined (active) stations. 
Profiles assigned to given 
station will be used 
automatically during the 
process. 

-procout 
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Parameter Allowed Values Description and Rules Expected Format 

-procin  Process in for all defined 
(active) stations.  

-procin 

-exchange  Exchange data with all 
active stations using the 
assigned communication 
method. 

-exchange 

-clear_log  This parameter will 
clear ecm.log file, but 
only when ECM is 
launched with either -
procin, -procout, or -
exchange parameters 

-clear_log 

/nosplash  Prevents the display of 
the ECM splash 
screen. 

Note: This parameter 
MUST be preceeded 
with "/", not "-". 

/nosplash 
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ECMProc.exe 

Parameter Allowed Values Description and Rules Expected Format 

-user Defined Retail Pro 
user name. 

Retail Pro logon name. -user:sysadmin 

-password The defined 
password for the 
specified Retail 
Pro user name. 

Password for the defined 
logon name. 

-password:sysadmin 

-out  Process out for all defined 
(active) stations. Profiles 
assigned to given station 
will be used automatically 
during the process. 

-out:mm/yyyy proc out 
with optional starting 
date 

-in  Process in for all defined 
(active) stations. 

-in 

-a  auto mode (closes 
upon completion) 

-a 

-show  Show main form -show 

-sub -sub:<3-digit 
subsidiary 
number> 

Subsidiary number -sub:XXX 

-stid -stid:<station_id> Station ID 

Enables EcmProc to 
process a single station 
instead of all active 
station (entire subsidiary).  

The format for 
<station_id> is XXXYYYZ, 
where XXX is subsidiary 
number, YYY – store 
number, Z – station code 
(leading zeros are 
meaningful, and station 
code is capitalized). The 
same station id can be 
seen as a folder name in 
the ECM polling folder. 

This parameter is used for 
EcmExchange, but you 
can also use it when 
running EcmProc from the 
command line. 

-stid:001001A 

-prf -prf:profilename Overrides profile for all 
stations being 
processed in this run 

-prf:<profilename> 



 Retail Pro® Enterprise Communication Manager (ECM™)  
 

© 2011 Retail Pro International, LLC All rights reserved. 
72 

Parameter Allowed Values Description and Rules Expected Format 

-prfopt -prfopt:<1-digit 
number> 

0 = keep nothing 
- override all 
parts (default) 

1 = keep store 
filter from station 
settings 

2 = keep 
processing rules 
(proc-in rules, 
profile tools) 
from station 
settings 

4 = keep area 
options 
(all/none/diff/ima
ges) from station 
settings 

Example: 

a) override area 
options and 
rules, but not 
store filter: 

-prfopt:1 

b) override area 
options only, 
keep store filter 
and processing 
rules 

-prfopt:3 

The part of the original 
station profile to keep 
(add numbers together) 

Example: 

-prfopt:0 

-ora_skip_style_relink  Do not rebuild style 
SIDs 

-ora_skip_style_relink 

-
ora_force_style_relink 

 Rebuild style SIDs for 
all active stations 

-ora_force_style_relink 

-
ora_update_created_
date_on_hist 

 Allow 
receipt/voucher/slip/me
mo to update its 
created_date when 
processed in to Oracle 
for existing documents 

-
ora_update_created_dat
e_on_hist 
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Hidden Switches 

There are two hidden switches which can be accessed by creating the EcmProc.ini file manually 
(file must reside in the same folder where EcmProc.exe is). The EcmProc.ini file should look like 
this: 

[ECM_BTF] 

SkipSerial=0 

SkipLot=0 

If set to "1" EcmProc will ignore serial/lot numbers while processing inventory file into 8-series 

ECMExchange.exe 

Parameter Allowed Values Description and Rules Expected Format 

/ws /ws:<ws_no> Tells what 8-series 
workstation number to 
use while reading 
preferences (WS100 by 
default). 

/ws:01 

/install  Installs ECM Exchange. /install 

/uninstall  Uninstalls ECM 
Exchange. 

/uninstall 

/silent  Suppresses a popup 
dialog during 
installation/uninstallation. 

/silent 

 

Note: The /ws:<ws_no> parameter must be passed to EcmExchange during installation. - This 
way, it will automatically be recorded as a parameter for the system service it is installing. 

 

Examples of Command Line Parameters 

Examples 
(Launching process out) 
ECM.exe -user:sysadmin -password:sysadmin -procout 

(Launching exchange) 
ECM.exe -user:sysadmin -password:sysadmin -exchange 

(Launching process in) 
ECM.exe -user:sysadmin -password:sysadmin -procin 
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Installing Scheduler as a Service 
The tasks that you define in Scheduler Editor won't be run unless you install Rpro9Schedule.exe 
from the command line, and then start the service. 

To install Scheduler as a service: 

1. From the desktop, select Start > Run. 

2. In the command line prompt, type the path to your Rpro9Schedule.exe, add a space, and then 
type install:  

Example: C:\RetailPro9\Rpro9Schedule.exe /install 

 

To start the Scheduler Service: 

1. Select Start > Control Panel. 

2. Open Administrative Tools. 

3. Open Services. 

4. Select Task Scheduler from the list of services. 

5. Make sure the Status field says Started. If the Status field reads Stop, right-click and select 
Start. 
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Communication Programs and Files 
The following ECM programs carry out communications between Retail Pro® 9-Series and 
stations. 

ECM 
The ECM.exe application controls communication configuration, allowing users to manually 
launch communication cycles and troubleshoot the process. 

ECM: 

 Requires a unique identifier, or Global Store Code, for each station. 

 Uses command line parameters when scheduling communications. 

 Displays a progress dialog when running manually. 

 Can be scheduled via Scheduler. 

 Interacts with Scheduler to provide continuous communications. 

 Writes to a processing log. 

ECM Exchange 
Exchange (ECMExchange.exe) transfers data between two stations. To exchange data, 
ECMExchange.exe must be running at both stations. Once installed, ECMExchange.exe is launched 
automatically when you start your system. 

At Retail Pro® BTF stations, the service is configured, by default, to use WS100 as its 
workstation. You can change the workstation after installation, if necessary. 

ECMExchange.exe: 

 Updates the Windows Event Log when a connection request is initiated. 

 Updates the Windows Event Log when a connection request is terminated. 

 Listens on a specified port (default = 20000). 

 Can be used by third-party developers for sending .xml files. 

 Supports server initiated connections with stations. 

 Writes to a log file in the ECM\Polling\Log folder. 

 Performs encryption of XML files prior to transmission, with decryption occurring on the 
receiving end prior to writing the data to the hard disk. 

ECM Proc 
ECMProc.exe processes data that is being sent or received. Data is processed according to the 
profiles and processing rules that you define. ECMProc.exe writes the results of each process 
in/process out operation to the Processing Log. 
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ECMProc.exe: 

 Supports XML interface via XML schemas and XML data. 

 Optionally compresses data using a compression stream, so no intermediate files (i.e., 
mailbags) are created. 

 Executes your defined rules for processing in and out of data. 

 Processes data in. 

 Processes data out. 

 Provides a progress report for each process in and process out operation. 

 Writes to a log file in the \ECM\Polling\Log folder. 

Quick Poll 
Quick Poll lets you perform a full or partial communication cycle with a single touch. When 
doing a Quick Poll, the operations that you specified in ECM workstation preferences are 
included, and are performed in the order you defined. 

Typically, when performing a Quick Poll, a full polling cycle is not performed.  Instead, only the 
minimum necessary operations are performed. For example, a process out and exchange can be 
performed to update a station's inventory quantities. 

Reasons for a Quick Poll include: 

 Updating on-hand quantities at stations. 

 Updating the station’s information for reporting purposes. 

To perform a Quick Poll: 

1. Select Stations from the ECM Home Screen. The list of stations 
displays. 

2. Select a station from the list and then click Quick Poll.     

Note: When performing a Quick Poll, the ECM Workstation Preference options to Process in 
Immediately after Exchange and Process Out Immediately after Process In are ignored. 
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Sending/Receiving Data 
If you want to immediately transfer data between stations, you can use the send/receive feature. 
The data in each station's \Out folder (data that has been processed out, but not sent) is transferred 
to the other station's \In\Recvd folder, where it will wait to be processed in. 

To send/receive data: 

1. Select Stations from the ECM Home Screen. 

Result: The list of stations displays. 

2. Select the station with which you want to send/receive data. 

3. Click Send/Receive.       

 

Starting Exchange 
For two stations to communicate, ECM Exchange program must be running at each station. When 
ECM is installed, ECM Exchange is installed as a service, meaning it is launched each time your 
workstation is started. If necessary, you can manually start ECM Exchange from within ECM. 

To start ECM Exchange: 

1. Launch ECM. 

2. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

3. Select a station from the list and then click Start Exchange.      

Result: ECMExchange.exe starts. 

Restrictions for ECM Exchange for Windows 
Vista/2008/Win7 Users 

 If you are using Windows Vista/2008/Win7 you must turn OFF User Account Control. 

 If you are logged in as a user without administrator privileges AND if EcmExchange is 
installed as a system service you have to guarantee that EcmExchange system service is 
started before Ecm.exe will try to communicate with it. 

 If you have EcmExchange installed as a system service and you want to change the 
socket port number in ECM workstation preferences (not in station settings) you have to 
be logged in to Windows as a system administrator (because it requires re-configuring 
system service and it cannot be done without Windows administrator privilege). 

 Vista/2008/Win7 will not automatically display EcmExchange/EcmProc windows if 
EcmExchange is running as a system service; neither will you see icons in the taskbar 
notification area. 
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Communications Cycle 
A communications cycle is the series of events that occur when ECM exchanges data between 
two stations.  

A full communications cycle is typically performed in the following order. 

Step Description 

1. Process out at the Main 
(or Remote) 

The station prepares data files to be communicated to Retail Pro 9. The data 
typically includes receipts for the day’s sales, vouchers for merchandise 
received, slips for merchandise transfers, plus any sales orders and 
customers added or changed that day. 

2. Exchange The station sends Retail Pro 9 its prepared data files and picks up any files 
waiting for it. A starting time and duration of an Exchange is normally 
scheduled at Retail Pro 9. This interval allows sufficient time for all stations to 
connect and exchange. If a station is unable to connect during that period, 
data files that were prepared will simply accumulate and be exchanged the 
next time the station connects. 

3. Process in at Retail 
Pro® 9 Series 

Retail Pro processes in the data it has just received. This updates inventory, 
history, customers, and other data. 

4. Process out at Retail 
Pro® 9 Series 

After processing in all data, Retail Pro 9 prepares data to be sent to each 
Remote, including the new data just processed in. 

5. Exchange With ECM, it is possible for either the sending or receiving station to initiate a 
request for exchange of data. 

6. Process in at the Main 
(or Remote) 

After the second exchange, each station processes in the data it just received 
from Retail Pro 9. This updates the inventory to reflect that day’s activities. 
Other data files are also updated with any data received. 

A partial communications cycle can include any of the above steps, in any order. For example, to 
pull sales data from a station into Retail Pro, you can perform the following steps: 

Step Description 

1. Exchange Any data that is processed out at Retail Pro 9 (but perhaps not sent) is 
transferred to the station. 

2. Process in at the 8 
Series Main (or Remote) 

The Main (or Remote) processes in any data that was sent from the Retail Pro 
9 station. 

3. Process out at the 8 
Series Main (or Remote) 

The station processes out its data, including the most recent sales data. 

4. Exchange The data is transferred to the \In\Recvd\ folder at Retail Pro 9. 

5. Process in at the Retail 
Pro 9 Series station 

Retail Pro 9 processes in the data, updating company data as well as data for 
the Remote. 
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Processing Steps 
The following sections detail the specific processing steps taken during communications. 

Processing Out 
1. ECM Procs reads the profile of the station with which you are communicating. 

2. ECM Procs creates XML files in the station's \Out directory. (You can also place other XML 
files in \Out.). 

3. ECM Procs compresses all files (if the compression option is selected in the station's record). 

 

Management of Files During Process Out 

When processing out, ECM Procs creates separate data files for each station. This helps limit the 
size of each data file as well as controls the distribution of sensitive data to the stations. 

Planned Markdowns 

When immediate price or cost changes are made in Retail Pro® 9-Series, the selected store's 
inventory is updated. The updated inventory data is communicated to the appropriated target 
station. No separate markdown file is created at the target station. 

For planned price/cost changes, ECM processes out the planned price/cost changes and 
exchanges the data with the appropriate target station. When the planned markdown data is 
processed in at the 8-Series (BTF) target station, the system creates a Retail Pro markdown file 
(MkDn.dat). 

Retail Pro makes the changes associated with the planned markdown file and updates inventory. 
The system communicates the resulting inventory change to the Retail Pro 9 installation. 

Planned markdowns created in Retail Pro 8 are not communicated to a Retail Pro 9 (Oracle). 

Store Credit and Customer Balances 

When using store charge accounts, customers may have charge balances. Retail Pro 9 can build 
an accurate sequence of events related to customer charge balances.  The accuracy of those 
balances is determined by how often stations communicate with Retail Pro. The more often 
stations communicate with Retail Pro 9, the greater the likelihood that customer charge balances 
and store credit are up to date. 
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Inter-Company Transfers 

When an out slip is processed in at Retail Pro, ECM determines if the slip is part of an inter-
company transfer. If it is, ECM automatically generates an ASN (advance shipping notice) for the 
target station. The ASN contains a special number that is a concatenation of subsidiary number, 
store, and slip number. This number is written to the ASN Package # field on the newly created 
ASN. 

Example: 00200000056  

 Subsidiary number = 3 digits. If the subsidiary number is less than three digits, leading 0s 
are added. 

 Store = 3 chars. Station identifier (a,b,c…) is not used within this number identification. 

 Slip number = 5 chars. If the document number is less then 5 digits, the numbering 
sequence contains leading zeroes. 

If the out slip already references a document, then no ASN voucher is created. 

Flagging Records as Transmitted 

Records are marked transmitted when a confirmation file is processed in. The confirmation file 
lists the records that were successfully processed in by the target station.   

 

Exchange 
1. ECM Exchange moves files from the local \Out directory to the other computer’s \In 

directory. 

2. At the source station, ECM Exchange copies sent files to \Out\Sent and deletes the original 
files from \Out. 

3. At the target station, ECM Exchange copies received files to \In\Recvd and deletes the 
original files from \In. 
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Processing In 
1. ECM Procs checks for files in \In\Recvd.  

2. ECM Procs decompresses files (if compression was used). 

3. ECM Procs moves the files to \Temp and processes them on a file-by-file basis. 

4. ECM Procs then creates confirmation file for return to the source station. 

Management of Files during Process In 

When processing in data, Exchange may attempt to transfer to the station's \In\Recvd folder a file 
that already exists there. This would happen if a second process out and exchange occurred before 
the target station had a chance to process in. In this situation, ECM Exchange will attempt to 
overwrite the file that is currently being processed in. To prevent the source installation from 
receiving an error during the exchange, the following occurs: 

When processing in, any files residing within the In\Rcvd directory are moved to a temporary 
folder (\Temp\) in the processing station's directory.  

ECM Procs moves only the file which it is working on at that instant to the \Temp\ folder. 
Processing of these moved files begins within the \Temp\ folder.  

This allows Exchange to occur and writes new or updated XML information to the In/Recvd 
directory during processing. 

Once ECM Procs has successfully processed the XML file, the file is deleted from the \Temp\ 

Oracle Database Objects 

Retail Pro® 9-Series uses objects to store the files that ECM Procs will be processing at any 
given time. This means that an XML file that is being processed into an Oracle database will be 
loaded in the database as an object, and processing will be done on this object and not directly 
from the file sitting within the \In\Recvd directory. 

Deletion of the file does not occur within the \In\Recvd directory, because ECM Procs has no way 
of ensuring that the file being deleted is not in fact newer then the one it has just finished 
processing, thus potentially deleting new data information. 

Management of Data Files 

Maximum File Size 
The maximum file size that can be processed by ECM is 2GB. When processing out files greater 
than 50MB, ECM will split the file into multiple, smaller files 

If files are being split, the first XML file for any data type that is processed out is known as the 
primary file and will not have a sequential number assigned. Each XML file is assigned a 
sequential number as it is processed out.  
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Example 

Processing out a 200MB Customer file yields the following files: 

Customer.xml  (50MB) - primary customer file 

Customer1.xml (50MB) - enumerated file 

Customer2.xml (50MB) - enumerated file 

Customer3.xml (50MB) - enumerated file 

Note: The splitting of a given data file will occur regardless of whether you are using 
compression or not using compression. 

Overwriting of Existing Files at Target Station 
When ECM Exchange transfers a data file: 

 If only an enumerated file is being sent, then that file overwrites any existing copy at the 
target station. 

 If the primary file exists at the target station, that primary file and any enumerated files 
are first deleted, and then the new data file(s) are placed in the target station's In\Recvd 
folder. 

Why does ECM delete the existing files at the target station? 

Deleting the existing files prevents the following type of situation from occurring: 

A retailer creates a large number of inventory items or documents by mistake. The retailer 
processes out. ECM splits the file into a primary file and enumerated files. The retailer runs 
Exchange, which places the files in the station's In\Recvd folder. The retailer then realizes his/her 
mistake and deletes the documents or items. The retailer processes out again. The file is now 
small enough that it doesn't need to be split. The retailer processes out. If the retailer runs 
Exchange before the target station has processed in, the new primary file would overwrite the 
primary file at the target station, but the enumerated files would not be affected. In other words, 
the target station would be processing in invalid data. 

Maximum File Size 
The maximum size of your .xml data files is 2GB. When files are greater than 50MB, ECM will 
split the files into multiple smaller files.  
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Importing Documents 
You can import any document in xml format into Retail Pro using the Enterprise Communication 
Manager (ECM). This enables you to import documents created at a different store or import 
documents created on outside or legacy systems into Retail Pro.  

When importing documents, be sure to include the required fields for that document type. 

Important! To import the Invoice.xml file, the INVN_BASE_ITEM section is required. 

To import documents into Retail Pro: 

1. Add the transaction information to the appropriate xml file. For example, add sales 
transaction information to the Invoice.xml file. (Make sure the file includes 
INVN_BASE_ITEM) 

2. Place the file in the ECM\Polling\[Station]\In\Recvd directory. 

3. Perform a Process In operation using the Enterprise Communications Manager (ECM). 

Why INVN_BASE_ITEM is Required when Communicating Receipts 
When a receipt (invoice) is transmitted from one station to another, it cannot be guaranteed that 
the receiving station will have the items that are listed on that receipt in the stations’ inventory. 
When ECM is importing a receipt into Retail Pro, if an item that is on the receipt is not in 
inventory, then that item will be created by ECM and marked as inactive. This enables the receipt 
to be created successfully at the importing station. To do that, ECM needs to know basic details 
about the item and this information is contained in the <INVN_BASE_ITEM> section of the 
XML file.  

Flag Field Must Be Set to "0" for Receipts to Update On-Hand Quantity 

If importing items into Retail Pro, be sure to set the Flag field in the Inventory.xml file to “0”. If 
you don’t set the Flag field to “0” in the Inventory.xml file, receipts that are imported into Retail 
Pro will not update the item’s on-hand quantity. 

Required Fields for Retail Pro Document Types 
The required fields for each Retail Pro document type are listed below: 

Adjustment Memos (ADJUSTMENT table) 

ADJ_SID SBS_NO STORE_NO 

CREATED_DATE MODIFIED_DATE CMS_POST_DATE 
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Purchase Orders (PO table) 
 

PO_SID SBS_NO STORE_NO 

CREATED_DATE MODIFIED_DATE CMS_POST_DATE 

 

Receipts (INVOICE table) 

INVN_BASE_ITEM CMS_POST_DATE INVC_SID 

SBS_NO STORE_NO INVC_NO 

INVC_TYPE CREATED_DATE MODIFIED_DATE 

 

Sales Orders (SO table) 

MODIFIED_DATE CMS_POST_DATE SO_SID 

SBS_NO STORE_NO  

 

MODIFIED_DATE 

CMS_POST_DATE 

SO_SID 

SBS_NO 

STORE_NO 

Slips (SLIP table) 

SLIP_SID SBS_NO OUT_STORE_NO 

IN_SBS_NO IN_STORE_NO UNVERIFIED 

CREATED_DATE MODIFIED_DATE CMS_POST_DATE 

 

Transfer Orders (TORD table) 

TO_TYPE CREATED_DATE MODIFIED_DATE 

CMS_POST_DATE TO_SID SBS_NO 

STORE_NO   

 

Vouchers (VOUCHERS table) 

VOU_SID SBS_NO STORE_NO 

VOU_NO VOU_TYPE VOU_CLASS 

CREATED_DATE MODIFIED_DATE CMS_POST_DATE 

 



  Retail Pro® Enterprise Communication Manager (ECM™) 
 

© 2011 Retail Pro International, LLC All rights reserved. 
85 

Importing Items 
You can import items from outside or legacy systems in xml format into Retail Pro 9 using the 
Enterprise Communication Manager (ECM). 

This section explains how to import new items into the Retail Pro v9 database from an external 
system and how to perform updates. 

To import new items into Retail Pro: 

1. Add the item information to the Inventory.xml file.  

Reference: See Required Information for New Items 

2. Place the file in the ECM\Polling\[Station]\In\Recvd directory, and then perform a Process In 
operation using the Enterprise Communications Manager (ECM). 

Importing New Items  
Item Definition/Description 

The first time you import items from an outside system into Retail Pro, you must enter values in 
the following fields: 

sbs_no dcs_code description1 

created_date modified_date tax-code 

flag ext_flag kit_type 

max_disc_perc1 max_disc_perc2 unorderable 

print_tag active mark_for_del 

cms_post_date eci_flag regional 

qty store_no  

 

Important!: Do not leave a required field blank or use empty quotation marks (“ “) 

Active Field Must Be Set to 1 

When importing items, it is crucial that the Active field is set to "1" . 

Note: You can import departments and vendors whose active field is set to "0", but not items. 

Defining Store Quantities 

In the INVN_SBS_QTYS section of the Inventory.xml file, enter a store_no for each store and the 
qty of the item at the store. You do not need to enter a qty of “0” for those stores where the on-
hand quantity is zero. 
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For example, if you want to import an item and set its quantity to zero at all stores, the XML will 
look like this: 

<INVN_SBS_QTYS> 

<INVN_SBS_QTY store_no="1"/> 

<INVN_SBS_QTY store_no="2"/> 

<INVN_SBS_QTY store_no="3"/> 

<INVN_SBS_QTY store_no="4"/> 

.... 

<INVN_SBS_QTY store_no="250" qty="0"/> 

</INV_SBS_QTYS> 

In this example, after the item is in Retail Pro, the retailer could create adjustment memos to 
adjust the quantity. 

If you want to define (or update) non-zero item quantities, list every store_no and qty. 

Example: 

<INVN_SBS_QTYS> 

<INVN_SBS_QTY store_no="1" qty="10"/> 

<INVN_SBS_QTY store_no="2" qty="10"/> 

<INVN_SBS_QTY store_no="3" qty="10"/> 

<INVN_SBS_QTY store_no="4" qty="10"/> 

<INVN_SBS_QTY store_no="250" qty="40"/> 

</INV_SBS_QTYS> 

Store 250 

Store 250 is used to store the on-hand quantity for the entire company. Be sure to enter the correct 
company quantity for store 250 when importing items into Retail Pro for the first time. 

You must either pass correct store 250 quantities, OR use Technician’s Toolkit after the import to 
recalculate company quantities. If you don’t enter the correct quantity for store 250 or run 
Technician’s Toolkit, Retail Pro inventory will display incorrect quantity values for the company. 

Flag Field Must Be Set for Transactions to Update On-Hand Quantity 

When importing new items into Retail Pro, be sure to set the Flag field in the Inventory.xml file. If 
you don’t set the Flag field in the Inventory.xml file, receipts that are imported into Retail Pro 
will not update the item’s on-hand quantity. 

The flag field is a bit array field: 

Bit Function 

0 Skip Committed flag 

1 Skip Inventory flag (i.e. Non-inventory item) 

2 Non-editable flag. An example of this would be the CMS flag, used in v9 but not used in v8. 

3-7 Reserved for future use. 
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The following table lists the integer value that should be entered in the Flag field to achieve the 
desired setting. 

Integer 
Value 

Description 

0 All flags deselected (0000 0000). An item with this setting would be included in Committed, 
would not be a non-inventory item, and would be editable. 

1 Enables the Skip Committed flag (0000 0001) 

2 Enables the Non-Inventory flag (0000 0010) 

3 Enables both the Skip Committed and Non-Inventory flags. (0000 0011) 

4 Enables the CMS flag (0000 0100)( 

5 Enables the CMS and Skip Committed flag (0000 0101) 

6 Enables the CMS flag and the Non-Inventory flag (0000 0110) 

7 Enables the CMS flag, Non-Inventory flag, and the Skip Committed flag (0000 0111) 

 

Sample Inventory.xml file: 
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Importing Updated Item Information 

To import updated item information into Retail Pro: 

1. Add the item information to the Inventory.xml file.  

2. Place the file in the ECM\Polling\[Station]\In\Recvd directory, and then perform a Process In 
operation using the Enterprise Communications Manager (ECM). 

Updating Item Quantities 

If you want to import updated item quantities, list each store_no and qty in the IVNV_SBS_QTY 
section. 

Example: 

<INVN_SBS_QTYS> 

<INVN_SBS_QTY store_no="1" qty="10"/> 

<INVN_SBS_QTY store_no="2" qty="10"/> 

<INVN_SBS_QTY store_no="3" qty="10"/> 

<INVN_SBS_QTY store_no="4" qty="10"/> 

<INVN_SBS_QTY store_no="250" qty="40"/> 

</INV_SBS_QTYS> 

Communication of Receipts 

INVN_BASE_ITEM Info Required 
When a receipt (invoice) is transmitted from one station to another, it cannot be guaranteed that 
the receiving station will have the items that are listed on that receipt in the stations’ inventory. 
When ECM is importing a receipt into Retail Pro, if an item that is on the receipt is not in 
inventory, then that item will be created by ECM and marked as inactive. This enables the receipt 
to be created successfully at the importing station. To do that, ECM needs to know basic details 
about the item and this information is contained in the <INVN_BASE_ITEM> section of the 
XML file.  

Communication of Customers 
ECM uses different logic for processing out customers depending on whether the station has a 
Station Type of MAIN, or a Station Type of Remote.  

When setting up the station records of the stations yours will communicate with, make sure that 
the Station Type reflects the actual type of the station it is: Retail Pro 8/9 Main or Retail Pro 8/9 
Remote. Remember, you are selecting the type of station you are communicating with, not your 
own station's type. 

Note: Station type Other behaves similar to a Retail Pro 9 Main station. IPMS station type also 
behaves like a Retail Pro 9 Main, with the addition of auto-confirming every processed out 
document. 
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Rules for Processing Out Customers 
Processing Out to a Main station: 

1) Local customers are sent to the station's own subsidiary 

2) Global customers are sent to all subsidiaries 

3) Non-shared customers are sent to the station's own subsidiary 

4) Regional customers with an UNDEFINED District are sent to the station's own subsidiary 

5) Regional customers with a DEFINED Region and District from the CORP subsidiary (-1) are 
sent to the subsidiaries included in that region's list of locations 

6) Regional customers with a DEFINED Region and Sector from any other subsidiary are sent to 
that subsidiary 

Note that these rules ignore Store Number. This is a desired behaviour when data is polled TO the 
main station. 

Processing Out to a Remote Station. 

1) Local customers are sent to all stores in the station's own subsidiary 

2) Global customers are sent to all stores in all subsidiaries 

3) Non-shared customers with a NON-BLANK Store Number field are sent to the station's own 
store only 

4) Non-shared customers with a BLANK Store Number field are sent to all stores in the station's 
own subsidiary 

5) Regional customers with an UNDEFINED District goes to its own store, if store number is 
also blank it goes to all stores in its own subsidiary 

6) Regional customers with a Region and District selected from the CORP subsidiary 

(-1) are sent to all stores in the subsidiaries included in that region's list of locations  

7) Regional customers with a region and sector selected from any other subsidiary are sent to the 
list of stores specified in that region's list of locations. 

General Rules 
1) A non-shared customer with a blank store number field behaves like a local customer. 

2) A regional customer behaves like a non-shared customer if region/district is not selected. 

3) When proc-out is preparing data for another MAIN station, it will not filter customers by 
stores. 

Note: This change affects ECM on both Retail Pro 8 and Retail Pro 9 sides.  

Share With and CMS Fields in Customer Records 
The Share With field in customer records is used when processing out from Retail Pro 8. The 
CMS field is used when processing out from Retail Pro 9.  
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CMS (Retail Pro 9) Field Values 

Value Description 

0 Local customer (CMS_0) 

1 Global customer (CMS_1) 

2 Regional customer (CMS_2) 

-1 Non-shared customer (CMS_3) 

 

SHARE_WITH (Retail Pro 8) Field Values 

Value Description 

0 Share with all stores (SHARE_WITH_0) 

1 Share with MAIN only (SHARE_WITH_1) 

2 Not shared at all, i.e. not polled (SHARE_WITH_2) 

-1 Share with all stores as a GLOBAL customer (SHARE_WITH_GLOBAL) 

 

Rules for SHARE_WITH and CMS Flags 

Polling Scenario Result 

Customer is polled between two 9-series 
stations 

CMS flag is used and is updated based on customer modified 
date. 

Customer is polled between two 8-series 
stations 

SHARE_WITH flag is used and is updated based on customer 
modified date. 

Customer is polled between 8-series 
and 9-series and this is an EXISTING 
customer on the target station 

Neither flag is updated 

Customer is polled from 8-series to 9-
series and it is a new (or reactivating) 
customer record 

Flags are mapped as follows: 

a) SHARE_WITH_0 -> CMS_0 

b) SHARE_WITH_1 -> CMS_3 

c) SHARE_WITH_2 -> CMS_3 

d) SHARE_WITH_GLOBAL -> CMS_1 

Customer is polled from 9-series to 8-
series and it is a NEW customer record 

Flags are mapped as follows: 

a) CMS_0 -> SHARE_WITH_0 

b) CMS_1 -> SHARE_WITH_0 

c) CMS_2 -> SHARE_WITH_0 

d) CMS_3 -> SHARE_WITH_1 
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Communication of Preferences 
When you communicate preference information to another station, the resulting Preferences.xml 
file only shows two values: the PREF_ID and the PREF_TYPE. 

See Appendix A for a table listing preferences and by PREF_ID and PREF_TYPE. 

Communication of Transfer Documents 
Retail Pro 9 handles transfer documents differently than Retail Pro® 8-Series, so special 
processing rules are used. The processing rules allow for the unique database types to maintain a 
document trail that is accurate for their respective databases, while eliminating the chance of a 
single document making multiple updates at a given database. 

Out Slips 
In both Retail Pro 9 and 8, creating an out slip updates the source location's inventory. In RP8, 
however, the out slip also updates the target store's inventory. 

In Slips 
Retail Pro 8 users can optionally require In Slips when receiving transferred merchandise, but the 
In Slip is only used to verify the transfer and correct any discrepancies; In Slips themselves have 
no impact on inventory. Retail Pro 9, on the other hand, requires a voucher to update the target 
location's inventory. 

The following sections explain how ECM handles communication of slips between Retail Pro 9 
and 8. 

Unverified Slips sent to Retail Pro 9 (Oracle) 
When unverified out slips are communicated to the Retail Pro 9 (Oracle) station, ECM recognizes 
that the slip is not verified and does not currently exist within the database. Retail Pro 9 generates 
an ASN voucher that references the out slip. Both the slip and the ASN are then saved to the 
database. At this point, both the RP8 (BTF) database and RP9 (Oracle) database contain the 
unverified out slip. What happens next depends whether or not the out slip is verified at the 8-
Series station, or if an ASN is updated at the RP9 station. 

If the Out Slip is verified in Retail Pro 
Verifying an out slip in Retail Pro, confirms the updating of the target station's inventory. 

During the next communication with Retail Pro 9, ECM recognizes that Retail Pro already has 
the out slip, and that the slip references an ASN (automatically created by Retail Pro when the out 
slip was first sent). 
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Retail Pro generates a voucher from the ASN, and the target station in Retail Pro is now updated. 

During the next communication, the voucher is sent to Retail Pro. ECM at the Retail Pro station 
recognizes the reference to the existing out slip, and the voucher is not filed into the Retail Pro 
(BTF) database. 

If an ASN Voucher is updated in Retail Pro 
You can generate a voucher directly from the ASN (or reference the ASN on a new voucher). 
When the voucher is updated, the target station's inventory is updated, and the out slip is marked 
Verified. 

During the next communication, the out slip is sent to Retail Pro 9. At the Retail Pro station, 
ECM recognizes that the slip already exists, but is coming in as verified. ECM also notes that the 
slip references a voucher. The voucher created in Retail Pro is not actually processed into the 
Retail Pro database; however, a confirmation will be sent back to Retail Pro 9, as though it had. 
The out slip is then filed. 

Verified Slips Sent to Retail Pro 9 (Oracle) 
When a verified slip is sent to Retail Pro 9, ECM recognizes that the slip is verified and does not 
currently exist in the Oracle database. 

Retail Pro 9 automatically generates a voucher, referencing the out slip, that updates the target 
station's inventory. 

During the next communications cycle, the voucher is sent back to the RP8 Main station. ECM 
recognizes the reference to the out slip (which is already in the RP8 BTF database), and the 
voucher is not processed in; however, a confirmation is sent to the RP9 station to confirm that the 
voucher was seen during communication. 

Inter-Company Transfers sent to Retail Pro® 9-Series (Oracle®) 
When sending a slip for an inter-company transfer, ECM will create an ASN.  

References between the slip and ASN do not need to be maintained because the documents will 
be distributed to separate subsidiary stations. Each subsidiary will make the change, as needed, on 
their respective documents. 

Updating In Transit Information in Retail Pro 8 (BTF) 
When communicating slips from Retail Pro 9 to RP8, different rules apply depending on the 
tracking in transit configuration at the target station. 

If not tracking in transit and not requiring in slips 
Out slips created in Retail Pro 9, when sent to an RP8 BTF station, immediately update the source 
and target stations' inventory. The out slip is then filed. 

 The out slip's Target Updated field is selected, indicating that the target station's inventory 
has been updated. 

 There is no update of in-transit quantity information. 
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If not tracking in transit and requiring in slips 
The out slip created in Retail Pro 9, when sent to an RP8 BTF station, immediately updates both 
the source and target stations' inventories. 

 The out slip's target updated flag is selected. 

 The out slip is moved to the unverified slips file to await verification. To complete 
verification, an in slip referencing the out slip must be created. Upon verification, both 
slips are filed. 

Note: The target station will not be updated twice when the unverified slip is moved to the former 
slips file because the out slip's target updated field is selected. 

If tracking in transit and not requiring in slips 
When tracking in transit, out slips created in Retail Pro 9 Oracle stations perform a different 
function during inventory updates. 

 Out slips only affect the source station's inventory. 

 Because tracking in transit is used, after the source station is updated, the slip is filed in 
the unverified slips file. 

 The in-transit quantity information is updated. 

Note: An out slip is truly considered to be tracking in transit when it contains a Days in Transit 
value greater than 0.  

RP8 BTF stations are not aware of tracking in transit. If tracking in transit is set, and an out slip is 
created at a Remote station, the Days in Transit value is set to -1. When the out slip is sent to the 
Main station, the process in program recognizes that this is a system-assigned value, and the 
correct days in transit is entered on the document (retrieved from the system preference setting at 
the Main). 

After the out slip is verified, the slip is filed, the target station's inventory is updated, and the 
slip's Target Updated field is selected. 

If tracking in transit and requiring in slips 
Out Slips created in Retail Pro 9 update only the source station's inventory. When the out slip is 
sent to the RP8 (BTF) station, the out slip is placed in the unverified slips file, and the in-transit 
quantity information is updated. 

If a referencing in slip is found, then verification takes place regardless of the days-in-transit 
status. The out slip and in slip are then filed, the target station's inventory is updated, and the 
Target Updated field is selected. 

Now that the out slip has been verified, the previous effects on In-Transit quantity will be 
reversed. 

If the days-in-transit value has expired and no in slip is found, you have an unverified out slip that 
performs the following actions: 

 The target station's inventory is updated. 

 The slip's target updated field is selected. 

 The previous effect on in-transit quantity is reversed. 



 Retail Pro® Enterprise Communication Manager (ECM™)  
 

© 2011 Retail Pro International, LLC All rights reserved. 
94 

An in slip will still be required to move the out slip to the former slip file. After the in slip is 
created, both documents are filed with no additional impact on source or target inventories or in-
transit quantities. 

In Slips 
Retail Pro 9 does not recognize in slips as a document type that affects inventory. Any in slips 
communicated from an RP8 (BTF) database are simply filed in the RP9 (Oracle) database.  

Reversed Slips/Vouchers 
The rules that are applied depend on where the out slip was created and what type of tracking in-
transit configuration is used at the Retail Pro 8 BTF station. 

If you reverse an out slip at a BTF station, ECM handles the document differently depending on 
whether or not the document previously existed in the Oracle database, and whether or not it was 
in a verified state. 

Out slip does not exist in Oracle database 
If the out slip was not previously sent to the Oracle database, it won't be in the database. In this 
case, the BTF station sends the original out slip (now marked Reversing), as well as the new out 
slip that reverses its effect (marked Reversing). ECM processes in both documents. 

The Reversed out slip is considered a verified document. Because the document SID does not 
exist in the Oracle database, the out slip is filed and no changes are made to the source station's 
inventory. 

The Reversing out slip is processed in. Because the document SID does not exist in the Oracle 
database, the system creates a voucher to update the target station's inventory, and immediately 
reverses it. The voucher contains a reference to the Reversing out slip, and thus is not sent back to 
the BTF database (preventing duplicate updates of inventory). 

Verified out slip exists in Oracle database (with a related voucher affecting 
target station) 
Retail Pro 8 (BTF) stations send both Reversed and Reversing out slips to RP9 Oracle databases. 
ECM processes in both documents. 

A Reversed out slip is considered a verified document. The document already exists in the Oracle 
database, but in a different state, so ECM updates the source station's inventory with the correct 
quantity on the out slip. 

The Reversing out slip recognizes the voucher in the Oracle database that updates the target 
station's inventory. The system reverses and files the voucher.  

The Reversed voucher maintains its reference to the out slip. This prevents the BTF station from 
processing in the document and mistakenly updating its inventory again. 

Unverified Out Slip exists in Oracle database (with a related ASN) 
A Reversed out slip is, by nature, a verified document. The out slip is filed and no changes are 
made to the source station's inventory.  

A Reversing out slip inactivates the ASN associated with the out slip. 
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Communication of Inter-Company Transfers 
In Global Preferences > Company > Transfer Rules, you can select the specific locations that can 
perform intercompany transfers. This preference area provides two main benefits: 

 Makes it easier to configure inter-company transfers 

 Enables locations to view the entire configuration chain established at the Corporate 
headquarters, something they were previously not able to do 

 

 

 

 

 

 

 

 

 

 

 

 

When defining transfer rules, you can define:  

A single rule for all stores in the subsidiary, or a unique rule for each store in the subsidiary. 

Define Single Rule for all Stores 

If Define Single Rule for all Stores is selected, you are deciding that all stores at the source 
subsidiary will have the same rules with respect to the target stores with which they will perform 
intercompany transfers. 

At any point in time the user can unselect this option after an array has been saved and make 
changes to an individual source store as needed. Un-checking this option after an array has been 
set,will result in each store still having the same set of configurations. 

Define Unique Rule for Each Store 

If Define Unique Rule for Each Store is selected, you not only have a list of the stores that are 
assigned for a selected subsidiary, you can highlight a specific store and update target 
subsidiary\store combinations as needed. You can do this for each individual store. 

Default = Define Single Rule for all Stores 

In you toggle from ‘Single Rule’ to ‘Unique Rules’, all defined target locations are held. In 
essence, all source stores will still be the same, but you can manually change details for a specific 
store as needed. If you move from ‘Unique Rules’ to ‘Single Rule’ all defined stores will be 
removed and it will be as though you are starting from the beginning of the process. A warning 
message is displayed to warn you defined rules will be lost. 
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Source Subsidiary 
The Source Subsidiary is listed on the left side of the screen and is the location from which an 
inventory transfer is being requested. 

All subsidiaries defined at the given installation are listed, except the default corporate subsidiary 
(-1). The information in the drop down is displayed in [sbs_no]: [sbs-name] format. When a 
subsidiary is selected, all active stores assigned to the given subsidiary are displayed.  

The two radio buttons are a unique attribute for each subsidiary. This gives retailers the flexibility 
of some subsidiaries using the same rules for all stores and other subsidiaries using unique rules. 

Source Stores 
Only active stores are displayed If you configure a rule for a sub\store combination that is active 
for one location but inactive at another location, those rules will still be recorded but simply not 
used at the alternate location. 

Target Subsidiary 
The target subsidiary is listed on the right side of the screen and displays the location to which 
inventory transfer requests are being sent. 

All subsidiaries defined at the given installation are listed, except the default corporate subsidiary 
(-1). The information in the drop down is displayed in [sbs_no]: [sbs-name] format. When a 
subsidiary is selected, all active stores assigned to the given subsidiary are displayed. 

Target Stores 
In the Target Stores area, you can select the target locations to which the rules will be sent. Only 
active stores are displayed You can use the Select All option in the ‘Include’ column to enable or 
disable all stores in one operation. 

Masters Information 

Displays the date of the last update of the transfer rules area of preferences. 
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Copying and Pasting Rules 

When defining a unique rule for each store, you may have several stores that will use the same 
rules. To speed up the configuration of transfer rules, you can copy and paste transfer rules from 
one store to another. 

Select Define Unique rule for each store, and then define rules for a store. 

With the store selected, right-click and select Copy Rules. 

 

 

 

 

 

 

 

 

 

 

 

 

Select the store to which you want to paste the rules, and then right-click and select Paste Rules. 
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The extraction of transfer rule pairings and stores is controlled by the Transfer Stores and 
Transfer Store Pairs areas in the Profile Checklist. 

 

 

 

 

 

 

 

 

Select All in the Transfer Stores area to extract the list of subs and stores from the table that 
populates the transfer rules source and target sub and store list. 

Select All in the Transfer Store Pairs area to extract the pairing relationships. The data 
representation of the pairing relationship indicates whether a single rule or unique rule for the 
source subsidiary is in use.  

XML File for Inter-Company Transfer Rules 

The resulting XML file is named ICTRule.xml.  

Subsidiary\Store Discrepancies 

Ideally, multiple installations are configured with the identical subsidiaries and stores, and the 
identical identifying numbers are assigned to those subs/stores. 

If there are differences, the following example outlines current functionality in Retail Pro and 
recommended course of action. 

Installation 1 

SBS 1 Store 001 Store 002 Store 003 

North Region Store A Store B Store C 

 

Installation 2 

SBS 1 Store 001 Store 002 Store 003 Store 004 

West Region Store W Store X Store Y Store Z 

 

If you communicate store information from the North Region to the West Region, the end result 
will have the SBS 1 = West Region store 1=A, 2=B, 3=C and 4=Z. 

Company information is not changed; however, the store details will be updated. To ensure 
consistency, it is important for both stores and transfer rules to be shared.  
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Communication of Employees 
Communicating Employees from Retail Pro 8 

When you use the ECM to import employees into Retail Pro 9 from a Retail Pro 8 station, the 
Enabled field for these employees is cleared. In addition, the employees are not assigned a name 
or password. To allow these employees to access Retail Pro 9, you need to select the Enabled 
field, at which time you are prompted to give them a unique log-in name and password.  

Security Information for New Employees Imported into Retail Pro 9 

When you import new employees into Retail Pro 9 via the Employees.xml file, you must import 
the employees without password or security settings. After the basic information for the employee 
is added, you must go into Employee Mgmt > Groups to assign passwords, security rights, and 
privileges. 

Security information is stored in the <SECURITY_SETTINGS> area of the XML file. A sample 
of which is shown below: 
<SECURITY_SETTINGS sig1="80095CC838C28504CBB5E89A20985A10FFF9187F"> 
<EMP_SBSS> 
<EMP_SBS sbs_no="1" access_all="1" stores="0-1"/> 
</EMP_SBSS> 
<CMS_USER user_id="97" user_name="USER2" sbs_no="1" active="1" password="C498F7B745" 
sysadmin="0" sig2="49E5E008F0B1F5E306701BE393602844A2FFA5B"> 
<USER_GROUPS> 
</USER_GROUPS> 
</CMS_USER> 
<SIGNATURE sig3="D9FBBA855F6D5BFFB73E2C08134377B9FB11AAFC"/> 
</SECURITY_SETTINGS> 

 

These are not required fields. If you are importing new employees into Retail Pro 9, do not enter 
values in these fields for the new employees. When you assign password and security 
information, the fields will be populated by the system. 
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Communication of Employee Passwords/Policies 
ECM makes it easy for retailers to communicate employee passwords (and password policies) 
between the Main (headquarters) and remote stations.  

ECM’s password polling features have the following benefit: 

 Decrease amount of polled data, speeding up communication times 

 Enable greater flexibility in passsword polling (Main can receive password updates from 
remotes while still controlling other employee information) 

ECM Checklist Options for Employee Passwords, Password Policies 

ECM includes separate checklist options for Employee Passwords and Password Policies. These 
options enable retailers to send only passwords and/or policies, which are much smaller files than 
the Employees.xml file and thus can be sent more often. 

Please note that password information is still included in the Employees.xml file. The checklist 
options are designed to give retailers the option of sending only passwords or policies, if desired 
and apply only to communication between V9 databases. 

Employee passwords and password policies can be sent as None, or All. The sending of 
Differences (updates and new records only) is not currently available. 

 

 

 

 

 

 

 

 

 

The XML files that communicate employee password and policy information are, respectively, 
EmployeePasswords.xml and PasswordPolicies.xml. These files are always produced in 
compressed form. 

Configuration #1 – Main Controls Employees, Passwords Polled once per Day 

In this scenario, one polling cycle is performed per day. The Main has the Manage Employee 
Security and Accept Employee Password flags selected. The checklist options for Employee 
Details and Password Policies are also selected. This enables the Main to control all employee 
information, including password policies, yet still receive password updates from remotes. 

The Remote is configured to NOT manage security. It is set to process out employee passwords, 
but not employee details and password policies. 

 

Setting At Main At Remote 
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Manage Employee Security Enabled Disabled 

Accept Employee Passwords Enabled N/A (Manage Security disabled) 

Employee Details All None 

Employee Passwords None All 

Password Policies All None 

 

Configuration #2 – Main Controls Employees, Passwords Polled Multiple Times per Day 

In this scenario, the Main is configured to poll passwords multiple times per day (e.g. every hour) 
but employee details only once per day. The Main has the Manage Security flag selected, but not 
the Accept Employee passwords flag.  

The Remote is configured to NOT manage security. The remote is set to process out employee 
passwords every hour and not to process out employee details at all. 

 
Setting At Main At Remote 

Manage Employee Security Enabled Disabled 

Accept Employee Passwords Disabled N/A (Manage Security disabled) 

Employee Details All None 

Employee Passwords None All 

Password Policies All None 

 
Differences between the Two Scenarios 

The difference between these two scenarios is that in the first scenario the only way for an 
updated employee password to be sent from the Main to the Remote is by sending all employee 
details (Employees.xml), which involves much more work for ECM. In the second scenario, 
employee passwords (EmployeePasswords.xml) can be polled at regular intervals (ECM will 
silently skip the passwords for the employee records that haven’t been polled yet), thus 
shortening the regular polling cycle (because passwords are faster to process alone). 

Sending the password file multiple times per day can ensure that employee password changes are 
propagated in a timely manner, preventing problems with employee log in.  

Likewise, if a change is made to grpup password policies, such as rules for strong passwords, 
reusing passwords, etc., you can select the Password Policies option to send the 
PasswordPolicies.xml file only. 
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Remote Control of Passwords 
Accept Employee Passwords Flag 

In the Profile Tools area of the ECM checklist is an option called Accept Employee Passwords. 
The Accept Employee Passwords option enables remotes to control passwords while the Main 
controls other employee information. This is useful for retailers who find it more convenient and 
practical to change/update passwords at remotes than at the Main.  

The Accept Employee 
Passwords flag works in 
conjunction with the Manage 
Employee Security flag. 
When receiving the 
EmployeePasswords.xml file, 
ECM only looks at the Accept 
Employee Passwords setting 
if the Manage Employee 
Security setting is selected. 

If both the Manage Employee 
Security and Accept Employee Passwords flags are selected, your station WILL process in the 
EmployeePasswords.xml file. 

If the Manage Employee Security flag is selected, but Accept Employee Passwords is NOT 
selected, the station WILL NOT process in the EmployeePasswords.xml file. 

Configuration #3 – Main Controls Employees, Remote Controlls Passwords 

In this configuration scenario, the Main is configured to Manage Employee Security and is also 
configured to Accept Employee Passwords. The checklist options for Employee Details and 
Password Policies are selected, but Employee Passwords is not. 

At the remote, Manage Employee Security, Employee Details and Password Policies are not 
selected, but Employee Passwords is selected. 

Setting At Main At Remote 

Manage Employee Security Enabled Disabled 

Accept Employee Passwords Enabled N/A (Manage Security disabled) 

Employee Details All None 

Employee Passwords None All 

Password Policies All None 

 

About the “Manage Employee Security” Flag 
If you select “Manage Employee Security” for a station, you are indicating that the station 
manages its own security and won’t accept changes (including password changes) from another 
station. This is why, if you want the station to accept password changes (by processing in the 
EmployeePasswords.xml file), you also need to select the “Accept Employee Passwords” flag. 
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If Manage Employee Security is selected for a station, the following information will NOT be 
imported: 

1) Group policy settings defined in Groups >Policy from PasswordPolicies.xml. (Not all of those 
pertain to “passwords”) 

2) Employee logon credentials from Employee.xml 

3) Employee group assignment from Employee.xml 

4) Employee store assignment from Employee.xml 

5) List of user groups from UserGroup.xml 

6) User rights assignments for user groups from UserGroup.xml 

Notes about Communicating “Employee Passwords” 
 All passwords are always processed out always; polling of differences is not allowed. 

 Passwords are processed out for the same employees that get processed out in the 
“Employee Details” area.  

 A Primary license server database can only send passwords to a secondary activated 
against that primary. A secondary can only send passwords back to its own primary.  

 If you get an error “Cannot update passwords - no passwords found” it means that there 
were no employees with any credentials to be polled for a particular station, so turning on 
polling of password policies was not even  needed.  

Notes about Communicating “Password Policies” 
 The “Manage Employee Security” switch DOES affect processing in of password 

policies. Password policies will be silently ignored if the receiving system is set to 
manage security locally. 

 IMPORTANT: You can poll the “Enforce Password History” policy in the sense that “the 
MAXIMUM NUMBER of unique passwords allowed before reusing a password” can be 
set properly at the receiving side; however, there is no way of polling the actual 
PASSWORD HISTORY, so if an employee’s password is changed on both sides before 
synchronization occurs, it is possible to end up with two conflicting histories of actual 
password values at the Main and remote. Therefore, if the “Enforce password history” 
policy is enabled, we recommend that you change the password in one location and let 
ECM send it to other locations during a regular polling cycle. Do not change a password 
in multiple locations before ECM has a chance to synchronize all the stations. 

 Employee password policies can only be communicated from a primary license server to 
a secondary license server activated against the primary.  Do not try to process out 
employee policies at a secondary license server. 
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Password Modified Date 
Employee records include a “Password Modified Date” field that stores the date of the most 
recent password change. The Password Modified Date field is updated in the following situations: 

 A new user is created 

 An existing user’s password is changed 

 An existing user is reactivated 

When processing in employee records, if an employee’s Password Modified Date field is blank, 
ECM leaves the Password field alone (unless Oracle logon credentials were changes). 

If an employee’s Password Modified Date field is not blank (password modified), ECM update’s 
the employee’s password is updated, provided that the date in the XML is newer than then date in 
the CMS_USER table in Oracle. 

Sysadmin User Passwords 

The password of a SYSADMIN user is NOT updated regardless of the Password Modified Date. 
This prevents a remote from overriding a password change done at the Main. In other words, a 
SYSADMIN user’s password is always controlled locally. 

Disabling/Enabling Employees 

Disabling and enabling an employee does NOT cause the Password Modified Date field to be 
updated. 

Editing XML Files 
Every piece of the XML has a digital signature, so don't try to decompress the file, edit it, and 
then process it in. An error message will be displayed, explaining that the signature could not be 
verified. 

Enforce Password History 
The Enforce Password History policy is a special policy. It is used to control employees’ ability 
to re-use previously used passwords. When communicating passwords and policies, ECM does 
not send the actual password history, just the setting. Therefore, if the Enforce Password History 
policy is enabled, we recommend that you change the password at the primary license server and 
let ECM propagate it to any secondary license servers during a regular polling cycle.  

Trial Mode Databases Cannot Send Passwords, Policies 
ECM will NOT send passwords or policies out if your station is in trial mode. This is because 
there is no way to verify the hardware signature (license servers aren’t aware of each other until 
licensing is activated). 
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Proc_Status Field on Slips 
The Proc_status field is used to identify properties of transfer slips, specifically: 

 Whether or not a slip is a reversed slip, or a reversing slip (a reversing slip undoes the 
effect of the original slip). 

 If the slip has been exported to the general ledger (GL Flag selected) 

 If the slip resulted in a cost change (Cost Change Flag selected) 

 If the slip was exported using Bridge (Bridge Flag selected) 

Bits which can be set in slip.proc_status are: 1, 2, 3, 4, 5.   5 bits = 32 combinations 

Thus, proc_status = B1 * 2 + B2 * 4 + B3 * 8 + B4 * 16 + B5 * 32 where B1-B5 can be either 0 
or 1. 

Bit Description 

B1 GL Flag 

B2 Cost Changed Flag 

B3 Bridge Export Flag 

B4 Reversed Slip 

B5 Reversing Slip 

 

Since bits B4 and B5 cannot be set simultaneously (a slip cannot be simultaneously a reversed 
and reversing slip), we end up with only 24 combinations. 

 

Bits Proc_status K 

00000000 0 +1 

00000010 2 +1 

00000100 4 +1 

00000110 6 +1 

00001000 8 +1 

00001100 10 +1 

00001110 14 +1 

00010000 16 +1 

00010010 18 +1 

00010100 20 +1 

00010110 22 +1 

00011000 24 +1 

00011010 26 +1 

00011100 28 +1 

00011110 30 +1 
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Bits Proc_status K 

00100000 32 -1 

00100010 34 -1 

00100100 36 -1 

00100110 38 -1 

00101000 40 -1 

00101010 42 -1 

00101100 44 -1 

00101110 46 -1 

 

How to Determine if a Slip is Reversed or Reversing 
Look at the proc_status, and find the corresponding value of K.   

If K=+1, the slip is a normal or reversed slip, and it DECREASES quantity in the outgoing store 
and INCREASES quantity in the incoming store.  

If K=-1, the slip is a reversing slip and it INCREASES quantity in the outgoing store and 
DECREASES quantity in the incoming store. 

Note: There is no guarantee that the proc_status field will not pick up additional flags.  When it 
does, there will be additional values that would need to be checked. The proper and reliable 
method is to check for the reverse and reversing flags is to analyze the individual bits. 
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Communication of Physical Inventory Files 
You can send physical inventory files to Retail Pro , where they will be used to confirm or correct 
current on-hand quantities in inventory. 

The available checklist options for PI files are All or None. You cannot send Differences 
associated with PI Counts. 

To send physical inventory counts to Retail Pro: 

1. Click Stations on the top menu of the ECM Home Screen. 

Result: The list of stations displays. 

2. Select the Station to which you want to assign or change a profile. 

3. Click Form View. 

4. Select the Checklist/Rules tabbed page. 

5. Click Edit. 

6. Select Profile Checklist > Merchandise > Physical Inventory. 

7. Click Save. 

Pending PI Files 
Some retail locations do not have permission to update inventory quantities. These,mstations send 
a Pending PI file to the Main station, which processes the counts and then updates the source 
location's inventory via adjustment memos or the inventory data file. 

Processing Out of PI Files 
Basic Steps 

1. Retail Pro  BTF creates RproPI.zip. 

2. ECM retrieves the zip file and converts the data to XML. 

3. ECM Exchange compresses and encrypts the file. 

 If target station (process in station) is a BTF database, the XML file is converted to BTF 
format. 

 If target station is an Oracle database, the XML file is processed directly into the 
database. 
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Retail Pro 9 Series Creates Pending PI Counts 
ECM prepares XML files from Pending PI files for the correct locations. ECM Exchange 
compresses and encrypts the data. 

 If the target station (process in station) is a BTF database, the XML file is converted to 
BTF format. 

 If the target station is an Oracle® database, the XML file is processed directly into the 
database. 

Processing Out from 8 Series BTF 
The Retail Pro  8-Series PI Tool places the latest PI file (Rpropi.zip) in the 
Polling\[store\station]\Out\Upload folder. When processing out, ECM copies the Rpropi.zip file to 
the appropriate \Out\Temp folder for the target station. The contents of Rpropi.zip are then 
extracted and converted into XML format. The original RproPI.zip file within the  ...\Out\Upload 
directory is then deleted. 

Process Out Log 

The ECM Process Out log records any successful retrieval of an RproPI.zip file. The log will 
display: 

“Successful process out of RproPI.zip from “[Path]”” where [Path] is the store stations path to the 
…\Out\Upload folder. 

The ECM Process Out log will record any failed attempt to create the needed XML data file for 
PI files. If a failure occurs, the original zip file will not be deleted. The log file will reflect: 

“Unable to prepare RproPI data file from RproPI.zip from “[Path]”” where [Path] is the 
store/station's path to the  …\Out\Upload folder? 

 

Processing Out from 9 Series Oracle 
When processing out from Retail Pro 9, ECM doesn't check for a RproPI.zip file. Pending PI’s 
that should be communicated are stored directly in the database. ECM recognizes the pending 
status of any PI file that was created in Retail Pro. 

When PI count files exist, ECM prepares the appropriate XML file with respect to the PI counts 
and the store/station for which those counts belong. 

Note: ECM will not process out Pending PI information for a given store/station unless that PI 
originated at Retail Pro or if Retail Pro is set to manage inventory for that given location. 
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Communication of Oracle Logon Information 
ECM can export and import employee details as well as Oracle logon information associated with 
that employee. 

Oracle logon information is stored in the CMS_USER table in the database. 

To export Oracle Logon information: 

1. In the station checklist for each target station, select the All option for Employees. 

If All is selected, all employee group information (including logon name and password) is 
sent to the target 9 Series station via the Groups.xml file.  If None is selected, no group 
information is sent to the target station. 

2. Perform a Process Out and Exchange. 

During Process Out, employee information is written to the Employees.xml file. Group 
information is written to the Groups.xml file. 

Note: The Groups.xml file encrypts password information. 

Exported Employee Information 

During Process Out, ECM exports the following employee information: Employee subsidiary 
number, employee name, employee code, commission level, drawer, time shift number, max 
discount percentage, customer sid, active, retail pro full name, description, hire date, exempt 
status, job name, username, password. 

To import Oracle Logon Information: 

1. Perform a Process In at each target station. 

The logon information in the Employee.xml file is written to the CMS_Users table in the 
database. 

Duplicate Checking 

During Process In, ECM checks each employee to see if the employee already exists within the 
database. ECM uses a combination of [username], [password], [login_name], to identify 
employees that already exist in the database and writes the duplicate information to a separate 
file. You can review the file and make corrections. 

If the employee is a new employee, all information available in the Groups.xml file is added to 
the database. 

Imported Employee Information 

During Process In, ECM imports the following employee information: Employee subsidiary 
number, employee name, employee code, commission level, drawer, time shift number, max 
discount percentage, customer sid, active, retail pro full name, description, hire date, exempt 
status, job name, username, password. 

Subsidiary 
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Exported employees may be assigned to a subsidiary that does not exist at the target location. If 
an exported employee is not able to be assigned to an existing subsidiary at the target location, the 
employee will imported into the same subsidiary as the user performing the import. 

Group Assignment 

When importing employees, Group information is imported first. Employees information is then 
imported and employees added to the same groups to which they belonged at the exporting 
location.  

Communication of Externally Created Files 
Externally created files can be exchanged and processed provided they are in XML. 

To process in an externally created XML file: 

Place the file in the \In\Recvd directory. The next process in the operation attempts to update this 
file. ECM logs any information related to the success or failure of the given files. 

To exchange an externally created XML file: 

Place the file in the \Out directory at the source location. ECM Exchange transfers the file to the 
\In\Rcvd directory at the target station. 

Data Encryption 
Each time you exchange data, ECM Exchange encrypts each file (on a per file basis) at the source 
station and decrypts each file at the destination station. 

ECM recognizes the current exchange direction and either encrypts or decrypts the data 
accordingly.  
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Internet Communication 
Internet is the recommended method for communication. 

To select Internet as the communication device: 

1. In the Station Wizard: On the Station Details screen, select Internet as the communication 
method. If creating a station manually: Select Internet in the Preferred Device field. 

2. Enter the target station's IP Address. This can be a static IP Address, or a DNS (Domain 
Naming Service) that resolves to an IP Address. 

 

 

 

 

 

 

 

 

 

 

When necessary, ECM uses the network options within your operating system. Consult your 
operating system's documentation for configuration information. 

To access Network Settings: 

1. Select Options from the top menu of the ECM Home Screen. 

2. Select a station, then select Network Settings from the side menu.    
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Modem Communication 

To communicate using a modem, you'll need to: 

1. Set up an RAS connection in Windows. 

2. Set up a Windows user. 

Two levels of authentication are required when communicating by modem. Each station must be 
in the other station's address book, and have the correct login name and password defined in each 
computer's Windows modem settings. The second level of authentication is the standard matching 
login name and password that must be defined in each station's record. 

To select Modem as your communication device: 

1. In the Station Wizard: On the Station Details screen, select Modem as the communication 
device. If creating a station manually: Select Modem in the Preferred Device field. 

2. Enter a Phone Book Entry. Select   to display the Polling Phone Book dialog. Select a 
phone book entry, and then select OK. (See Windows documentation for setting up Phone 
Book entries.) 

 

 

 

 

 

 

 

 

 

 

When necessary, ECM uses the modem and dial-up options within your operating system. 
Consult your operating system's documentation for configuration information. 

To access modem settings: 

1. Select Options from the top menu of the ECM Home Screen. 

2. Select Modem Settings from the side menu.   
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Disk Communication 
ECM allows you to transfer data from a Retail Pro 8 installation to a Retail Pro 9 installation 
located on a local or network drive. The procedures below describe how to set up disk 
communication, as well as how to initiate a communication cycle. 

Note: The procedure below assumes that you already installed ECM as part of your Retail Pro 9 
installation. The Retail Pro 9 installation of ECM is referred to as the "original" ECM installation 
throughout this topic. For more information, see Installing ECM.  

Set Up Your System for Disk Communication 

Create a New ECM Installation Folder 

1. Create a new folder on your computer called ECM_Exchange. 

Note: You can give your new folder a different name if you prefer. 

2. Copy all the files (except ECMExchange.exe) from your original ECM installation and paste 
them into your new ECM_Exchange folder. 

Configure Your 9-Series Installation 
Set Workstation Preferences 

1. Launch your original ECM.  

2. Select Options > WS/Preferences, 
then select General > Setup on 
the left menu.  

3. Enter the Station Name (host 
name of the workstation on 
which Retail Pro is installed). 

4. Select Oracle under Installation 
Type & Path. 

5. Select RPROODS as the 
database. 

6. Adjust the Communication 
Details, as needed. 

7. Click OK to exit preferences.  
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Create a Station Profile 
Reference: See Creating a Station. 

1. From the Home Screen, click Stations on the top menu. 

2. Select a Subsidiary from the drop-down list. 

3. Click New, then click Form View (<Alt+V>). 

4. Enter General station information. 

 

 

 

 

5. Enter Communication details. 

Station Type The type of station with which ECM will be communicating. 

Example: Main (RPRO 8x) 

Preferred Device Disk 

Deliver Files To Path to secondary ECM Process Out files: 

Example: C:\ECM_Exchange\Polling\XXXXXXX\IN\RECVD 

Note: XXXXXXX is the subsidiary number followed by station number. 
For example, subsidiary 1 that is MAIN would have the folder name 
0010000. 

Pick Up Files From Path to secondary ECM Process In files: 

Example: C:\ECM_Exchange\Polling\XXXXXXX\IN 

Note: XXXXXXX is the subsidiary number followed by station number. 
For example, subsidiary 1 that is MAIN would have the folder name 
0010000. 

Host Name/IP 
Address 

Leave blank, or enter the host name of the station. 

Login Name Retail Pro system login name.  

Password Retail Pro system password. 
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6. Adjust the Checklist details, as needed. 

7. Click Save, then exit ECM. 

 

Configure Your 8-Series Installation 
Set Workstation Preferences 

1. Launch ECM from your new ECM_Exchange folder. 

2. Select Options > WS/Preferences, then select General > Setup on the left menu.  

3. Enter the Station Name (host name of the workstation on which Retail Pro is installed). 

4. Select Retail Pro (BTF) under Installation Type & Path. 

5. Enter the subsidiary number and name, and specify the Retail Directory.  

Note: The Retail Directory is the path to the Retail Pro 8-Series installation. 

 

 

 

 

 

 

 

6. Adjust the Communication Details, as needed. 

7. Click OK to exit preferences.  

Create a Station Profile 

1. From the Home Screen, click Stations on the top menu. 

2. Select a Subsidiary from the drop-down list. 

3. Click New, then click Form View.  

4. Enter General station information. 
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5. Enter Communication details.  

Station Type Enterprise (Oracle) 

Preferred Device Disk 

Deliver Files To Path to the original ECM Process Out files: 

Example: C:\ECM\Polling\XXXXXXX\IN\RECVD 

Note: XXXXXXX is the subsidiary number followed by station number. 
For example, subsidiary 1 that is MAIN would have the folder name 
0010000. 

Pick Up Files From Path to the original ECM Process In files: 

Example: C:\ECM\Polling\XXXXXXX\OUT 

Note: XXXXXXX is the subsidiary number followed by station number. 
For example, subsidiary 1 that is MAIN would have the folder name 
0010000. 

Host Name/IP 
Address 

Leave blank, or enter the host name of the station. 

Login Name Retail Pro system login name.  

Password Retail Pro system password. 

 

 

 

 

 

 

 

 

 

6. Adjust the Checklist details, as needed. 

7. Click Save, then exit ECM. 

 



  Retail Pro® Enterprise Communication Manager (ECM™) 
 

© 2011 Retail Pro International, LLC All rights reserved. 
117 

Set Network Security Preferences 
When communicating data across shared network resources (disk communication), you need to 
define your network user credentials in ECM Workstation Preferences. Entering this information 
allows ECM to know the correct mapped network drives to use during disk communication. 

To enter network user credentials 

1. Select Options > Workstation Preferences from the ECM Home Screen. 

2. Select General > Network Security. 

3. Click the Allow ECM Exchange to copy files from a mapped drive checkbox. 

4. Enter your Windows Username and Password, and select your network Domain. 

Note: The username and password you enter must have access privileges to any mapped 
drives or folders that ECM may use during disk communication. 

5. Click OK on the side menu. 

Password Changes 

If you change your network password, be sure to also enter the new password in ECM 
Workstation Preferences, or communication errors may result. 

Network Resource Assignment 

Ensure that the account assigned within ECM is also assigned to all Retail Pro 9-Series resources 
and folders. In a multi-main server environment, each \RetailPro9 folder for each Retail Pro 
installation must have this account assigned with full access privileges.  
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Send Data From Retail Pro 8 to Retail Pro 9 
To communicate data between your 8-Series and 9-Series installations, follow the three-part 
procedure below. 

Part 1: Process Out From RP8 Command Prompt 

1. Launch your Retail Pro 8 ECM installation.  

2. From your Windows Task Bar, select Start > Run.  

 
3. Type cmd, then click OK to launch a command prompt. 

4. Type cd c:\ecm_exchange, then press <Enter>. 

Note: The "c:" in the command line shown above represents the letter assigned to your local 
drive. If your ecm_exchange folder is not located on your local drive, replace the "c" with the 
appropriate drive location. 

5. Type ecmproc -out -show -a and press <Enter>.  

Note: Leave the command prompt window open; you will return to it in Part 3 of the 
procedure. 
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The following screens display. 
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Part 2: Process In and Out from RP9 ECM 

1. Launch your Retail Pro 9 ECM installation.  

2. Click Stations, then click Send/Receive. 

Result: The ECM Exchange dialog displays. XML documents are placed into the Deliver Files 
To location you specified in the station record.  
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3. When the send/receive is complete, click Process In. 

Result: A dialog displays the data being processed in.  

 
4. When the process-in is complete, click Process Out.  

Result: A dialog displays the data being processed in. 

5. When process-out is complete, click Send/Receive. 

6. Exit ECM. 
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Part 3: Process In from RP8 Command Prompt 

1. Return to your command prompt (see Part 1: Step 2).  

2. Type ecmproc -in -show -a and press <Enter>.  

The following screens display. 

 

 
Suggestion: When all three parts are complete, launch Retail Pro and verify that the data was 
imported successfully.  
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Setting Termination Time for Data Streaming 
ECM can be used for constant updating of stores and back office locations, a process known as 
data streaming. When using ECM for constant updating of stores and back office, if ECM 
becomes hung or frozen, processing does not complete and all subsequent processing sessions fail 
because the system is handling the station in the hung session.  

To avoid this situation, technicians can create an .ini file that includes a hidden switch that will 
terminate the session after a specified number of minutes. To set a termination time for ECM 
processing, create a text file called EcmProc.ini in the same folder where EcmProc.exe is located, 
and enter the following lines: 

 

[ECM_ORA] 

TerminateAfterMins= 

 

After the equals sign, enter a numeric value for the number of minutes, as shown in the 
illustration below: 

 

 

 

 

 

 

 

 
The “TerminateAfterMins” indicates how many minutes EcmProc is allowed to run (counted 
from the moment when EcmProc starts). If after the specified number of minutes ECMProc.exe is 
still running, it will be terminated. Whatever log information has been accumulated so far will be 
gathered and the following message will be displayed:  

“error code -3: Process was terminated by watchdog timer.” 

Notes: 

 The option is disabled (off) by default. 

 There is no UI interface to set the option; you must create the ECMProc.ini file 

 This option is only available for EcmProc running on Oracle 11g, and ONLY if that 
switch is set in the EcmProc.ini file.  

 Removing the TerminateAfterMins switch or setting it to 0 (or negative) will turn off the 
option. 

 The minimum allowed setting is “5” for five minutes; integers only, no fractions or 
decimal values. Values below 5 default to five minutes. There is no upper limit. 
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FTP Communication 
You can use ECM to communicate Retail Pro data files via an FTP site.  

Preferred Device - FTP 

To communicate via an FTP site, select FTP 
in the Preferred Device field for the station.  

FTP Passive Mode 

FTP can be run in active or passive mode. You can control which mode is used 
via the FTP Passive checkbox.  

If the FTP Passive checkbox is selected, the client sends a PASV command to the server and 
receives and IP address and port number in return. This method is used when the client is behind 
a firewall and unable to accept incoming TCP connections. 

If NOT selected, the client sends the server the IP address and port number on which the client 
will listen, and the server initiates the TCP connection.  

Changing Default Port Number 

When using ECM to communicate with an FTP site, you will typically need to change the port 
number. The default port number used by ECM is 2000. For FTP communication, you will 
typically want to use port 21.  

To change the port number, you need to add the 
Port Number field to the screen layout for the FTP 
station. To add the Port Number field, right-click in 
an empty area of the screen and select Interface > 
Page Designer.  

A dialog is displayed with functions for changing the appearance of the user interface. 

Click the Fields button. The Setup Fields dialog is displayed. Select the Communication 
group. Add the Ftp Passive and Port Number fields to the Communication group and save. 

 

 

 

 

 

 

 

 

 

 

Important! Be sure to select appropriate and DIFFERENT folders in the “Deliver Files To” and 
“Pick Up Files From” fields. These should be folders on the FTP SERVER. 



  Retail Pro® Enterprise Communication Manager (ECM™) 
 

© 2011 Retail Pro International, LLC All rights reserved. 
125 

Initialization/Regeneration 
Initializing Stations 
Initialization sends all selected data types, including any associated images, to a station for the 
selected data range. Initialization is useful for helping a station get started or recover from a hard 
disk failure. 

To initialize a station:  

1. Click Stations on the top menu of the ECM Home Screen. 

2. Click Regenerate on the side menu.  

Result: The Regeneration/Initialization dialog displays. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select Initialize Station(s). 

4. In the Stations field, click  to display the Station Selection dialog box. Check the box next 
to each station that you want to initialize, then click OK. 

5. Click  to display the Data Area Selection dialog box. Select All to include all data types, or 
check the box next to each individual data type you want to include. Click OK to close the 
dialog box. 

Initialization By Sending All Data for Each Data Type 
It is possible to initialize a station simply by selecting All for all data types, but using the 
Initialize feature lets you do it without altering a station's existing Profile Checklist. 
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Skip Inactive Inventory 
During initialization, you can select to skip inactive inventory item. If the Skip Inactive Inventory 
checkbox is selected, EcmProc will NOT export inactive inventory items, and instead will auto-
confirm them inside of the database. You can use this function to prevent inactive items from 
being processed out during initial proc-out.  

Important! For Initialization Only 

The Skip Inactive Inventory checkbox should only be selected for initialization. The checkbox 
should then be cleared and left UNCHECKED during regular polling. 

 

 

 

 

 

Regenerating History 
If you have a hard disk or other data problem at a station, you can regenerate history documents 
and send them to the affected station. For example, if a Remote station's sales history file is 
damaged, you can regenerate sales history for that station. You can select which history 
documents to send to a station.  

When received at the destination station, the SIDs (system identifiers) of the incoming documents 
are compared against those already on file. In the case of duplicates, the older copy is 
automatically discarded. 

1. Launch ECM and then select Stations from the ECM Home Screen. The list of stations 
displays. 

2. Select a station from the list and then click Regenerate. The 
Regeneration/Initialization dialog box displays. 
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3. Select a Regeneration Method. 

Select Regenerate only documents made at target station to send only those documents that 
were created at the target station. 

OR 

Select Regenerate documents made at all stations to send all documents, regardless of where 
they were created. 

4. Select the document types you want to send: Receipt, Vouchers, Transfer Slips, and/or 
Adjustment Memos. Any document types that are not selected will not be sent. 

5. Select a document date range. 

Select a starting year, and then select a starting month. 

6. Select  to display the Station Selection dialog box. Select the station(s) to which you want 
to send history documents, then click OK. 

7. Click OK to close the Regeneration/Initialization dialog and start the regeneration. 
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Movelists 
About Movelists 
A movelist is a set of instructions that ECM uses to move a file and/or folder from one location to 
another. The move occurs during ECM communication.  

A movelist is a convenient way to communicate files — such as updated security files or a 
document listing promotional activities for the week — from one station or store to another 
within the company. 

Note: If you send an application file as part of a movelist, the application cannot be running 
during the move. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Target Station Path 
Before using movelists, you must define the path to the target station's Retail Pro® 9-Series 
installation in ECM Workstation Preferences. 

If ECM cannot find the target path specified for a movelist, ECM moves the file/folder to an 
ECM sub-directory and makes an entry in the processing log. 

Movelist Files 
Each movelist is stored in a separate file. The name of each file is the name you enter when 
creating the movelist, with an .mvl extension added at the end of the file name.  

Example:MyMovelist.mvl 
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Movelist Templates 
Movelist templates are useful if you need to regularly send certain files from one location to 
another. You can re-use a template at any time to create additional movelists. 

To create a template: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Click Movelist. A list of movelist files for the selected station displays. You can select a 
different station, if necessary. 

3. Click Templates. The Movelist Template screen displays. 

4. Click New (<Alt+N>). The New Template dialog is displayed. 

 

 

 

 

 

 

5. Enter a Template Name, then click OK. 

6. Select your new template on the side menu, and then select Files & 
Folders. 

7. Click Add to display the Insert dialog. 

 
8. Select File or Folder, then click OK. 
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9. Browse to and select your file/folder, then click Open. 

Result: ECM fills in the template files and folders information.  
File 
Name 

The name of the file or folder. 

File Path 
The current location of the file or folder that you want to send. Click  to browse 
to the file/folder. 

File Type The type of file you are attaching. 

Target 
Type 

Where you want to send the file or folder. Select from the following options: 

 ECM Directory: Moves the file/folder to the \ECM\ folder. 

 Retail Pro® 9-Series Directory: Moves the file/folder to the 
\RetailPro9\ folder. 

 Retail Directory: Moves the file/folder to the target station's \Retail\ 
folder. 

 Retail Pro Directory: Moves the file/folder to the target station's 
\Retail\Rpro\ folder. 

 Other: Enter the path to the file/folder.  
 
Note: All relative paths are based on the ECM installation path. 

Target 
Path 

The path to the destination folder as defined in Workstation Preferences at the 
destination location. 

Note: When you create a new movelist or movelist template, you will not see the 
Target Path. The target path is filled in at the target location when ECM 
communication is performed. 

File Size The size of the file or folder. 

 

10. Change the Target Type field, if necessary. 

11. Click Save, then click OK. 
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Creating a Movelist 
There are two ways to create a movelist. 

 Create a new movelist when you plan to use the movelist only once. 

 Create a movelist using a template when you want to move files or folders on a regular 
basis.  

Reference: See Movelist Templates. 

To create a movelist: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Select the station for which you want to create a movelist. 

Note: If using Retail Pro in a multi-subsidiary environment, select a Subsidiary. 

3. Click Movelist on the side menu. 

4. Click New. A dialog is displayed for selecting the 
type of movelist you want to create. 

 Select Create New Movelist to create a new 
movelist for one-time use. 

 Select Create Movelist From Template to 
select a template from the drop-down list. 

5. Click Add to display the Insert dialog. 

6. Specify whether you are inserting a File or Folder, 
then click OK. 

7. Browse to and select your file/folder, then click Open. 

Result: ECM fills in the movelist files and target stations. 

8. Edit the movelist fields, as needed. 

Field Description 

File/Folder 
Name 

The name of the file or folder that you want to send. 

File Path 
The current location of the file or folder that you want to send. Click  to 
browse to the file/folder. 

File Type Select the type of file you are sending. 
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Field Description 

Target Type Where you want to send the file or folder. Select from the following options: 

 Retail Pro 9-Series Installation: Moves the file/folder to the target 
station's \RetailPro9\ folder. 

 Retail Pro 8-Series Installation: Moves the file/folder to the target 
station's \Retail\ folder. 

 Retail Pro Installation: Moves the file/folder to the target station's 
\Retail\Rpro\ folder. 

 Other: Enter the path to the file/folder.  
 
Note: All relative paths are based on the target station's ECM 
installation path. 

Target Path The path to the destination folder as defined in Workstation Preferences at 
the destination location. 

Note: When you create a new movelist or movelist template, you will not see 
the Target Path. The target path is filled in at the target location when ECM 
communication is performed. 

File/Folder Size (Read-only) Displays the size of the file or folder that you are sending. 

9. Repeat Steps 5-8 to add additional files/folders to the list. 

10. In Movelist Target Stations, select the stations to which you want to send the file(s). 

11. Click Generate Movelist. 

Overwriting or Appending a Movelist 
When ECM generates a movelist, it checks the \Polling\Out\ folder for the intended station. If a 
movelist file is already in the \Out\ folder, ECM shows you the contents of that movelist. You can 
then select from the following options: 

 Append: Update the existing movelist with information from the new movelist - for the 
currently displayed station only. 

 Append All: Update the existing movelist with information from the new movelist - for 
all stations that have existing movelist files. 

 Overwrite: Delete the existing movelist and replace it with the new movelist - for the 
currently displayed station only. 

 Overwrite All: Delete the existing movelist and replace it with the new movelist - for all 
stations that have existing movelist files. 

 Ignore Station: The currently displayed station will not be included in the movelist (no 
change made to the movelist for the station). 

 Ignore All Stations: All stations that have existing movelist files are ignored (no change 
made to the existing movelist for all stations). 

Note: This check is only done against stationed defined in the new movelist. Any other stations 
that have movelist files are not affected. 
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Log Entry Created 

Creating a movelist for a given station automatically creates a log entry. An additional log entry 
is created to note the success or failure of the process in of a movelist file. 

 

Editing a Movelist 
You can edit an existing movelist. For example, you can add/remove files or folders and change 
the stations that will receive the movelist. 

To edit an existing movelist: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Select a station. 

Note: If using Retail Pro in a multi-subsidiary environment, 
select a Subsidiary. 

3. Click Movelist. A list of movelist files for the selected station 
displays. 

4. Select a station, then highlight the movelist you want to edit. 

5. Click Edit Exiting Movelist.     

6. Make your edits. 

7. Click Save. 

Deleting a Movelist 

To delete a movelist: 

1. Click Stations on the top menu of the ECM Home Screen. 

2. Select a subsidiary. 

3. Click Movelist on the side menu.  

4. Select a station, then highlight the movelist you want to copy. 

5. Click Delete.  

6. Click Yes to confirm the deletion. 

Deleting a Station Record 
If you delete a station record, movelist templates are automatically updated to remove that station. 
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Copying a Movelist 
A fast, easy way to create a new movelist is to copy an existing movelist that offers the closest 
match. 

To copy a movelist: 

1. Click Stations on the top menu of the ECM Home Screen. The list of stations displays. 

2. Select a station. 

Note: If using Retail Pro in a multi-subsidiary environment, 
select a Subsidiary. 

3. Click Movelist. A list of movelist files for the selected station 
displays. 

4. Select a station, then highlight the movelist you want to copy. 

5. Click Copy. A new movelist displays with the same information as the 
original. 

6. Edit the movelist fields, as necessary. 

Note: Click Add to add additional files/folders to the list. 

7. Click Save. 
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Logs and Alerts 
Processing Log 
The Processing Log is stored in \Polling\Log\EcmProc and provides the following information 
about each processing operation that your station performs: 

 The date/time the operation began 

 Its duration 

 Whether it was successful or an error occurred 

To view the Processing Log: 

1. Select View/Log from the ECM Home Screen.    

2. Click Processing Log.   

Result: A list of your processing logs displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select a log, then click View Log.  

Result the Log View dialog displays. 

4. Select the  to expand the log. When you are finished, click Close to exit the Log View 
dialog. 

Printing the Processing Log 
While viewing a log, you can click Print in the Log View dialog to print the log. 
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Purging of Processing Log 
ECM automatically purges Processing Logs based on the number of days you specify in ECM 
workstation preferences. 

Exchange Log 
The Exchange Log is stored in \Polling\Log\EcmExchange and provides the following information 
about each exchange that your station performs: 

 The starting and ending date/time of the exchange 

 The files that were sent 

 The workstation to which the files where transferred 

 Any errors that occurred 

To view the Exchange Log: 

1. Open the file manually using Notepad® or another word processing program. 

Purging of the Exchange Log 
1. The Exchange Log is automatically purged based upon the number of days you specify in 

ECM Workstation Preferences. 

 

Files 
ECM Directory Structure 
The table below provides descriptions of folders and files contained within the \ECM directory. 
  

ECM Folders Description 

 ECM Root folder 

   Documents Contains ECM Help files. 

   Layouts Contains ECM List View and Form View layouts. 

   Movelist Contains movelist files to be sent. 

     Templates Contains movelist template files. 

   Polling Polling directory 

     [Sub#+Store#] ECM creates a polling folder for each station you define. The folder consists 
of the subsidiary and the store number (e.g., 0010000 or 001A). 

       CRC ECM uses this folder to synchronize during a process out to ensure no files 
are missing, and to prevent duplicate information when sending differences 
only. 
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ECM Folders Description 

         CNF Contains confirmation files (BTF only). 

       In Main folder for files received 

         Partial Contains partially received files (if transmission is interrupted). 

         Recvd When ECM Exchange successfully moves files from the other computer’s 
\Out directory into the local computer’s \In directory, the files are copied to 
\In\Recvd to await processing. 

       Out Contains files ready to be sent. 

         Sent When ECM Exchange successfully moves files from the local \Out directory 
to the other computer's \In directory, the files are copied to the \Sent 
directory, and then deleted from the \Out folder. 

       Proc Contains compressed (Proc\Out) and decompressed (Proc\In) files during 
communication. The Proc folders are the first and last location of files as they 
move out of one database and into the other. 

       Temp When process in is requested, files in the \In\Recvd directory are moved, one 
by one, to the \Temp directory for processing. This allows another Exchange 
to occur and write new or updated XML information to the \In\Recvd directory 
while processing is taking place. 

     Log Contains ECM log files. 

       ECMProc Contains Processing Log files. 

       
ECMExchange 

Contains Exchange Log files. 

   Profiles Contains ECM Profile files (.prf). 

   SecAdmin Contains Security Administrator (SecAdmin.exe) program files. 

   Translat Contains translation files. 

   Web Contains image files used by ECM. 

Confirmation Files 
When processing in data, ECM creates confirmation files to ensure that data is successfully 
received at a given target station. Confirmation files are created for each of the primary data types 
and list all SIDs for the given data type that were processed in successfully. 

Confirmation files are placed in the station's \Polling\Out directory so that they can be sent back to 
(and processed in at) the station from which they were originally sent. 

Records are marked transmitted only when confirmation files are processed in at the station that 
originally sent the records! Therefore, when communicating data from 8 Series to 9 Series, it is 
important that the final steps be: 

 Run Send/Receive at the 9 Series (Oracle) Main or Enterprise (EMS) station. This moves 
the confirmation files from the 9 Series station's \Out folder to the 8 Series station's 
\In\Recvd folder. 

 Run EcmProc.exe (process in) at the 8 Series (BTF) station. This processes in the 
confirmation files and marks the appropriate records as transmitted. 
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If you don't send the confirmation files back to the 8 Series (BTF) station and process them in, 
then the next time that you send data from 8 Series to 9 Series, ECM will resend those records 
because they have not yet been marked transmitted. In other words, you will keep sending those 
data records again and again, and will be unable to send differences only. 

Data Types Requiring Confirmation 
The only data types that require confirmation are those that can be sent as differences, i.e., if the 
AllowedTransOptions field in the XML includes [ToDiff] as one of the options. The following 
table lists those data types and related information. 

Reference: For a full list of DOC_TYPE values used in the DOC_SYNC tables, see Appendix B. 

Data Type DOC_TYPE Value Confirmation File Comments 

Customer 36 Customer.cnf  

Inventory 49 Inventory.cnf  

Invoice 50 Invoice.cnf  

Adjustment memo 51 Adjustment.cnf  

Slip 52 Slip.cnf Verified/Unverified 

Vendor Invoice 53 VendInvoice.cnf  

Vouchers 54 Voucher.cnf Regular/Pending ASN 

TOs 55 TO.cnf  

SO 56 SO.cnf  

PO 57 PO.cnf Pending POs do not require confirmation 

MO 58 MO.cnf  

MN 59 MN.cnf  

Markdown 60 Markdown.cnf  

Store Sales Target 62 StoreSalesTarget.cnf  

Employee Sales 
Target 

63 EmployeeSalesTarg
et.cnf 

 

DCS Sales Target 74 DCSSalesTarget.cnf  

ZOut 75 Zout.cnf  

Pending APR 80 PendingAPR.cnf  

Sub Location Qty 84 SubLocQty.cnf  
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Appendix A: Preferences by PREF_ID 
and PREF_TYPE 
The following table lists each preference communicated by ECM, along with the PREF_ID and 
the PREF_TYPE assigned. 

PREF_ID PREF_NAME PREF_TYPE

0 Use Clerk Codes 252 

1 Encrypted passwords for levels 1 5 

2 Encrypted passwords for levels 2 5 

3 Encrypted passwords for levels 3 5 

4 Encryption coding scheme for use on price tags 5 

5 ID number on/off 252 

6 Allow items in PO regardless of supplier code 252 

7 GM is modified it affect cost instead of price 252 

8 On how many rows extend inventory file 3 

9 Number of inventory rows used (may be smaller than file size) 3 

10 TRUE=>average the cost using the entire family 252 

11 TRUE=>default is the received date of inventory 252 

12 Number of stores in company (excluding StoreBR) 3 

13 Number of price decimals for viewing purposes 3 

14 Ask for password when creating slip 252 

15 Monitors changes in vendor to transmit it 252 

16 Monitors changes in dept to transmit it 252 

17 PO and Voucher Fee names 110 

18 Default PO Instruction1 5 

19 Default PO Instruction2 5 

20 Default PO Instruction3 5 

21 Default PO Instruction4 5 

22 Default PO Instruction5 5 
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PREF_ID PREF_NAME PREF_TYPE

23 Use last cost in creating PO 252 

24 Number of price decimals used in reports 3 

25 Automatic Customer Discounting 252 

26 Credit Card names 110 

27 Invoice Fee names 110 

28 Discount Reason names 110 

29 True <=> at POS qty defines the price to use 252 

30 Price levels descriptions 110 

31 Use decimal places for qty values throughout Rpro 252 

32 Use decimal places for qty values in reports 252 

33 AutoSlip genration (0 = send o/h, 1 = send ordered, 2 = optimize) 3 

34 Use price levels set in stores setup 252 

35 Clerk code must be entered for each invoice 252 

36 Clerk code must be entered for each voucher 252 

37 Clerk code must be entered for each slip 252 

38 Style Definition 3 

39 Define how to set cost and price to new item in UI 3 

40 How to generate style line 3 

41 Markdowns: keep original price in mkdn 252 

42 Auto update vouchers for EE documents 252 

43 Currency symbol. defaults to $ 5 

44 TRUE=>currency_sym before amount 252 

45 Price Adjusting 110 

46 Precision for VAT 3 

47 Invoice UDFs 110 

48 Price levels Rounding 110 

49 Tax Codes 110 

50 Use Value Added Tax 252 
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PREF_ID PREF_NAME PREF_TYPE

51 How to calculate ExtPrice and tax in case of VAT 3 

52 Use InTransit 252 

53 Location of zip code in address 3 

54 Base Currency name 5 

55 Send out slips thru EE 252 

56 Update Inventory cost based on receiving document cost 252 

57 Requirement to record sale 3 

58 Order using cases only 252 

59 Use promotion prices 252 

60 Inventory UDFs 110 

61 Precision for taxes 3 

62 Tax Area Names 110 

63 Store Codes 110 

64 Allow input invoice total manually 252 

65 Coefficient type for margin calculation 3 

66 Send new customer thru EE 252 

67 Customer UDFs 110 

68 Vendor UDFs 110 

69 Default stores for documents 110 

70 Defines what actions create adjustment memos 3 

71 Comments are required on Adj 252 

72 Whether to Use 4 Digit Year - TRUE Means Use 4 Digit Year 252 

73 Clerk code must be entered for each Adj Memo 252 

74 Adjustment reasons 110 

75 After how many days purge ASNs 3 

76 Save store qtys in Adj 252 

77 TRUE: Margin% formula includes tax 252 

78 TRUE: Markup% formula includes tax 252 
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PREF_ID PREF_NAME PREF_TYPE

79 TRUE: Coefficient formula include tax 252 

80 Convert all data to uppercase in reports 252 

81 Inventory costing method 3 

82 Allow edit Cust IDs 252 

83 Display field Note in SO 252 

84 Show Note field in some documents 3 

85 What Invoice/SO flags (UDFs) are required 3 

86 Allow spread global discount in SO and Invoice 3 

87 Use EURO currency symbol 252 

88 Display DCS segmented 252 

89 Store Regions 110 

90 Use allocation patterns in multi store PO 252 

91 Allow to create voucher after PO cancel date 252 

92 What use as as base for Voucher reporting - Create or Post date 3 

93 Allow duplicate Cust IDs 252 

94 Use Trade disc for Order Cost 252 

95 Decimals for Invn Cost 3 

96 Decimals for Report Cost 3 

97 Allow Intransit complete XFer 252 

98 Fill reversed doc by former date 252 

99 Poll Proc Del Mrkd ASN 252 

100 Field Length 110 

101 Sub/Store combinations for InterCompany Slips 110 

102 Main store 3 

103 Main station (A Remote's Station char) 5 

104 Field Location after each invc: 0=Menu 1=BillCust 5=Cashier 6=Body 3 

105 Is store POS or not 252 

106 Use the last shipping percent again 252 
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PREF_ID PREF_NAME PREF_TYPE

107 Allow foreign currency to be used 252 

108 Whether shipping percent includes tax 252 

109 Credit card is a default tender 252 

110 Only sell an item if it's inven qty > 0 252 

111 Defines remote capability 252 

112 Is Rpro being run on a 4694 252 

113 Right to use network 252 

114 Allow customer pooling 252 

115 Adopt a default price after polling 252 

116 Price to be adopted as default after polling 3 

117 Number of days for shipping by default 3 

118 Number of days before order is cancelled by default 3 

119 Process POs from remotes 252 

120 Process SOs from remote 252 

121 Whether EDI is used 252 

122 Accumulate discount 252 

123 Source of orig price 3 

124 Shipping % by default 4 

125 Invoice comments 110 

126 Show store credit to customer 252 

127 Accept checks 252 

128 Shipping methods 110 

129 Show backorder message 252 

130 Backorder message 5 

131 Default shipfrom store (duplicate default stores???) 3 

132 Default ShipFrom station 5 

133 Default ship method 5 

134 Price rounding method 3 
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135 Use price rounding 252 

136 Rounding method for Price Mardown 3 

137 Use Markdown price rounding 252 

138 Target store for SO 3 

139 Target Station for SO 5 

140 Do Not Allow Deleting Invoice Items 252 

141 Require Customer on Return Invoice 252 

142 Circumstances when create special documents 3 

143 Purge SO delay 3 

144 Suggest Store Credit 252 

145 Require comments on Slips 252 

146 Allow edit Tax Code on POS document 252 

147 Check Available Store Credit 252 

148 Round foreign currency to 4 

149 Allow update Inventory price from Voucher price 252 

150 Accept checks in documents 3 

151 Do not accept negative qty in POS documents 252 

152 Allow tax rebate 252 

153 Tax Rebate percent 4 

154 Minimum tax rebate 4 

155 Default SO Instructions 110 

156 Default SO comments 110 

157 PO purge delay 3 

158 Ignore Min/Max Locking in Inventory 252 

159 Use Invoice term by default 252 

160 XZ out report is required manual enter of bills count 3 

161 XZ report purge delay 3 

162 Whether UpdateOnly options is availabel for Invoices 252 
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163 Default Process at Stations for SO 110 

164 Limit items in document created from SO only by SO items 252 

165 COD tender name 110 

166 Rounding level for base currency 3 

167 Rounding method for base currency 3 

168 How to share customers 3 

169 Default Commission Code 3 

170 Use zip lookup for customers 252 

171 Zip lookup mask 5 

172 Auto polling end POS inventory 252 

173 Min perc of SO deposit for Customer Order 3 

174 Min perc of SO deposit for Special Order 3 

175 Min perc of SO deposit for Layaway 3 

176 Comments are required on Voucher 252 

177 Allow duplicate ALU 252 

178 Item Sid source 3 

179 Number of symbols from ALU or UPC for Style Sid generation 3 

180 Where ALU is copied (Desc1, Desc2) 3 

181 Use WS sequence for invoices 252 

182 Use WS sequnece for Vouchers 252 

183 Use global sequence for Invoices 252 

184 Use global sequence for Vouchers 252 

185 Voucher comments 110 

186 Slip comments 110 

187 Info field is requred for Adj 252 

188 Poll new customers 252 

189 Use sequence for store credit 252 

190 Hide store credit in documents 252 
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191 Use sequence for gift certificates 252 

192 Style Sid source 3 

193 Check Credit card refund 3 

194 Chars ignored during Item Sid gen 3 

195 Check PO for Voucher items 252 

196 Check TO for Slip items 252 

197 Check Out Slip for In Slip items 252 

198 Check SO for Invoice items 3 

199 Currencies and Rates 110 

200 Customer and Vendor Titles 110 

201 Discount Schedule 110 

202 Commission Schedule 110 

203 Time Shifts 110 

204 Employees 110 

205 Inventory Scales 110 

206 Default Foreign Currency 5 

207 Use Thousand Separator For Quantity 252 

208 Use Thousand Separator For Currency 252 

209 Use Currency Symbol 252 

210 Import new Inventory Items 252 

211 Import Inventory Images 252 

212 Import Vendors 252 

213 Import Departments 252 

214 Import Min/Max 252 

215 Import Prices 252 

216 Import Allocation Patterns 252 

217 Import Customers 252 

218 Import Customer Images 252 
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219 Import Zip Codes 252 

220 Import History Documents 252 

221 Import ASN 252 

222 Import SO 252 

223 Import TO 252 

224 Import PO 252 

225 Import MO/MN 252 

226 Import Archived Orders 252 

227 Update Global Customers 252 

228 Update Global Inventory Items 252 

229 Synchronize Vendors 252 

230 Synchronize Departments 252 

231 Synchronize Inventory Images 252 

232 Synchronize Inventory Qty and Cost 252 

233 Synchronize Audited Documents 252 

234 Synchronize Min/Max 252 

235 Synchronize Inventory Prices 252 

236 Synchronize Allocation Patterns 252 

237 Synchronize Customers 252 

238 Synchronize Customer Images 252 

239 Synchronize Vouchers 252 

240 Synchronize ASN 252 

241 Synchronize SO 252 

242 Synchronize TO 252 

243 Synchronize PO 252 

244 Synchronize Adjustments Qty 252 

245 Synchronize Adjustments Price 252 

246 Synchronize Adjustments Cost 252 
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247 Synchronize Slips 252 

248 Document date mode for Delta 3 

249 Encrypt Price for Tag printing 252 

250 Encrypt Cost for Tag printing 252 

251 Encrypt Last Received Date for Tag printing 252 

252 Sort Options / Case Sensitive 252 

253 Sort Options / Use Locale 252 

254 Insert a blank line after each subtotal line 252 

255 Custom Labels / Names in Report 3 

256 Use decimals quantities in Report 252 

257 Number of price decimals to use in reports 3 

258 Number of cost decimals to use in reports 3 

259 Report Field Lenghts / Department 3 

260 Report Field Lenghts / Class 3 

261 Report Field Lenghts / Subclass 3 

262 Report Field Lenghts / Department Name 3 

263 Report Field Lenghts / Vendor Code 3 

264 Report Field Lenghts / Vendor Name 3 

265 Report Field Lenghts / Description 1 3 

266 Report Field Lenghts / Description 2 3 

267 Report Field Lenghts / Description 3 3 

268 Report Field Lenghts / Description 4 3 

269 Report Field Lenghts / Attr 3 

270 Report Field Lenghts / Size 3 

271 Report Field Lenghts / UPC 3 

272 Report Field Lenghts / ALU 3 

273 Report Field Lenghts / Aux 1 3 

274 Report Field Lenghts / Aux 2 3 
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275 Report Field Lenghts / Aux 3 3 

276 Report Field Lenghts / Aux 4 3 

277 Report Field Lenghts / Aux 5 3 

278 Report Field Lenghts / Aux 6 3 

279 Report Field Lenghts / Aux 7 3 

280 Report Field Lenghts / Aux 8 3 

281 Report Field Lenghts / Qty Fields 3 

282 Report Field Lenghts / Price/Cost Fields 3 

283 Report Field Lenghts / Ext Price/Cost Fields 3 

284 Report Field Lenghts / Discount Fields 3 

285 Report Header Font Name 5 

286 Report Header Font Size 3 

287 Report Header Font Style 3 

288 Report Header Font Color 3 

289 Report Header Font Charset 3 

290 Page Header Font Name 5 

291 Page Header Font Size 3 

292 Page Header Font Style 3 

293 Page Header Font Color 3 

294 Page Header Font Charset 3 

295 Column Headings Font Name 5 

296 Column Headings Font Size 3 

297 Column Headings Font Style 3 

298 Column Headings Font Color 3 

299 Column Headings Font Charset 3 

300 Details Font Name 5 

301 Details Headings Font Size 3 

302 Details Headings Font Style 3 
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303 Details Headings Font Color 3 

304 Details Headings Font Charset 3 

305 Totals Font Name 5 

306 Details Headings Font Size 3 

307 Details Headings Font Style 3 

308 Details Headings Font Color 3 

309 Details Headings Font Charset 3 

310 Fit To Preview 252 

311 WS Specific Voucher sequence 252 

312 WS Specific Invoice sequence 252 

313 Log of changes to Track Adjustments 110 

314 Backup Directory 5 

315 Use Vendor Invoices 252 

316 Use Two Step Approval 252 

317 Cost Variation Threshold 4 

318 Auto Retreive Ledger 252 

319 Taxable Threshold for Tax Area1 4 

320 Taxable Threshold for Tax Area2 4 

321 Eight Tax Codes Compatibility Mode 252 

322 Include 1st Tax When Calculating 2nd 252 

323 Tax Area Specific Tax Codes 252 

324 Use Multi Tax 252 

325 Audit Calendar 5 

326 Restrict EOP to Audit Calendar 252 

327 Show Item Number In Ledger Tree 252 

328 Show UPC In Ledger Tree 252 

329 Show ALU In Ledger Tree 252 

330 Use Thousand Separator for Quantities (Analytics) 252 
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331 Use Thousand Separator for Currency (Analytics) 252 

332 Use Currency Symbol (Analytics) 252 

333 Use 2 decimal places for qty values throughout Analytics 252 

334 Number of price decimals for viewing purposes (Analytics) 3 

335 Number of cost decimals for viewing purposes (Analytics) 3 

336 Synchronize Inventory Items and Kits 252 

337 Number of percentage decimals for viewing purposes (Analytics) 3 

338 Number of ratio decimals for viewing purposes (Analytics) 3 

339 When displaying week, show it as... (Analytics) 3 

340 How many days to store reports 3 

341 Spread Global Discount 252 

342 Number of last days to calculate DOS using DSR (0 means fixed periods) 3 

343 Ignore days when the Merchandise was out of stock 252 

344 Number of days back to detect changes for datamart refresh 3 

345 Maximum days to keep refresh logs 3 

346 Import Vendor Images 252 

347 Import Department Images 252 

348 Synchronize Vendor Images 252 

349 Synchronize Department Images 252 

350 Use database jobs for Delta build and post synchronization task 252 

351 Round Tax at Receipt and SO Level 252 

352 Tax rounding method for Receipts and SO 3 

353 Warning when new cost is greater than old 252 

354 New cost warning threshold percent 4 

355 Allow negative qty on Vouchers 252 

356 Case qty rounding method 3 

357 Lookup mode for listing items on documents 5 

358 Prevent Duplicate Customers Names 252 
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359 Document sequences 110 

360 Prompt for serial number when adding full control items on SO 252 

361 Prompt for serial number when adding partial control items on SO 252 

362 Prompt for serial number when adding partial control items on Receipts 252 

363 Prompt for serial number when adding partial control items on Vouchers 252 

364 Prompt for serial number when adding partial control items on Slips 252 

365 Prompt for serial number when adding partial control items on Adjustments 252 

366 Prompt for serial number when adding partial control items on Inventory 252 

367 Prompt for serial number when adding full control items on ASNs 252 

368 Default Serial Numbers Tracking Level 3 

369 PO Prefix 5 

370 Ledger Item Info 5 

371 Allow Overwrite Cust Title 252 

372 Allow Overwrite Vendor Title 252 

373 Tax Code Subtotal Calculation 252 

374 Default Inventory Store 3 

375 Default ASN Store 3 

376 Availability Checking for Return Vouchers 252 

377 Use Separate Sequences for Vouchers 252 

378 Require voucher to reference a PO 252 

379 Prompt for serial number when adding partial control items on ASNs 252 

380 Print Tags for Broken Kit Items 252 

381 Allow copying of prices and costs when copying items between subsidiaries 252 

382 Print Package Components on Receipts and SOs 252 

383 Print Package Components Prices on Receipts and SOs 252 

384 Print Kit Item on Receipts and SOs 252 

385 Print Kit Item Prices on Receipts and SOs 252 

386 Alert user when price differs from other style members 252 
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387 After voucher is updated go to 3 

388 Prevent negative cost entry 252 

389 Auto generate UPC 5 

390 Auto generate ALU 3 

391 Auto generate PO number 252 

392 PO Mask 5 

393 Enable UPC sequence 252 

394 Merchandise sequence rule type 5 

395 Enable ALU sequence 252 

396 Use Separate Sequences for Invoices 252 

397 Used PI type (Simple, Multizone, Multiztore) 3 

398 PI initialized by (UPC, or Item#, or ALU) 3 

399 Threshold cost for multizone report 4 

400 Use filters when start 252 

401 Strip lead zeroes when download 252 

402 Max. variance when autoupdate (%%) 3 

403 Use Smart smartscan mode 252 

404 Smart scan group 1 3 

405 Smart scan group 2 3 

406 Smart scan group 2 3 

407 Prompt to spread when going to tender 252 

408 Prompt to spread when saving SO 252 

409 Default value for POS flag menu 1 3 

410 Default value for POS flag menu 2 3 

411 Default value for POS flag menu 3 3 

412 Print Package Item on receipts and SOs 252 

413 Print Package Item price on receipts and SOs 252 

414 Print Kit Item on receipts and SOs 252 
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415 Print Kit Item price on receipts and SOs 252 

416 Tender Types used in rounding 3 

417 After update invoice go to 3 

418 Check charge balance 252 

419 Generate new system ID 252 

420 Tender display change window for 3 

421 Tender allow on return Receipt 3 

422 Default Comment 1 3 

423 Default Comment 2 3 

424 Require Min Percentage Customer Order 252 

425 Require Min Percentage Special Order 252 

426 Require Min Percentage Layaway Order 252 

427 Allow lost sale receipt when deleting unfilled SOs 252 

428 Append selected UDF/AUX fields to Inventory Description 2 field 252 

429 New inventory items enabled as Regional Inventory Items 252 

430 Regional Inventory Items 3 

431 Append blank spaces for field length if no value entered for UDF/AUX 252 

432 Allow negative quantities on POs 252 

433 Require Entry of Open and Close Amounts 252 

434 Allow Zero for Open Amount 252 

435 Register is Opened and Register is Closed 252 

436 Auto-Create Next Open 252 

437 Combine sales and tax for VAT 252 

438 X/Z-Out Reports Sort by 3 

439 Issue Gift Card when return amount exceeds 252 

440 Issue Gift Certificate when return amount exceeds 252 

441 Issue Store Credit when return amount exceeds 252 

442 Gift Card Exceed Amount 5 
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443 Gift Certificate Exceed Amount 5 

444 Store Credit Exceed Amount 5 

445 Expire Store Credit after Value 3 

446 Expire Store Credit after 252 

447 Expire Store Credit after Option 3 

448 Store Credit Offline floor limit 5 

449 Allow customer to reuse a Store Credit if a partial balance is available 252 

450 Store Credit Maximum Exceed by Amount 5 

451 Always issue Store Credit change on a new Store Credit 252 

452 Issue change on a Store Credit only if change amount exceeds 252 

453 Issue change on a Store Credit only if change amount exceeds value 5 

454 Suggest Store Credit ID numbers 5 

455 Expire Gift Card after Value 3 

456 Expire Gift Card after 252 

457 Expire Gift Card after Option 3 

458 Gift Card Offline floor limit 5 

459 Allow customer to reuse a Gift Card if a partial balance is available 252 

460 Gift Card Maximum Exceed by Amount 5 

461 Always issue Gift Card change on a new Gift Card 252 

462 Issue change on a Gift Card only if change amount exceeds 252 

463 Issue change on a Gift Card only if change amount exceeds value 5 

464 Suggest Gift Card ID numbers 5 

465 Use sequence for Gift Card 252 

466 Suggest Gift Card as a tender when available 252 

467 Allow Gift Card tender amount to exceed available credit 252 

468 Expire Gift Certificate after Value 3 

469 Expire Gift Certificate after 252 

470 Expire Gift Certificate after Option 3 
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471 Gift Certificate Offline floor limit 5 

472 Allow customer to reuse a Gift Certificate if a partial balance is available 252 

473 Gift Certificate Maximum Exceed by Amount 5 

474 Always issue Gift Certificate change on a new Gift Certificate 252 

475 Issue change on a Gift Certificate only if change amount exceeds 252 

476 Issue change on a Gift Certificate only if change amount exceeds value 5 

477 Suggest Gift Certificate ID numbers 5 

478 Suggest Gift Certificate as a tender when available 252 

479 Allow Gift Certificate tender amount to exceed available credit 252 

480 Use the Credit Card Gateway for all types 252 

481 Credit Card Gateway 5 

482 Debit Card Gateway 5 

483 Check Verification Gateway 5 

484 Gift Card Gateway 5 

485 Credit Card Workstation ID 5 

486 Debit Card Workstation ID 5 

487 Check Verification Workstation ID 5 

488 Gift Card Workstation ID 5 

489 Use POS Resiliency? (Credit Card only) 252 

490 Server to check 5 

491 POS Resiliency Floor Limit 4 

492 POS Resiliency Check Every 3 

493 POS Resiliency Check Every Option 3 

494 EFT Credit Card CVV2 / CVC2 / CID Verification Options 3 

495 EFT Credit Card AVS Verification Options 3 

496 EFT Credit Card Require Card Verification 252 

497 EFT Credit Card Verification Method 3 

498 EFT Credit Card Allow card information to be keyed in 252 
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499 EFT Credit Card Close Credit Card dialog on approval 252 

500 EFT Credit Card Automatically Update/Print after card approval 252 

501 EFT Credit Card Automatically start authorization after card swipe 252 

502 EFT Credit Card Allow clerk to force duplicate transactions 252 

503 EFT Credit Card Print EFT Receipt During Authorization 252 

504 EFT Credit Card Print EFT Receipt On Print/Update 252 

505 EFT Debit Card Allow Cashback 252 

506 EFT Debit Card Maximum Cashback Amount 4 

507 EFT Check Allow Cashback 252 

508 EFT Check Maximum Cashback Amount 4 

509 EFT Check Identification Verification 3 

510 XZ Out Report Script Langauge 3 

511 XZ Out Report Use Script 252 

512 XZ Out Report Script File 5 

513 XZ Out Require Register Level 252 

514 Use separate sequence for Multi/Single subsidiary PO 252 

515 Allow spreading of document fee across POs 252 

516 Require adjustment reason on inventory Price, Cost and Qty change 252 

517 Default adjustment reason on inventory Price, Cost and Qty change 3 

518 Default SO Comment 1 3 

519 Default SO Comment 2 3 

520 Default Instruction 1 3 

521 Default Instruction 2 3 

522 Use Seperate SO Sequence Numbers 252 

523 Default ASNs Lot Numbers Tracking Level 3 

524 Default Vouchers Lot Numbers Tracking Level 3 

525 Default Slips Lot Numbers Tracking Level 3 

526 Default Receipts Lot Numbers Tracking Level 3 
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527 Default Sales Order Lot Numbers Tracking Level 3 

528 Default Adjustments Lot Numbers Tracking Level 3 

529 Deactivate Lot Number once items have been depleted 252 

530 Print zero quantity items on receipts and SO 252 

531 Alert user when an item"s lot number expiration date has passed 252 

532 Block the sale of an item past its expiration date 252 

533 Audit Mode 3 

534 Audit Subclass 3 

535 Use Forward-Based Quantity Pricing 252 

536 Update PI counts on remote workstation 252 

537 XZ Require Blind Close 252 

538 XZ Allowable Number of Attempts 3 

539 XZ Allowable Reconcile Variance Amount 3 

540 Use workstation specific Receipt sequence numbers 252 

541 Use workstation specific SO sequence numbers 252 

542 Use workstation specific Voucher sequence numbers 252 

543 Use workstation specific Slip sequence numbers 252 

544 Use workstation specific Adjustment Memo sequence numbers 252 

545 Provide No Flag on Documents 252 

546 Use the last Flag on documents 252 

547 Target sbs_no for currency conversion in Planning Link 3 

548 Desc1 length for Planning Link 3 

549 Desc2 length for Planning Link 3 

550 Calendar Level for Planning Link 3 

551 Time Level for Planning Link 5 

552 Filter Level for Planning Link 3 

553 Default filter for Planning Link 3 

554 Update delta table flag for Planning Link 3 
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555 Location Level for Planning Link 5 

556 Product Level for Planning Link 5 

557 Use Workstation Specific Store Credit Sequence Numbers 252 

558 Use Workstation Specific Gift Certificate Sequence Numbers 252 

560 PI flag - Include Lot/Serial number entry in count 252 

561 PI flag - allow PI update with discrepancies 252 

562 Use Style AUX/UDF values 3 

563 Planning Link use PO Dates 3 

564 Planning Link Archive to the Log file flag 252 

565 Planning Link Purge Period 3 

566 Planning Link Log File path 5 

567 Copy Description to ALU 3 

568 Default maximum discount allowed for new items 3 

569 Default maximum accumulated discount allowed for new items 3 

570 Item Note Map Assigned To 1 5 

571 Item Note Map Assigned To 2 5 

572 Item Note Map Assigned To 3 5 

573 Item Note Map Assigned To 4 5 

574 Item Note Map Assigned To 5 5 

575 Item Note Map Assigned To 6 5 

576 Item Note Map Assigned To 7 5 

577 Item Note Map Assigned To 8 5 

578 Item Note Map Assigned To 9 5 

579 Item Note Map Assigned To 10 5 

580 Force User to select Associate on new receipt 252 

581 Force User to select Associate on new Sales Order 252 

582 High security on Receipts 252 

583 High security on Vouchers 252 
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584 High security on Transfer Slips 252 

585 High security on Adjustments Memos 252 

586 Default associate for new receipts 3 

587 Default associate for new SO 3 

588 Customer Security Level 1 5 

589 Customer Security Level 2 5 

590 Customer Security Level 3 5 

591 Customer Security Level 4 5 

592 Default Customer Security Level 3 

593 Default Price Level 3 

594 Flag incoming voucher as pending 252 

595 Transfer Order Number 252 

596 Require Item void reasons 252 

597 Default Item void reasons 3 

598 Require Item return reasons 252 

599 Default Item return reasons 3 

600 Regional Dept Unique Ident 3 

601 Regional Vendor Unique Ident 3 

602 New department enabled as Regional Departments 252 

603 New vendors enabled as Regional Vendors 252 

604 Regional Vendor Fields 3 

605 Disbursement Options 110 

606 Use Document Sequences on Security Receipts 252 

607 Default Customer Type 3 

608 Limit items in document created from PO only by PO items 252 

609 First Column for Item Allocation Grid in TOs 3 

610 Copy DOC Price to new inventory items 252 

611 Copy DOC Cost to new inventory items 252 
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612 Mark all new inventory Items as Proposed 252 

613 Mark new PO Items as Proposed 252 

614 Use Exchange Rate when propagating Price to child subsidiaries 252 

615 Round Price conversion 252 

616 Round Price 3 

617 Use Exchange Rate when propagating Cost to child subsidiaries 252 

618 Round Cost conversion 252 

619 Round Cost 3 

620 Include Inactive Stores in Planning 252 

621 Auto Promotions 252 

622 Require original receipt entry for return receipts 252 

623 Customer Lookup By 5 

624 Calculate Check Digit 252 

625 Display Check Digit 252 

626 Centrals Active Flag 252 

627 Address of Centrals Server 5 

628 Port for Centrals Server 3 

629 Lookup Mode 252 

630 Centrals Timeout 3 

631 Centrals Max Records 3 

632 Copy received quantity from original quantity on ASN voucher 252 

633 Use Seasonal Pricing 252 

634 Allow Level 2 Credit Card Processing 252 

635 Prompt for price on zero price items 252 

636 Quickbooks Company File Path 5 

637 Quickbooks Company 5 

638 AL Subsidiary Number 3 

639 Use Stock Audit 252 
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640 Use sales transaction information 252 

641 Sales Method 3 

642 Sales Retail Pro Address 1 3 

643 Sales Retail Pro Address 2 3 

644 Sales Retail Pro Address 3 3 

645 Split Customer City/State 252 

646 Customer and Contact Names 3 

647 Order to Send Customer Name to Quickbooks 3 

648 Include information in receipt comment 3 

649 Use external default terms 252 

650 Invoice due date 3 

651 Auto export customers 252 

652 Credit limit 4 

653 Update customer balances 252 

654 Write aging code to past due days field 252 

655 Discounted transactions 3 

656 Use receiving transaction information 252 

657 Receiving Method 3 

658 Receiving Retail Pro Address 1 3 

659 Receiving Retail Pro Address 2 3 

660 Receiving Retail Pro Address 3 3 

661 Vendor and Contact Names 5 

662 Order to Send Vendor Name to Quickbooks 3 

663 Include what information in voucher comment 3 

664 Auto-Update Vendors 252 

665 Send Retail Pro terms to QuickBooks 252 

666 Advance End Of Month to the next month 3 

667 Purchase Clearing 3 
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668 Use adj/trans information 252 

669 Adj/transfer Method 3 

670 Consolidate General Ledger accounts by 3 

671 Main account length 3 

672 Using account #s on COA 252 

673 Map store # to QB class 252 

674 Length for Sub-Account 1 3 

675 Sub-account 1 based on 3 

676 Merch Sales for Sub-Account 1 252 

677 Merch Disc for Sub-Account 1 252 

678 Inventory for Sub-Account 1 252 

679 Cogs for Sub-Account 1 252 

680 Primary Account (Department) 5 

681 Choose Store Sales Account Mapping 3 

682 Primary Account (Vendor) 5 

683 Choose Store All Receiving Account Mappings 3 

684 Primary Account (Discounts) 5 

685 Choose Store All Adj Transfer Account Mappings 3 

686 Primary Account (Inventory UDF1) 5 

687 Choose Store Suspense 3 

688 Primary Account (Inventory UDF2) 5 

689 Do Not Consolidate Like Items on Documents 252 

690 Include Inactive DCS in Planning 252 

691 Include Inactive Vendor in Planning 252 

692 Include Inactive Items in Planning 252 

693 Ecommerce default price level 3 

694 Ecommerce default sale price level 3 

695 Viewable Custom Files 5 
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696  Fill Formulas for Web Product Name 5 

697 Fill Formulas for Web Short Description 5 

698 Fill Formulas for Web Long Description 5 

699 Overwrite Existing Web Product Name 252 

700 Overwrite Existing Web Short Description 252 

701 Overwrite Existing Web Long Description  252 

702 Use Filter for Start 252 

703 Allow Creation of free form Attributes 252 

704 Allow Creation of free form Sizes 252 

705 Default Product Availability 3 

706 Default Product Availability Threshold 3 

707 Use Sub-Account 1 based on 252 

708 Length for Sub-Account 2 3 

709 Use Sub-Account 2 based on 252 

710 Sub-account 2 based on 3 

711 Merch Sales for Sub-Account 2 252 

712 Merch Disc for Sub-Account 2 252 

713 Inventory for Sub-Account 2 252 

714 Cogs for Sub-Account 2 252 

715 Length for Sub-Account 3 3 

716 Use Sub-Account 3 based on 252 

717 Sub-account 3 based on 3 

718 Merch Sales for Sub-Account 3 252 

719 Merch Disc for Sub-Account 3 252 

720 Inventory for Sub-Account 3 252 

721 Cogs for Sub-Account 3 252 

722 Length for Sub-Account 4 3 

723 Use Sub-Account 4 based on 252 
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724 Sub-account 4 based on 3 

725 Merch Sales for Sub-Account 4 252 

726 Merch Disc for Sub-Account 4 252 

727 Inventory for Sub-Account 4 252 

728 Cogs for Sub-Account 4 252 

729 XZ Default Leave Amount 4 

730 Split Vendor City/State 252 

731 Primary Account (Inventory UDF3) 5 

732 Primary Account (Inventory UDF4) 5 

733 Primary Account (Customer 3) 5 

734 Primary Account (Customer 4) 5 

735 Primary Account (Customer 5) 5 

736 Primary Account (Customer 6) 5 

737 Primary Account (Customer 7) 5 

738 Primary Account (Customer 8) 5 

739 Primary Account (Tax Areas) 5 

740 After Memo is updated go to 3 

741 After Slip is updated go to 3 

742 High security on Sales Orders 252 

743 Connection with QuickBooks is already set or not 3 

744 Choose Purchase Order Type 3 

745 Prompt & perform Central Processing if customer not found locally 252 

746 New Customer Required Fields 5 

747 Allow printing of EFT receipts even when EFT is disabled. 252 

748 Count Open Currency 252 

749 Availability Quantity Source 3 

750 Show Inactive Stores 252 

751 X/Z Out Register Definition 5 
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752 Use Workstation Specific Settings In X/Z Out 252 

753 Store encrypted card numbers 252 

754 Include non-inventory items in plan data 3 

755 Show Inactive Tax Areas 252 

756 Master Subsidiary for Product attributes 3 

757 Use Pending Purchase Order 252 

758 Multi Level Approval Required 252 

759 Purchase Order Approval Level 1 252 

760 Purchase Order Approval Level 2 252 

761 Purchase Order Approval Level 3 252 

762 Purchase Order Approval Level 4 252 

763 Purchase Order Approval Level 1 Amount From 4 

764 Purchase Order Approval Level 2 Amount From 4 

765 Purchase Order Approval Level 3 Amount From 4 

766 Purchase Order Approval Level 4 Amount From 4 

767 Purchase Order Approval Level 1 Amount To 4 

768 Purchase Order Approval Level 2 Amount To 4 

769 Purchase Order Approval Level 3 Amount To 4 

770 Purchase Order Approval Level 4 Amount To 4 

771 Use Pending Vouchers 252 

772 Multi Level Approval Required 252 

773 Allow Overages 252 

774 Approval Level 1 252 

775 Approval Level 2 252 

776 Approval Level 3 252 

777 Approval Level 4 252 

778 Approval Level 1 Amount From 4 

779 Approval Level 2 Amount From 4 
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PREF_ID PREF_NAME PREF_TYPE

780 Approval Level 3 Amount From 4 

781 Approval Level 4 Amount From 4 

782 Approval Level 1 Amount To 4 

783 Approval Level 2 Amount To 4 

784 Approval Level 3 Amount To 4 

785 Approval Level 4 Amount To 4 

786 Approval Level 1 Difference 4 

787 Approval Level 2 Difference 4 

788 Approval Level 3 Difference 4 

789 Approval Level 4 Difference 4 

790 Allow PI reactivate inactive items in Inventory 252 

791 Choose Transfer Order Type 3 

792 Spread as Global Discount 252 

793 Default Discount Type 3 

794 Create price adjustments for items with zero O/H qty 252 

795 XZ Maximum Cash Amount 5 

796 Intra Company Transfer Option for Slips 3 

797 Inter Company Transfer Option for Slips 3 

798 Use ZOut Sequencing 252 

799 Next ZOut Sequence Number 4 

800 Custoner Address Location Type Requires 252 

801 Default Address Location Type 3 

802 Default Customer Store 3 

803 Tax Method Name 3 

804 Use Two-Step Approval For Vouchers 252 

805 Audit - Close matching periods for multi SBS 252 

806 Sales Order Default Shipping Addrress Selection 3 

807 Receipt Default Shipping Addrress Selection 3 
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PREF_ID PREF_NAME PREF_TYPE

808 Use Central for Returns 252 

809 Zero out Tax% for export customers 252 

810 Restrict item discounts to not exceed spreadable global discount percentage 252 

811 Transfers - Do not check rule for Local Transfer 252 

812 Transfers - Do not check rule for Inter-Company Transfer 252 

813 Alert cashier when receipt price is less than cost 252 

814 XZ Minimum Cash Amount 5 

815 Automatically "Record Sale" after final deposit 252 

816 Region Sales Target - Optional Level 252 

817 District Sales Target- Optional Level 252 

818 Department Sales Target - Optional Level 252 

819 Limit Slip Items against referenced TO Items 252 

820 Currency Denomiation Listing Order 3 

821 Source for Package Tax Info 3 

822 Create new inventory item as web item 252 

823 Append Installation ID to Customer ID 252 

824 ICT-Allow Import of Rules 252 

825 ICT-Define Single Rule for all Stores 252 

826 ICT-Define Unique Rule for each Store 252 

827 ICT-Last Updated Date of Masters Information 5 

828 Credit Card Allow Cashback 252 

829 Credit Card Maximum Cashback Amount 4 
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Appendix B: Doc Type Field Values 
Background 
When processing records for the Doc Sync files and DOC_SYNC tables, ECM looks at the 
DOC_TYPE field value. The following table lists all the possible DOC_TYPE values. 

 

Doc Type Value 

None 0 

DocSync 1 

SbsPref 2 

PriceLevel 3 

TaxCode 4 

TaxArea 5 

DiscReason 6 

DiscSched 7 

Commission 8 

PosFeeType 9 

PurchFeeType 10 

Store 11 

CustomerUDF 12 

VendorUDF 13 

InventoryUDF 14 

InvoiceUDF 15 

MNUDF 16 

CreditCard 17 

Title 18 

AllocPattern 19 

DCS 20 

Scale 21 

Region 22 
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Doc Type Value 

InvoiceComment 23 

SOComment 24 

SlipComment 25 

VoucherComment 26 

Currency 27 

Rate 28 

POSTender 29 

PurchTerm 30 

ShipMethod 31 

ShipInstruct 32 

AdjReason 33 

TimeShift 34 

Employee 35 

Customer 36 

Vendor 37 

PriceRounding 38 

PriceAdjusting 39 

ZipCode 40 

SubLoc 41 

KitComponent 42 

StoreStation 43 

TransRule 44 

DefaultStore 45 

SbsFldLen 46 

TrackAdjLog 47 

DocSequence 48 

Inventory 49 

Invoice 50 

Adjustment 51 
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Doc Type Value 

Slip 52 

VendInvoice 53 

Voucher 54 

TO 55 

SO 56 

PO 57 

MO 58 

MN 59 

MarkDown 60 

RproLicense 61 

StoreSalesTarget 62 

EmployeeSalesTarget 63 

PICounts 64 

UserGroup 65 

Season 66 

Till 67 

DisburReason 68 

Country 69 

Lang 70 

TransReasonCode 71 

ItemGroup 72 

ItemRange 73 

DcsSalesTarget 74 

ZOut 75 

TranFeeType 76 

SbsStoreList 77 

SbsStorePairs 78 

SbsStoreOptions 79 

PendingAPR 80 
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Doc Type Value 

SubLocSegment 81 

SubLocation 82 

DefaultSubLoc 83 

SubLocQty 84 

AddrType 85 

PIMap 86 

InvcItemReason 87 

StoreClass 88 

StorePhysType 89 

Job 90 
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